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Safety Precautions 
For your safety and protection of the BrailleSense Polaris, please read and 
abide by the following safety precautions. 

1. The input voltage of the AC adapter is 100V - 240V, and the output is 
DC 5V / 2A. 

2. When the BrailleSense Polaris is shipped, the battery may be packaged 
separate from the unit to avoid damage. When you use the BrailleSense 
Polaris for the first time, you may need to open the package, remove the 
battery, and insert it into the battery slot at the underside of the unit. 
(See section 1, introduction, for more details on inserting the battery.) It 
is possible that the dealer or distributor from whom you purchased the 
BrailleSense Polaris has already done this for you. The battery may not 
be fully charged when it is shipped. Before you use the BrailleSense 
Polaris, you should ensure the battery is fully charged.  

3. When you use the BrailleSense Polaris with the battery for the first time, 
the battery status may not be displayed accurately. To avoid this, leave 
the BrailleSense Polaris connected to the AC adapter for about five 
hours with the unit turned on. If you want to use the BrailleSense Polaris 
immediately, you may use it while it is charging. 

4. If you want or need to remove the battery from the unit, power the unit 
off, and then remove the battery. If the unit is connected to AC power, 
before re-inserting the battery into the unit, make certain that the power 
is off. 

5. There is a risk of explosion if the battery is replaced by an incorrect 
type. Please make certain to use only battery packs produced 
specifically for the BrailleSense Polaris by SELVAS Healthcare. Please 
dispose of used batteries according to the instructions. 
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6. If the usage time is less than 50% as compared to the stated battery run 
time in the product specifications, even after a full charge, it is 
recommended that you replace the battery. 

7. It is recommended to remove and store the battery separate from the 
product during long periods of disuse. 

8. If you drill into or disassemble the product or battery using a sharp point, 
it may cause electric shock, explosion or fire. 

9. When you are using the BrailleSense Polaris on battery power, the 
status of the remaining battery power is announced when the battery 
charge is low. When the battery’s charge falls below 15 percent, 
connect the AC adapter to the unit for recharging. If the remaining 
battery charge drops to five percent, and the unit is not connected to the 
AC adapter, the BrailleSense Polaris goes in to Sleep Mode one minute 
after the announcement of the battery’s status. If the battery level falls to 
2%, the unit shuts down to preserve settings, etc. The amount of battery 
life per charge varies depending on the options you have set and the 
number and type of tasks you are running. 

10. Your BrailleSense Polaris needs to be handled with care. The 
BrailleSense Polaris is a very delicate machine. Please handle the unit 
in a proper, careful manner. The BrailleSense Polaris is very sensitive to 
dust. Make sure to keep it away from dusty environments. 

11. The Braille cells are very sensitive, intricate parts. If the Braille cells are 
not working properly due to the presence of dust or for any other 
reason, please contact our repair center, or the dealer from whom you 
purchased the BrailleSense Polaris for support. 

12. You should register your BrailleSense Polaris in order to ensure further 
maintenance, service, and upgrade information. In the US, please visit 
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www.hims-inc.com, to register your information. If you have any trouble 
when registering your information, please contact the dealer from whom 
you purchased your BrailleSense Polaris for help. International 
customers should contact their regional dealer for product registration 
information. 

13. Do not disassemble the BrailleSense Polaris yourself. Do not have 
anyone else who is not authorized by HIMS take apart the BrailleSense 
Polaris. If an unqualified person disassembles the unit, serious damage 
may occur. If an unauthorized person disassembles the unit, it is 
excluded from any free maintenance, and the warranty becomes void. If 
any liquid or external force damages the unit, it may also be excluded 
from free maintenance, even if the damage occurs during the warranty 
period. The BrailleSense Polaris contains a Liquid Contact Indicator 
sticker that will change color if the unit comes in contact with water or 
other liquids. This indicator will not activate under humid or other 
conditions that fall within the product’s normal environmental 
requirements.  

14. Do not leave your BrailleSense Polaris in closed, high temperature 
environments such as inside a car on a hot summer day, as the battery 
may be damaged or catch fire. Please do not let your BrailleSense 
Polaris remain in such environments for long periods of time.  

15. To prevent possible damage to your hearing, do not listen to audio at 
high volume levels for long periods. 

16. This equipment has been tested and found to comply with the limits for 
a Class B digital device, pursuant to part 15 of the FCC Rules. These 
limits are designed to provide reasonable protection against harmful 
interference in a residential installation. 
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Operation is subject to the following two conditions. 

1. This device may not cause harmful interference, and 
2. This device must accept any interference received, including interference 

that may cause undesired operation. 

This equipment can generate, use and radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause harmful 
interference to radio communications. However, there is no guarantee that 
interference will not occur in a particular installation.  

If this equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the 
following measures: 

- Reorient or relocate the receiving antenna. 

- Increase the separation between the equipment and receiver. 

- Connect the equipment into an outlet on a circuit different from that to which 
the receiver is connected. 

- Consult the dealer or an experienced radio/TV technician for help. 

 

FCC statement 
FCC RF Radiation Exposure Statement: 

This equipment complies with FCC RF radiation exposure limits set forth for an 
uncontrolled environment. This transmitter must not be co-located or operating 
in conjunction with any other antenna or transmitter. Changes or modifications 
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not expressly approved by SELVAS Healthcare may void your authority to 
operate the equipment  

Congratulations on the purchase of your BrailleSense Polaris! The BrailleSense 
Polaris is capable of doing everything that an ordinary tablet can do, and more – 
all without the need for a screen!  

 

I. Your BrailleSense Polaris packing box should 
contain the following items: 
1) BrailleSense Polaris 
2) Battery 
3) Carrying Case 
4) AC adapter 
5) USB 3.0 Cable  
6) Earbuds 
7) Braille Commands Summary 

II. How to use this manual 
In this manual you will see references to hot keys and shortcut keys. These keys 
refer to ways to access menus and functions quickly by using a combination of 
keystrokes. Please note that not all hot keys and shortcut keys will work from 
every location on the BrailleSense Polaris. Some hot keys and shortcut keys are 
program specific, thus, they require that you be within a specific program for 
them to work. 

Shortcut keys refer to keystrokes used to quickly activate a function from within 
a menu. Hot keys refer to keys that will activate a function regardless of where 
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you are within the program. When functions are described in this manual, 
shortcut keys are shown in parentheses, and hot keys are shown in quotes. 

This user manual notes how to press hot keys and shortcut keys in the following 
manner: Keys that are to be pressed at the same time are separated by a - 
(dash). When you see “Space-b (dots 1-2),” this means that you should press 
“Space” and dots 1 and 2 simultaneously. 

If you are unable to find a solution to a problem within the manual, or if you need 
assistance with the BrailleSense Polaris, please email us at support@hims-
inc.com. You may also visit us on the web at www.hims-inc.com; or, you can call 
us at 888-520-4467. 
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1. Introduction 
1.1 What is the BrailleSense Polaris? 
The BrailleSense Polaris is a Braille note taker developed and manufactured by 
HIMS, for people who are blind and visually impaired. The BrailleSense Polaris 
has a variety of powerful capabilities, including the following. 

1. Read TXT, BRF, RTF, PDF, EPUB, and Microsoft Word, Excel and 
PowerPoint files. Take notes or create formatted documents and e-mails.  

2. Play media, DAISY books, and FM Radio and YouTube videos. 

3. Organize your Appointments and contacts, and synchronize them with your 
Google account.  

4. Perform scientific calculations, set alarms and explore the Lunar and solar 
calendars. 
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5. Use the BrailleSense Polaris as a USB or Bluetooth Braille display with a 
compatible screen reader, such as JAWS, NVDA, SuperNova, System Access, 
VoiceOver for Mac and iOS and TalkBack for Android. 

6. Use the built-in GPS sensor and digital compass to navigate independently 
without the need for external devices.  

7. Download and install 3rd party applications from the Google Play Store. 

8. Utilize Google Services such as Drive, Docs, Sheets, Slides, and Classroom 
via our included screen reader, specially customized for these applications. 

9. Obtain information and perform functions using your voice with the included 
Google Assistant, or third party voice assistants like Amazon Alexa. 

 

1.2 Hardware 
To get the most from your BrailleSense Polaris, it is important to become 
oriented to the buttons and ports as well as learning their functions. This section 
will orient you to your Polaris. 

Place the Polaris on a desk or table top with the Braille display nearest you.  

 

1.2.1 THE TOP PANEL 
On the top face of the BrailleSense Polaris is located a 9 key Perkins-style 
keyboard, consisting of Braille dots 1:6, "SPACE", "BACKSPACE", and 
"ENTER".  

On the same row as the Space bar are Control and Alt, as well as 4 oval 
function keys. Moving from left to right, the row contains F1, F2, Control, Space, 
Alt, F3 and F4. 
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Below the keyboard is a 32 cell Braille display. Above the Braille display, there 
are cursor routing buttons corresponding to each of the 32 Braille cells. When 
you are editing documents, you can use these keys to route your cursor to the 
character of the corresponding Braille cell. The cursor routing keys also serve as 
shortcut keys for navigating lists and groups of fields in certain places on the 
unit. A dot is placed on each 5th cursor routing button for easier orientation.  

"Between the Braille cells and the cursor routing buttons is a thin touch strip. 
You can use this touch strip to perform flick and tap gestures similar to those 
used on touch screen phones or tablets running screen readers. These gestures 
differ by context and application and will be explained further in subsequent 
relevant chapters of this manual. You can turn Touch Gestures on or off in the 
Global Options. (See chapter 3) 

On each side of the Braille display are two capsule shaped keys. These are the 
"UP" and "DOWN" scroll keys. The scroll keys are used to scroll the Braille 
display through menus, fields, lists or text. You can use the scroll keys to scroll 
by display length, paragraph, line, sentence, or character. You can set the left 
and right sets of scroll keys independently in the "Global Options". (See chapter 
3.)  

Near the top center of the unit's top panel, is a liquid crystal display (LCD). The 
LCD displays the output of the unit visually so that a sighted person can see 
what is shown on the BrailleSense Polaris. There are also 4 LED indicators, 2 
on each side of the LCD. To the left of the LCD are indicators for Power and 
GPS status, and to the right of the LCD are indicators for Wi-Fi and Bluetooth 
status.  

Stereo speakers are located on the top left and right corners for audio output. 
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1.2.2 THE RIGHT PANEL 
Toward the front of the right panel of the BrailleSense Polaris is the USB 3.0 
rapid data and Micro USB combination port. This port can be used for 
transferring data, charging the unit, and connecting to a computer as a USB 
Braille display. As indicated, this port supports both USB 3.0 and traditional 
Micro USB connections.  

Continuing toward the back of the unit, you will find the "SD" slot used for 
housing an SD (secure digital) card. The BrailleSense Polaris supports SD HC 
cards for auxiliary storage. 

  

1.2.3 THE LEFT PANEL 
Near the front of the unit on the left panel are 2 small buttons for raising and 
lowering the master volume of the unit. Use the button nearer the front to 
decrease the volume, and the button behind it to increase it. 

Behind the volume buttons are located 2 small, round jacks. The one nearest 
the front is the stereo headphone jack, and the one nearer the rear of the unit is 
the stereo microphone jack for connecting a stereo microphone or line level 
recording source.  

Nearest the back of the left panel is a USB host port used to connect USB 
drives, keyboards and other compatible accessories. 

 

1.2.4 THE REAR PANEL 
The port nearest the right of the rear panel is the AC adapter jack. To charge the 
unit's battery or use the BrailleSense Polaris on AC power, plug the small, round 
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end of the AC adapter in to this jack, and plug the larger box-like end in to a 
standard AC electrical outlet. 

Toward the left end of the rear panel is the HDMI port. Use this port to connect 
HDMI video screens or monitors to the BrailleSense Polaris for Visual 
presentation or to view a student's work.  

Nearest the left of the rear panel is the Kensington lock port. This slot is used to 
physically lock the unit to your desk or tabletop so that someone cannot remove 
it while you are away. 

 

1.2.5 THE FRONT PANEL 
On the far left of the front panel is located a 3-position slide switch. This is the 
key "Lock" switch. This switch is explained in more detail in section 2.11 of this 
manual. 

To the right of it is another 3-position slide switch. This is the "Media Mode" 
switch, and determines which type of content the front panel buttons control. 
This switch is explained in more detail in the next chapter. 

To the right of the "Media Mode" switch, are five buttons, with a dot on the 
center one. These buttons control media and DAISY playback as well as 
providing shortcut keys for other areas of the unit when they are set to 
Application Mode. As explained above, the type of content controlled by these 
buttons depends on the position of the "Media Mode" switch. These five buttons 
are explained further in subsequent chapters of this manual. 

To the right of the media buttons is the Power button. To turn on the unit, press 
and hold this button until you hear a beep and feel a vibration. The first time you 
power on the unit, it will take some time to boot up.  
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Once the unit boots, you can press the Power button quickly to put the unit in 
standby "screen off" mode. This is similar to locking the screen on a phone or 
tablet. Press it quickly again to unlock it and return to the position at which you 
entered Screen off Mode. Press and hold the Power button to completely power 
down the system.  

 

1.2.6 THE BOTTOM FACE 
The underside of the unit contains the battery compartment and the camera. 
The battery contains a rounded edge along one of the sides of its length. This 
rounded edge should be placed alongside the back edge of the unit's casing. 
The battery has 2 small protrusions that should be pointed to the right. Place the 
battery in the unit right side first, and then press down on the left side to click it 
into place. To remove the battery, Use a finger to pull the battery release lock 
toward the left edge of the unit, and pull the battery out. 

The 13 megapixel camera is located near the upper right corner of the 
underside of the unit. Applications for OCR and photo capture can be 
downloaded from the Google Play Store. For best results, hold the Polaris 9 to 
12 inches above the paper, with the unit off set to the left to account for the 
camera position.  

Congratulations! You are now familiar with the basic functions of the buttons and 
ports of the BrailleSense Polaris. The rest of the manual discusses each 
function in greater detail to help you maximize the potential of your BrailleSense 
Polaris. 

1.3 Hardware Specifications 
1. Operating system: Android Lollipop 5.1.1 
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2. Internal storage: 64GB. 

3. RAM: 3GB. 

4. CPU: 2.1 GHz SAMSUNG Exynos 7420  

5. Battery: Lithium Polymer (detachable), 4800mAh. 

6. Battery running time: About 18 hours (with Braille and TTS, internal speaker 
at mid volume) 

7. Keyboard: 9 key Perkins-Style Braille keyboard, Control and Alt, 4 function 
keys, 32 cursor routing keys, 4 scroll buttons. 

8. Additional buttons and switches: key lock switch, Media Mode switch, 5 media 
buttons. 

9. Braille display: 32 refreshable Braille cells. 

10. Visual display: Internal LCD, HDMI, Miracast (1920 x 1080 FHD) 

11. Wireless: 802.11 b/g/n/ac Wi-Fi, Wi-Fi Dual-band (2.4GHz and 5.0 GHz), Wi-
Fi Direct; Bluetooth 4.2, NFC headset pairing, IrDA.  

12. Sensors: GPS, RTC, Accelerometer, Compass, Gyroscope 

13. Camera: 13 MP SAMSUNG Camera 

14. Interface: 1 Micro USB and USB 3.0 rapid data and charging combination 
port, 1 USB host port, 1 SD card slot (FAT32 and exFAT supported) 

15. Sound: Internal stereo speakers, stereo headphone jack. 

16. Voice recording: Internal stereo microphones, external stereo microphone 
jack, headset microphone.  

17. Vibrate motor: installed. 

 



 
 

 30  

  

 

1.4 Memory on the BrailleSense Polaris 
The BrailleSense Polaris has 3GB of RAM (random access memory) and 64GB 
of flash memory. The RAM is memory reserved for running programs. RAM is a 
temporary storage area for any program files that are running or any currently 
open documents. The data in the RAM area disappears if your battery depletes, 
and the AC adapter is not connected. The RAM data also disappears when 
BrailleSense Polaris reboots for any reason. This means, if you have an open 
document which you have not saved, the unsaved data disappears. 

2. Basic Functions of the BrailleSense Polaris 
 

2.1 How to Enter Commands 
The commands used to operate the Polaris are comprised of various 
combinations of the Braille and function keys. In this user manual, the "-" (dash) 
is used to indicate that keys should be pressed simultaneously. For example, 
"Space-Z" indicates that the user should press "space" and Z at the same time. 
This manual also contains expressions like "Space-2-4-6". This means that the 
spacebar with dots 2, 4, and 6 should be pressed and released simultaneously.  

In a menu or dialog, when your cursor is placed on your desired command, you 
can execute most commands by pressing "Enter". To cancel a function or close 
a program or menu, and return to your previous location, press "Space-Z". 

• Note: In Android applications, “Space-Z” serves as the “Back” button. You 
can also use “Space-E” or “F4” as the Android “Back” button, used to 
move back one screen, or exit your current function or application.  
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2.1.1 BASIC ALERTS AND MESSAGES 
There are instances where the Polaris alerts you to events for which you have 
asked it to notify you. For example, by default, the Polaris checks the Schedule 
Manager when you power on, and notifies you of any appointments scheduled 
for that day. When you are notified of an appointment, you can interact with the 
Schedule Manager as you normally would. To exit the Schedule Manager, press 
"Space-Z" or "Space-E" and you are returned to your previous location.  

Other Polaris system messages are displayed and spoken, and automatically 
disappear when any key is pressed, or after a set number of seconds. For 
example, when you connect the AC adapter to the Polaris, the Polaris speaks 
the message "AC adapter connected." When you disconnect it, the Polaris says, 
"AC adaptor disconnected." 

You will also hear alerts from the Android system and applications. You can 
review Android notifications by pressing “Space-1-2-3-4-5-6”, and can delete 
most notifications using “Space-D”. Press Enter on the notification to open the 
associated program. You can control how various notifications and alerts are 
handled in the Global options. (See Chapter 3) 

 

2.2 Menu Concepts 
Menus on the Polaris provide you with a list of programs, actions, or options 
from which you can select. If a menu item has a sub menu, selecting it brings up 
another list of choices. 

When using a program on the Polaris, press "Space-M" or F2 to bring up its 
menu. Press the "Up" scroll key or "Space-1" to move to the previous item, and 
press the "Down" scroll key or "Space-4" to move to the next item.  
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To move to the first item in the menu, press "Space-1-2-3." To move to the last 
item in the menu, press "Space-4-5-6." When placed on the first item of a sub 
menu, pressing "Backspace" returns you to the upper Menu. To repeat the 
current item, press "Space-R". To open a sub menu or execute the current item, 
press “Enter”.  

You can also quickly jump to and execute a menu item by pressing the menu 
item's shortcut key, usually the first letter of the item name. Often menu items 
can also be executed instantly, directly from your current position in the 
program, with a hotkey. 

Shortcut keys are displayed in parentheses following the menu names. Hotkeys 
generally consist of a modifier such as "Enter," "Space," or "Backspace", 
pressed simultaneously with a letter or dot combination. These are displayed 
following the shortcut keys. 

For example, if you are in the Word Processor, and press "Space-M" or "F2," 
then press "Enter" on "File," you hear "New (n) pull down Enter-n". The word 
"New" is the menu option. You would press the letter N to jump to "New" from 
within the "File" menu. Press "Enter-n" to access the "New" document command 
from anywhere in the Word Processor. The n is the shortcut key and "Enter-n" is 
the hotkey. It is important to note that some hotkey commands are global, thus 
will work from anywhere on the unit, and some are program specific. For 
example, if you want to activate the "new document" option in the Word 
Processor. You cannot press "Enter-n" from the "Program" menu to activate this 
option. You must be in the Word Processor for "Enter-n" to activate the "new 
document" command. However, if you wish to activate the "display time and 
Date" option in the "Utilities" menu, this can be done from anywhere on the unit 
using "Space-T" as this is a global hot key.  
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Let's begin going through the various menus. First, turn the unit on as explained 
in chapter 1. Now, bring up the "Program" menu by pressing "F1". The 
"Program" menu is the main menu of the Polaris. You can access all of the 
programming, option settings, utilities, and help from this menu, as well as the 
Play Store and installed Android apps.  

The "Program" menu consists of 5 programs: File Manager, Word Processor, 
Notepad, E-mail and Exchange E-mail; then 7 sub menus: Media, Organizer, 
Web Tools, Extras, Utilities, Settings, and Help. Finally, at the bottom of the 
menu are the Play Store, All Apps, and information.  

The first item in the "Program" menu is "File Manager". If "Space-4" is pressed, 
the next menu item is displayed and spoken. Pressing "Space-4" repeatedly, 
continues your navigational progress down the list of items in the "Program" 
menu. When you reach the bottom of the list, the "information" menu item is 
displayed as it is the last item in the "Program" menu.  

You could also jump quickly to the "Information" menu item by pressing "Space-
4-5-6" when "File Manager" is displayed. Press "Space-1-2-3," and the Polaris 
jumps back to the top. Press "Enter" on an item you want to execute or open. If 
you are in a submenu, and wish to return to the main "Program" menu, press 
"Space-E" or F4.  

The "Media" menu contains the "Media Player", "FM Radio" and "DAISY 
Player".  

The "Organizer" menu contains the "Address Manager" and "Schedule 
Manager".  

The "Web Tools" menu contains the "Web Browser" and “Google Search”.  
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The "Extras" menu contains the optional "Sense Dictionary", "Excel Viewer" and 
"Online DAISY".  

The "Utilities" menu contains the "Calculator", “Polaris Math”, "Display time and 
Date", "Display Compass Heading", "Wake Up Alarm", "Stopwatch", "Terminal 
for Screen reader", "Display Network Status", "Display Power status", "Format", 
"Sleep Timer" and "Upgrade BrailleSense Firmware". 

The "Settings" menu contains "Set Time and Date", "Setup Internet", "Bluetooth 
Manager", “Menu Manager”, "Backup/Restore Settings", "Change device 
Name", “Quick Start Guide”, "Password Protection", "Initialize Polaris Options”, 
“Voice options”, "polaris Global Options", “Android Backup and reset” and 
“Android System Settings”. 

The "Help" item opens a navigable version of the Polaris User Manual. 

The "Play Store" item opens the Google Play Store where you can search for 
and download native Android apps. 

The "All Apps" menu displays a list of all native Android apps installed on the 
unit. When the unit ships, this list contains stock Android apps and other Google 
basics like Docs, Sheets and Slides. 

The “Information” dialog provides the copyright and version of the BrailleSense 
Polaris, as well as the operating system version, the version of the BrailleSense 
Polaris firmware, and other useful items such as Mac address and Key number. 
When the "information" dialog is open, you can save the information about the 
BrailleSense Polaris by pressing "tab (Space-4-5 or F3)", to navigate to the 
"Save" button and press "Enter". The unit displays "Successfully saved", and 
returns you to the "Save" button. The saved file is named "bs-information.txt", 
and is stored in "flashdisk" for easy access. 
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For more information on a specific program, please see the section of this user 
manual related to that program. For information on using Android apps, see 
chapter 12. 

The "F1" command for accessing the "Program" menu is an example of a global 
hotkey. This means that pressing the "F1" key takes you to the "Program" menu 
immediately from anywhere on the Polaris.  

There are also global quick launch commands for most Polaris programs, 
usually comprised of either F1 or F3 and a letter or dot combination. These 
quick launch commands immediately launch their associated application from 
anywhere on the Polaris. See section 15.2 for a complete list of the quick launch 
commands.  

You can also search for apps and uninstall non-Polaris apps from the Main 
Menu/All Apps list. To uninstall any 3rd party app, press “Space-D” when you are 
focused on it. You are prompted if you are sure you wish to uninstall the app, 
press “Enter” to confirm. 

Searching for apps may be useful if you have many Android apps installed, or if 
you want to see which apps you have in a certain category, such as mail or 
music. Press “Space-F” from the Main Menu/All Apps list, and you are prompted 
to enter your search term. Type it, and press Enter, and results matching your 
search are displayed. 

Press “Enter” on an app in the list to execute it. Press “Space-D” on any 3rd 
party app to uninstall it. 
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2.2.1 CONTROL SYMBOLS 
The BrailleSense Polaris uses several control symbols to note the type of 
information being displayed: examples are list items, menus, and edit boxes. 
These symbols can appear "Before" or "After" the text, or the appearance of this 
information may be set to "off", determined by the "Control information" setting 
in the "Global Options". For example, if "Control information" is set to "before", 
and you bring up the Word Processor's program menu, The BrailleSense 
displays, "MN File (f) pull down". 

 Note: In the Web Browser, the control symbols are displayed even if the 
"Control information" is set to "off". 

The following table shows the types of controls and the symbols that are used to 
indicate them. 

 

Name 

Symbol 

Comments 

Menu 

MN 

A menu that has submenus. 

Menu item 

MI 

A menu that does not have a sub menu. 

List item 
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LI 

An item that is part of a list. 

Edit box 

EB 

After this symbol, the edit box name is displayed. You can find the edit box after 
the edit box name. In the web browser, the symbol "EB" may be followed by an 
edit box without an edit box name. Edit boxes that begin with the symbol "EB" 
are one line. 

(Ex: "EB Last name: (cursor)" in the address manager program or "EB (cursor)" 

Multi edit box 

MEB 

This indicates a multi-line edit box.  

(Ex: "MEB Subject: (cursor)" in the e-mail program) 

Computer edit box 

CE 

An edit box requiring ASCII Braille input. 

(Ex: "CE To:" in the Email program) 

Combo box 

CB 

Indicates a combo box in which you can choose an item by pressing the up 
scroll button or the down scroll button. 

(Ex: "CB Type:" in the "Open dialog box" of the Word Processor) 
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Edit combo box 

ECB 

choose the desired item by pressing the up or down scroll button, or by directly 
typing in the item name. 

(Ex: "ECB File name: (cursor) was in the "Open dialog box" of the word 
processor program) 

Prompt button 

PB 

PB follows any question in which you have to choose "Yes" or "No." You can 
toggle between "Yes" and "No" by pressing "Space" or "Backspace" button.  

(Ex: When you exit from the word processor, "PB Save: Yes")  

Static box 

ST 

ST indicates the current status. 

(Ex: "ST noname.hbl/insert mode/write" in the word processor program) 

Link 

LN 

Indicates a link on a web page. 

Anchor 

ANC 

Indicates an anchor on a web page. 

Radio button 
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RB 

Indicates a radio button, cycle among items using up scroll button, down scroll 
button, space, or Backspace.  

(Ex: "RB Attribute: Write" in the "Information dialog box" of the file manager) 

Radio button select 

SRB 

Indicates the currently selected radio button in the web browser 

Radio button unselect 

URB 

It indicates the radio button is not selected. 

Check box check 

SCHB 

Indicates the check box is selected. 

Check box uncheck 

UCHB 

Indicates the check box is not selected.  

 

 Note: Links, anchors, and radio buttons are controls that are only used in 
the Web Browser.  

The symbols enable you to understand what type of input control or menu you 
are working with. For example, if "MN," "MI," or "LI" are displayed, you know you 
can move from one item to the previous and next items by pressing the "Up" 
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and "Down" scroll keys. If "ECB," "EB," "CB," or "MEB" are displayed, you know 
you are in an input area where you must type the. If "BT" is displayed, you can 
press "Enter" to activate the "button". 

 

2.3 Using the Function Keys 
There are four function keys on the Polaris. You can use these function keys to 
open the menus, cancel tasks, and move to other items.  

The "F1" key opens the Polaris "Program" menu from anywhere on the unit, and 
is used in combination with other keys to open various Polaris programs.  

From within Polaris programs, the "F2" key opens the program specific menu, 
similar to pressing “Alt” in Windows.  

 Note: you may also use "Space-M" to perform this function.  

The "F3" key functions as "Tab ("Space-4-5")". "Space-F3" serves as "Shift-Tab 
("Space-1-2")". F3 is also used together with other keys to open Polaris 
programs. 

The "F4" key functions like the "Escape" key on a PC. You can also use "Space-
E". Please note that "Escape" does not exit a program, as does "Space-Z" but 
rather, exits menus, dialogs, or prompt boxes. It also serves as the Back button 
in native Android apps. 

You can use the function keys in combination to perform various other tasks. 
Pressing "F1" and "F2" at the same time functions as "Page Up". Pressing the 
"F3" and "F4" keys together serves as "Page Down". "F1" and "F4" together 
opens the task list. Pressing the "F2" and "F3" keys together cycles through the 
running programs; similar to pressing "alt-tab" on your PC. The Task List and 
task switching are explained in greater detail in section 2.9. 
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The keys to the left and right of the spacebar are referred to as Control and Alt. 
This is because, in native Android applications, these keys function as Control 
and Alt on a QWERTY keyboard so that you may take advantage of native 
Android keyboard shortcuts when they are present. In BrailleSense specific 
applications, these keys operate similarly to "Space-1" and "Space-4" and 
provide an alternative method for scrolling through menus and lists.  

 

2.4 The AC Power Supply and the Battery Pack 
To check the battery power status, press "Space-1-6." The unit displays the 
following 2 items: 

1. Battery power level: expressed as a percentage of the remaining battery 
power compared to a full charge.  

2. Power source (battery, USB or AC power) 

If the battery power level drops under 15 percent, the Polaris displays the 
battery status on the Braille display, and it announces that the battery has less 
than 15 percent of its power remaining. If the battery power level falls below five 
percent, the Polaris gives you a warning indicating that your battery power level 
is under five percent, and the Polaris will be automatically put to sleep in one 
minute, unless you connect it to a power supply. When the level reaches 2 
percent, the unit automatically shuts down. 

When the Polaris is shipped, the battery pack is not installed. This is done to 
prevent damage during shipping. When you insert the battery in to the Polaris 
for the first time, the unit may display an inaccurate battery power level. Before 
using the Polaris for the first time, please charge the battery for at least 5 hours. 
You may use the unit during the initial charge, however, it is recommended if 
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you do, that the unit remain connected to AC power for at least 5 hours to fully 
charge the battery.  

When you remove the battery from the Polaris, make sure your unit is turned off; 
especially when the AC power adapter is not connected. If you remove the 
battery while the unit is on and AC power is not connected, you will lose all data 
stored in RAM, including open documents, emails, and contacts or 
appointments that have not been backed up.  

Polaris can also be charged via a USB 3.0 or Micro USB cable. It is compatible 
with Qualcomm quick chargers for more rapid charging. You may also charge 
Polaris's battery pack via QI compliant wireless charging decks. 

 

2.5 Controlling the Volume, Speed, and Pitch of the TTS 
Press "Backspace-F4" to increase the voice volume. Press "Backspace-F1" to 
decrease the voice volume. Press "Space-F4" to increase the speech rate. 
Press "Space-F1" to decrease the speech rate. Press "Enter-F4" to raise the 
pitch and "Enter-F1" to lower it.  

When you press any of the above key combinations, the Polaris announces the 
status of its volume, rate, or pitch. The changes in the characteristics of the 
voice remain in effect until you change them again, or a hard reset is performed 
either manually or due to lack of power to the unit for an extended period of 
time. 

 Note: the volume of the voice is controlled independent of the Main 
Volume on the unit, thus, you can adjust it above or below the volume of 
the system sounds, media playback, etc. using the Voice volume control 
described above. You can control the "Main Volume" of the unit using 
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"Backspace-Space-F1" to lower it and "Backspace-Space-F4" to raise it. 
You can also use the Volume Up and Volume Down buttons on the left 
side of the Polaris to control master volume.  

 

2.6 Using Speech and Braille 
When using the Polaris, you can choose to read using Braille only or speech 
only. You can also use both Braille and speech simultaneously. However, you 
cannot turn off both Braille and speech as you would have no method of 
receiving information from the Polaris. Use "Backspace-F2" to toggle the speech 
on and off. Press "Backspace-F3" to toggle the Braille on and off. You can also 
control these settings in the Global options. 

 

2.7 Entering Text 
In a document, "edit box" or "multi edit box" on the Polaris, you can enter either 
grade 1 or grade 2 Braille. By default, the unit uses UEB Braille, and you are 
free to use UEB, even when writing e-mail or Web addresses. However, if using 
the traditional US Braille code, some areas of the unit, such as the "to" field of 
the E-mail program, contain a "computer edit box" requiring you to enter text in 
computer Braille.  

To enter a capital letter in computer Braille, use the upper case indicator (Space-
U" before the letter you want capitalized. For example, if you want to enter H in 
a computer edit box, press "Space-U" then H. If you press "Space-U" twice, 
caps lock is turned on. Press "Space-U" again to turn off caps lock. 
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You can also press "Space-Backspace" simultaneously with the letter to 
capitalize it. To input the "at sign," you may either use "Space-U" followed by dot 
4, or "Space-Backspace-dot 4".  

To enter numbers in contracted or uncontracted Braille, use the "number sign 
followed by the number. However, when using computer Braille, you use no 
number sign and must enter numbers as "dropped" numbers (Nemeth 
numbers).  

 

2.8 Multi-Tasking 
Polaris can run many tasks at once. For example, you can work with the Word 
Processor while listening to music, and place calculations into a document at the 
same time. To do this, open the Media Player and play a music file. While the 
audio is playing, press the "F1" key to bring up the "Program" menu and launch 
the Word Processor. 

If you try to run a program that is currently running, The Polaris does not open a 
new instance of the program, but rather, returns you to the instance of the 
program that is already running. For example, while working with a document 
called "Notes" you decide to execute the "File Manager." Next, you navigate to a 
document called "journal" in the file list and press "Enter." The Word Processor 
does not load a second time, but rather, "journal" is opened in the same 
instance of the Word Processor in which "notes" is already loaded. You can 
switch among multiple open documents in a single instance of the Word 
Processor with F3 and Space-F3. Switching documents is explained in more 
detail in section 5.  



 
 

 45  

  

 

To switch between currently running programs press "F1-F4" to open the Task 
List. The Task List shows all the currently running programs in list form. To return 
to any application, simply navigate to it and press "Enter". To force closing of an 
application in this list, press "Space-D". To close all applications, press “F3” to 
tab to the “Close All” button, and press “Enter”, or press “Enter-Space-D”. 

If you have pressed "F1" to bring up the "Program" menu, or "F1-F4" to open the 
Task List and you decide not to access a different application, you can press 
"escape" ("Space-e" or "F4") to return to your previous location on the unit. 

You can use "F2-F3" to immediately cycle among all running programs without 
opening the Task List. This is similar to using "alt-tab" on your PC. If you are 
running three programs and are in the second program, pressing "F2" and "F3" 
moves you to the third program. If you press "F2-F3" again, you are placed in 
the first program. 

In the above case, if you were to press "Space-Z" to close the currently open 
program, you are then placed in the previous program. However, if there is only 
one program running, pressing "Space-Z" closes the program and places you in 
the "Program" menu.  

 

2.9 Switching Media Modes 
The media buttons on the front panel perform different functions according to 
the location of the "Media Mode" switch. 

If you slide the "Media Mode" switch to the left-most position, the Polaris 
announces, "application mode" and the media buttons control operation of the 
current application. If you place the "Media Mode" switch in the center position, 
the Polaris says, "DAISY mode" and the media buttons control playback of 
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DAISY content. If you slide the "Media Mode" switch to the right-most position, 
the Polaris announces, "media mode" and the media buttons control media 
playback. 

It is very important to pay attention to the position of the "Media Mode" switch to 
achieve desired operation of the media buttons. For example, if you are using 
the Media Player, if the "Media Mode" switch is placed in the center position, the 
media buttons on the front panel control operation of the DAISY Player, even 
though your focus is in the Media Player. More detailed explanations of the 
functions of the Media buttons is given in the Mobile Screen Reader, DAISY 
Player, and Media Player sections in this manual. 

 

2.10 Switching Key Lock 
You can disable the keys on the Polaris to prevent the accidental pressing of 
keys using the key "Lock" switch on the front panel. 

When the key "Lock" switch is placed in the left-most position, Polaris 
announces, "all keys locked". This means all keys on the unit are disabled 
including the on/off switch. If the key "Lock" switch is placed in the center 
position, Polaris says, "top panel locked". This means you can continue to use 
the buttons and switches on the front panel (media mode switch, media buttons 
and on/off switch), however, you cannot use any of the keys on the top face of 
the unit. If the key "Lock" switch is placed in the right-most position, Polaris 
announces, "unlocked". This indicates all keys are operational. 

To lock and unlock only the keys on the front media panel, press the "Back" and 
"Forward" media buttons simultaneously. The unit announces "Media keys 
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locked". If you press the keys again, the unit announces "Media keys unlocked", 
and the media buttons are again operational.  

 

2.11 One-Handed Mode 
Polaris provides a One-handed mode for users restricted to the use of one hand 
for Braille input. To toggle One-handed mode on/off, press “Backspace-1-2-3”. 
You can also turn One-handed mode on or off in the "Global Options" dialog. 

When One-handed mode is on, use the following methods to input text:  

1. To type a character, press the dots in any combination or order. When you 
have pressed all dots, press "Space" to complete the entry of the character. For 
example, if you want to type "h," you press "dot 1" and "dot 2" separately or 
together and then press "dot 5." Finally, press "Space". 

2. To press a command that includes "Space," press "Space" both before and 
after the dot combination. For example, to press "Space-o (dots 1-3-5)," press 
"Space" then press "dot 1", "dot 3" and "dot 5" separately or together in any 
order. Then press "Space" again. 

3. To press a command that includes "Backspace" or "Enter," press "Backspace" 
or "Enter" before the dot combination. Then press keys that make up the dot 
combination. Finally press "Space". For example, to press "Enter-l (dots 1-2-3)", 
press "Enter", and then press "dots 1-2-3." then, press "Space". 

4. To press "Space," "Backspace" and "Enter", press the key twice. For 
example, to press "Space" to create a space between words, press "Space" 
twice. 

The operation of the scroll keys, function keys, and media buttons remains the 
same as in normal mode.  
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If One-handed mode is on, the Polaris announces this each time it is powered 
on, as well as how to return to normal operation.  

 

2.12 Using Typing Mode 
While you are typing in a document, you may wish to turn off the navigation 
keystrokes, especially if you type very fast as you may accidentally navigate 
when you intend to enter text. To turn on "Typing Mode", press "Backspace-
Space-Enter-M" from within a document. "Start typing mode" is announced and 
displayed. 

When using "Typing Mode", if you press "Space-dot 4", instead of moving to the 
next line, the "Space" and "Dot 4" are entered into the document. 

To cancel "Typing Mode", Press "Backspace-Space-Enter-M" once again. "End 
typing mode" is announced and displayed. After "Typing Mode" is canceled, 
navigation commands return to normal operation.  

 

2.13 Using Touch Gestures 
As described in the introduction, the Braille display on the Polaris contains a 
touch strip located between the Braille cells and the cursor routers. This touch 
strip allows you to perform several functions with taps and swipes, similar to the 
touch gestures used with screen readers on smartphones and tablets. 

Before you can use touch gestures, you must turn gestures on in the Global 
Options. Once on, you can toggle the basic navigation gestures between items 
and tab controls. In item mode, the navigation gestures move back and forward 
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by one line or list item. In Tab mode, the navigation gestures perform the same 
function as “F3” and “Space-F3”, or rather, Tab and Shift-Tab. 

To toggle item mode and Tab mode, perform a one or two finger quadruple tap. 
Use a two finger swipe right to move forward by item or tab control, and use a 
two finger swipe left to move back one item or tab. 

To select an item, double tap one or two fingers. To open a program specified 
menu, triple tap one or two fingers. To close or exit a menu or program, pinch 
two fingers. To open the Global options, pinch out two fingers. 

 

2.14 Creating System Logs and Screen Recordings 
There may be times when it is necessary to report an issue in detail to support 
staff in order to clearly demonstrate a problem or process. Polaris offers several 
options for providing a picture of any given situation you may need to tell us 
about. 

• Take a  screen shot. Hot-key: F4-S. 
i. It is saved in the “Music” folder, as that’s where general media 

is stored. 
ii. A sub folder called “ScreenShots” is created, and each image 

is saved according to the date and time it was taken. 
• Create a screen recording. Start/stop Key: F4-R. 

i. It is saved in the “Music” folder. 
ii. A sub folder called “ScreenRecording” is created, 

• Create a system log and screen recording simultaneously. Start/stop 
key: F4-L. 

i. A zip file is automatically created containing both the log data 
and the screen recording. 

ii. The zip file is saved to Flashdisk/logData. 
• Create a system log only. Start/stop key: Backspace-Space-Enter-2-

3-5-6 from the Main Menu. 
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i. A log file is created and saved to Flashdisk/LogData, named 
according to the time and date it was created 

 

3. Customizing your Notetaker 
When you receive your notetaker, one of the first things you will want to do is to 
configure it to act the way you want it to. The " Settings" menu allows you to 
configure and customize your notetaker to meet your specific needs and 
preferences.  

To open the "Settings" menu, press "F1" to bring up the main menu. Press 
"Space-4" until you reach "Settings" and press "Enter". Or, just press S from the 
main menu to quickly jump to and open the "Settings" menu. 

The "Settings" menu contains the following items: "Set Time and Date", "Setup 
Internet", "Bluetooth Manager", "Backup/Restore Polaris Settings", "Change 
Device Name", "Quick Start Guide", "Password Protection", "Initialize Polaris 
Options", “Voice options”, "Polaris Global Options", “Android Backup & Reset” 
and “Android System Settings”. The following sections discuss each of these 
items in detail. 

 

3.1 Set Time and Date 
To set the Polaris's internal clock, press "Enter" on "Set Time and Date" in the 
"Settings" menu. Or press T to open the "set time and date" dialog from the 
menu. You can launch the "Set Time and Date" dialog from anywhere on the unit 
by pressing "F3-T".  

The set time and date is a dialog, consisting of the following: "Time zone", "Time 
format", "Time", "Date Format", "Date", "Synchronize with time server", a 
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"Confirm" button, and a "Cancel" button. You can move among these items by 
pressing “F3” or “Space-F3”. 

When you activate "Set Time and Date", "Time zone?" appears followed by the 
default time zone. You can choose your desired time zone by navigating to it 
using "Space-1" or "Space-4" or by typing the first letter of the time zone. Once 
done, move to the next item using "F3". 

The next item is "Time format", the options for which are 12 hour and 24 hour 
time. You can toggle between the two using "Space-1" or "Space-4".  

The next item is "Time". When typing the time, separate the hour and minute 
using a space or a colon.  

If you select 12 hour clock in the "Time format", A.M. or P.M. is displayed after 
the hour and minute. In the 12 hour clock, you can toggle A.M. it P.M. by 
pressing "Space-X".  

Tab to "Date format". You can choose to display the date in either the "short" or 
"long" format. The short format displays the date numerically, while the long 
format displays the Month spelled out and shows the date as it would appear in 
literary form. Toggle between the two using "Space-1" and "Space-4".  

The next item is "Date". Type the "Date" month, date, and year as mm/dd/yyyy. 
Use 2 digits for the month, 2 digits for the day, and 4 digits for the year, 
separating them by a space or a slash.  

The next item is "Synchronize with time server", used to synchronize time and 
date with a time server on the Internet. This function is extremely useful when 
the date and time of Polaris is faster or slower than the current time. To execute 
this function, your Polaris must be connected to the Internet. When connected, 
press "Enter" on the "Synchronize with time server" button. After 
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synchronization, it displays the synchronized time in the "Time" edit combo box. 
The synchronized date is also displayed in the "Date" edit combo box. 

If you do not wish to enter date and time information directly, you can navigate 
using the following commands: 

When setting time: 

Move forward 1 hour: Space-4 

Move back 1 hour: Space-1 

Move forward 10 minutes: Space-5 

Move back 10 minutes: Space-2 

Move forward 1 minute: Space-6 

Move back 1 minute: Space-3 

When setting date: 

Move to the next day: Space-6 

Move to the previous day: Space-3 

Move to the next week: Space-5 

Move to the previous week: Space-2 

Move to the next month: Space-4 

Move to the previous month: Space-1 

Move to the next year: Space-5-6 

Move to the previous year: Space-2-3 
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When you have completed entering all of the information, press "Enter" to save 
your settings, or "Tab to "Confirm" and press "Enter", and you are returned to 
the "Settings" menu. 

 

3.2 Setup Internet 
The "Setup internet" function is used to configure your Polaris to use a LAN or 
Wireless connection to access the Internet.  

 Note: to use a LAN connection, you will need a USB to Ethernet adapter.  

To activate "Setup internet", press "Enter" on "Setup internet" in the "Settings" 
menu, or press "I". You can open the "Setup Internet" menu from anywhere on 
the unit by pressing "F3-I".  

 

3.2.1 SETUP WIRELESS LAN 
Before setting up a Wireless LAN connection, be sure wireless is turned on in 
the "Global Options" dialog. You can toggle wireless on and off from anywhere 
on the Polaris using "Backspace-1-4-5-6". In addition, when you choose this 
option, if Wireless is not turned on, BrailleSense automatically activates 
Wireless LAN. To connect to a wireless network, navigate to the "Wireless LAN" 
option in the connection types list under "Setup Internet" and press "Enter".  

The "Wireless LAN" dialog consists of the "access points" list, "Advanced" 
button, "Options" button and "Close" button. You can move among these 
controls by pressing "F3" or "Space-F3". If wireless is not turned on, the "access 
points" list displays "no items".  
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When wireless is on, this list shows the wireless "access points" (networks) in 
range of your notetaker. The "Access points" list displays the "access point 
name", "encryption", and "sensitivity" of each item. (Ex: linksys, encryption: 
WEP, sensitivity: good.) If there is more than one access point in the list, you 
can move among them by pressing "Space-1" or "Space-4". Move to the 
"access point" to which you want to connect, and press "Enter". If the access 
point has no encryption, the Polaris announces, "Connecting to (access point 
name)". If connection is successful, the connecting sound is heard. If the 
network is encrypted and requires a network key, when you press "Enter" on the 
access point, the "Network key" edit box is displayed. Type the network key in 
computer Braille in the edit box and press "Enter". If your settings are correct, 
the unit says, "Completed setting profile" and the connecting sound is heard.  

The "Advanced" dialog is used to modify an existing profile, manually add a new 
profile, or check the settings of an existing profile. Pressing "Enter" on the 
"advanced" button, while wireless LAN is turned on, displays a list of the 
wireless profiles saved on the Polaris. 

The "Advanced" dialog has 5 controls: the "profile list", "Connect" button, "Add" 
common dialog button, "Remove" button, "Properties" common dialog button, 
and "Close" button. You can navigate among these controls by pressing "F3" or 
"Space-F3". Navigate the items in the Profile list using "Space-1" and "space-4". 
Press "Enter" to activate one of the buttons. 

Use the "Add" button: to manually add a profile, specifically where an SSID is 
hidden, and thus does not appear in the "access points" list. The "Add" dialog" 
contains 10 controls. 

1) "Setup IP: Automatic" combo box: You can switch between automatic and 
manual by pressing "Space-4" or "Space-1". If you select "Manual", you must 
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enter your IP address, subnet mask, gateway IP address, and DNS IP address. 
You can move among these computer edit boxes by pressing "Space-4" or 
"Space-1". Press "tab (Space-4-5)" to move to the next control. 

2) "Network name (SSID)" computer edit box: Type the network ID in the 
computer edit box. 

3) "Network mode" combo box: You can select among "Infrastructure", and 
"802.11 ad-hoc" mode by pressing "Space-1" or "Space-4". 

4) "Network authentication mode" combo box: Select among "Open", "Shared", 
"WPA-PSK", and "WPA2-PSK" by pressing "Space-1" or "Space-4". 

5) "Data encryption" combo box: Select the data encryption method by pressing 
"Space-1" or "Space-4". If you select "Open" or "Shared" in network 
authentication mode, you can choose among "Disable" and "WEP". And if you 
select "WPA-PSK" or "WPA2-PSK" in network authentication mode, either "AES" 
or "TKIP" can be selected in the "Data encryption" combo box. 

6) "The key is provided automatically" check box: If the "access point" does not 
provide a key for users automatically, uncheck this check box by pressing 
"Space". The default is checked.  

7) "Network key" computer edit box: This is a computer edit box to type the 
network key if the key is not provided automatically. 

8) "Key index" edit box: This is an edit box to type the key number of the 
wireless access point that matches the network key input. 

9) "Confirm" button: Pressing this button applies the changes. 

10) "Cancel" button: You can select this button to cancel the setup. 

 Things to note:  
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1) If "Data encryption" has been set as "disabled", press "F3" and you are taken 
directly to the "Confirm" button.  

2) "Network key" and "Key index" is displayed only if you uncheck "The key is 
provided automatically". 

To delete a profile item in the profile list, select the profile item you wish to 
delete, and press R or "Tab" to the "Remove" button and press "Enter".  

To get information about a selected profile item in the profile list, "Tab" to the 
"Properties" button and press "Enter". In the "Properties" dialog, you can 
reconfirm or modify the information for each profile.  

To exit the "Advance" dialog, press "Space-E" or "Space-Z". 

The "Options" dialog allows you to set how the Polaris scans for and detects 
wireless networks. The "Scanning Always Available" option allows you to choose 
whether Polaris auto scans for available networks, even when you don't open 
the Setup Internet dialog. The "Wi-Fi Frequency Band" determines what Wi-Fi 
networks are detected and used. Choose from "Auto", "5GHz" and "2.1GHz". 
Use "Space" to adjust the options in the dialog, and press "Enter" to save your 
settings. 

 

3.2.2 LAN SETUP 
Before attempting to set up a LAN connection, connect one end of a LAN cable 
to the Polaris via a USB to Ethernet adapter, and the other to a router or direct 
LAN connection to the Internet. ?. From the list of connection options in "Set up 
Internet", navigate to "LAN" and press "Enter".  

"Setup IP: Automatic" is displayed. If your service provider does not require you 
to use a static IP address, simply press "Enter" on this option for automatic 
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setup. For the automatic setup, your host server should provide DHCP service 
(Dynamic Host Configuration Protocol). 

To set up your IP configuration manually, move to "Manual" by pressing "Space-
1", and press "Enter". The following settings are displayed: "IP", "Subnet mask", 
"Gateway", and "Primary DNS". These settings require specific numeric 
addresses. Please contact your Internet service provider for the correct 
addresses. Use computer Braille to type the information for each setting, using 
"Space-1" and "Space-4" to move among the settings. When you have entered 
the information for each item, press "Enter" to save the settings. The unit 
announces, "Setting completed". And you are returned to "Setup internet". Your 
Internet connection should be active.  

 

3.3 Bluetooth Manager 
The Polaris is Bluetooth capable, or rather, you can connect the Polaris to 
various devices such as keyboards, printers, audio devices, and other 
computers without the need for cables. You can also use Bluetooth to transfer 
files, or to connect the Polaris as a Braille display with a compatible screen 
reader. Bluetooth is the latest in wireless technology and enables wireless 
connectivity via a Personal Area Network (PAN). Unlike a traditional Wireless 
Local Area Network (WLAN), these networks are limited to approximately 30 
feet or less. Bluetooth enables users to exchange various types of information 
over this wireless connection.  

You can toggle Bluetooth on/off from anywhere on the unit using "Backspace-
dots-3-4-5-6".  
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To access the Bluetooth Manager from the program menu, navigate to the 
"Settings" menu, and press "Enter. Then, navigate to "Bluetooth Manager", and 
press "Enter". You can also press "F3-B" to launch the Bluetooth Manager from 
anywhere on the unit. 

 

3.3.1 BLUETOOTH DEVICE LIST 
When the Bluetooth Manager is activated, you are placed in a dialog with 2 
items: a paired devices list, and a "Search" button to scan for available devices. 
For example, if you have a computer with Bluetooth enabled nearby, the Polaris 
attempts to find it. It may take 30 to 40 seconds to discover all of the Bluetooth 
devices in range. The Polaris announces and displays, "Scanning for devices. 
Please wait...” Full cells are filled in on the Braille display to indicate scanning 
progress.  

When a Bluetooth device is detected, the Polaris announces "found (Bluetooth 
device name)".  

 Note: while the Polaris is scanning for Bluetooth devices, it cannot 
respond to key presses. In addition, you may not cancel the scan once it 
has begun, but must wait for its completion before the Polaris returns to 
normal operation.  

When the scanning process completes, you are placed in the Bluetooth Device 
List. If the Polaris has found other Bluetooth devices in range, they are 
displayed as "device name (untrusted (or trusted)) xx/yy" where xx is the 
number at which the device appears in the list, and yy is the total number of 
devices. "Trusted" indicates that the service has been authenticated, "untrusted" 
indicates the service has not been authenticated. 
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If there are no other Bluetooth devices in range, the Polaris announces, "no 
items". You can press "Space-1" or "Space-4" to move through the list. To select 
a device from the list, press "Enter" on the device name. 

If the Bluetooth device is trusted, settings for connecting the device are 
automatically saved in the Polaris. If you want to delete this information, press 
"Space-D" on the Bluetooth device name in the list. The Polaris announces, 
"Device settings removed". Removal of the settings applies only to the current 
device. 

From the Bluetooth Device List, you can access the menu by pressing "F2". The 
"Bluetooth Device List menu" contains "Rescan for Devices", "Delete Pair 
Information", "Options" and "Exit". You can navigate among the menu items 
using "Space-1" or "Space-4". 

The first menu item is "Rescan for Device". This option initiates a new scan for 
other Bluetooth devices. To activate this item, press "Enter" on "Rescan for 
Devices" in the menu. Or you can activate it directly from the list by pressing 
"Enter-R".  

The next menu item is "Delete Pair Information". This item allows you to remove 
the connection settings for the current device. To activate this item, press 
"Enter" on "Delete Pair Information" from the menu, or press “Space-D" to 
activate it from the Device List.  

The "Options" item lets you determine if the Polaris is discoverable to other 
Bluetooth devices. Press "Space" to check or uncheck the option. 

The final item in the Bluetooth Device List menu is "Exit". This option exits the 
Bluetooth Manager program. To activate this item, press "Enter" on "Exit" from 
within the menu, or exit the program any time by pressing "Space-Z".  
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3.3.2 BLUETOOTH SERVICE LIST 
When you locate a Bluetooth device to which you'd like to connect, press 
"Space-1" or "Space-4" to navigate to the device in the Bluetooth Device List, 
and press "Enter" on the device name. The unit announces, "Scanning for 
services. Please wait...” Please note The Polaris does not respond to key 
presses during the scanning process.  

The Polaris supports the following Bluetooth services: FTP, Serial port, USB 
port, and headset. To access any of these functions, be sure that the remote 
Bluetooth device is in Discoverable mode, and that the service you wish to 
access is enabled on that device. It is possible to have certain services enabled 
on your remote Bluetooth device, while disabling others. The Polaris only sees 
and displays services which are enabled on your remote device, even if others 
are available.  

When the Polaris has found all of the available services, the services are 
displayed in a list in the following format: "service name xx/yy" where xx is the 
number at which the service appears in the list, and yy is the total number of 
available services. You can move through the available services by pressing 
"Space-1" or "Space-4". Press "Backspace" to return to the Bluetooth Device 
List. 

From the Bluetooth Service List, you can access the menu by pressing "Space-
M" or by pressing "F2". The "Bluetooth Service List menu" contains "Open FTP", 
"Disconnect" and "Exit". You can navigate the menu items using "Space-1" or 
"Space-4". 

The "Open FTP" menu item allows you to quickly open a direct FTP connection 
with a remote Bluetooth device without accessing the Device and Service lists. 
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However, you must have connected the FTP service previously for the Polaris to 
allow you to transfer files. If you have not connected the FTP service, and you 
activate this function, the unit announces, "FTP service disconnected".  

You can access "Open FTP” by pressing "Enter" on it from within the menu, or 
by pressing "Enter-T" directly from the Bluetooth Service List. The Polaris says, 
"Connecting service". Detailed information on connecting various service types 
is covered later in this chapter. 

The "Disconnect" menu item allows you to disconnect services with other 
Bluetooth devices. You can access this item by pressing "Enter" on "disconnect" 
from within the menu. Or you can activate it directly from the Bluetooth Service 
List by pressing "Enter-D".  

If there are no services connected and you activate this function, the unit says, 
"There is no service connected". 

 

3.3.2.1 Connecting a Service 
To authenticate a service and connect to it, press "Enter" on the service. The 
Polaris announces, "Connecting service". You are then prompted for a "PIN 
code:" You must use ASCII characters when you type the pin code. This edit box 
only appears when you have not previously connected to a service, and a pin 
code is required by the device. You can exit the edit box or delete text you have 
typed by pressing "Space-Z" and you are returned to the Bluetooth Service List. 

When you finish typing the pin code, press "Enter". The unit announces, "Please 
wait for authentication". If the remote device is setup correctly, and has not been 
set up to allow this device to always connect, the remote device also asks for a 
pin code. Please be sure to enter the same pin code on both devices. If the 
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remote Bluetooth device pin code matches the pin code on the Polaris, the 
service should authenticate. If connection is successful, the unit announces, 
"PIN code authentication accepted".  

You are then prompted, "Please wait. Access permission". If the remote 
Bluetooth device does not give access permission, the unit says, "Connection 
failed", and you are returned to the Bluetooth Services List. If the remote 
Bluetooth device gives you access permission, the Polaris says "Connection 
succeeded". If the connection succeeds, "Connected" is displayed after the 
service in the Bluetooth Service List. Some services may be connected without 
inputting a pin code depending on the Remote Bluetooth device settings. 

3.4 Menu Manager 
Using the Menu manager on the Polaris, you can manage what menus and/or 
programs are displayed in the Main Menu, sub menus, and All Apps. You can 
show or hide almost any program in the Main Menu with a few exceptions. You 
may not hide the File manager, or the Menu Manager itself.  

To execute the "Menu manager", from the "program" menu, press S" to open the 
"Settings"" menu. Press M to open "Menu manager". The "Menu manager'" 
dialog is displayed. You can also launch the "Menu Manager" from the Main 
Menu by pressing "Enter-H".  

The dialog of the "Menu manager" consists of the following items: The 
menu/program list, Confirm button and Cancel button. To navigate among the 
programs, press "Space-1" or "Space-4". Press "F3" or "Space-F3" to navigate 
to the "Confirm" and "Cancel" buttons.  
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Menus are displayed if they have programs accessible inside them. If you have 
chosen to hide all the programs in a given menu, this menu is not displayed in 
the Program menu.  

To hide unused programs on the polaris, press "Space" on each of the programs 
you wish to hide in the list. Hidden programs will display an Asterisk (*) next to 
their names. Press "Enter" to save your settings, or tab to "Confirm" and press 
"Enter". After a couple of seconds, the you are returned to the program menu, 
and the programs you chose to hide are no longer displayed.  

To unhide the programs, return to the "Menu Manager" dialog, and press 
"Space" on the programs you wish to unhide, and press "Enter" to save the 
settings.  

*Note: Using the “Initialize options” function described in section 3.9, all menu 
items will return to their default status of being displayed. 

 

3.5 Backup/Restore Polaris Settings 
If you hard reset your Polaris or initialize the Polaris Options, the main option 
settings and settings for each program are initialized to the default values. If you 
have created a backup of your settings, you can restore the option settings after 
the hard reset. 

You can run this utility by pressing K from the "Settings" menu. You can also 
launch the "Backup/Restore Polaris Settings" dialog from anywhere on the unit 
by pressing "F3-K".  

The "backup/restore" dialog contains: the "program option check box list", a 
"Select all" button, a "Backup" button, a "Restore" button, and a "Cancel" button. 
You can move among the check boxes in the "program option check box list", by 
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pressing "Space-1" or "Space-4". You can move among the controls in the 
dialog by pressing "F3" or "Space-F3". 

The "program option check box list" contains "Options settings", "File manager 
options", "Word processor options", "E-mail Options", "Media Player options", 
"Radio Options", "DAISY Player options", "Address manager options", 
"Schedule manager options", "Web browser options", “Excel Viewer Options", 
"Wake Up Alarm Options" and “Bluetooth manager options". 

In this list, move to the program options you want to backup or restore and 
check the item by pressing "Space". You can uncheck a checked item by 
pressing "Space" again. To select all of the program options in the list, press 
"Enter" on the "Select all" button.  

After selecting all the options you want to backup or restore, press "Enter" on 
the "Backup" or "Restore" button, or press "Enter-B" to backup or "Enter-R" to 
restore. If you select the "Backup" button, you are prompted to select a path for 
storing the backup file. You can accept the default path, or choose an 
alternative. Navigate to the folder in which to store the backup files using normal 
file/folder navigation commands. Select the folder or drive in which to store the 
backup by pressing "Space", and press "Enter" to start the backup process. If 
you select the "Restore" button, you are prompted for the path from which to 
restore backup files. Again, use normal file and folder navigation to select the 
folder containing your backup files. If you select a folder in which there is no 
backup, you receive a message indicating there is no backup option file. To 
restore your settings, select the folder containing the backup files by pressing 
"Space", then press "Enter" to initiate the restore process. 

 



 
 

 65  

  

 

3.6 view Device Name 
The "View device Name" function allows you to view the Bluetooth/network 
name of your unit, so that you can correctly identify it when connecting to other 
devices.  

You can access the "View device Name" dialog by navigating to the "Settings" 
menu, then to "View Device Name". You can also launch the "View device 
Name" dialog from anywhere on the unit by pressing "Backspace-Enter-E".  

The "View device Name' dialog consists of 2 controls: a "Device Name" static box, 
and a “Close” button.  

 

 

3.7 Quick Start Guide 
The Quick Start Guide runs a getting started wizard that introduces you to 
Polaris and its functions, and lets you set basic preferences. This guide 
automatically launches the first time you start your unit. You can relaunch it at 
any time by selecting the “Quick Start Guide” option in the “Settings” menu. 

When you press “Enter” on this option, you are asked, “Would you like to reboot 
your system and launch the Quick Start Guide?”. Press “Enter” for Yes, or 
navigate to ‘No’ with “Space-4” and press “Enter” to cancel this operation. 

 Note: when you launch the Quick Start Guide, all options are initialized to 
factory defaults, so that they can be reset using this wizard. 
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3.8 Password Protection 
The Password Protection item allows you to set a password that must be 
entered when the unit is powered on, comes out of Sleep Mode, is upgraded, or 
the disk is formatted. 

WARNING!! It is imperative that you create a password that you can easily 
remember, or that you store in another location for easy retrieval! Due to Android 
security safeguards, we are not able to send unlock codes as has been the case 
with older BrailleSense models. If you set a password using this function, or 
using the Android system settings, and you are not able to remember or retrieve 
it, it will be necessary to send the unit to HIMS/SELVAS for unlocking, during 
which, all data will be lost. As remembering and retrieving personal passwords is 
the responsibility of the customer, any costs associated with transporting and/or 
unlocking the unit are also the responsibility of the user.  

To open the "Password Protection" settings, from the Main menu, navigate to 
"Settings" and press "Enter". Press A to jump to and open "Password 
Protection". You can open "Password Protection" from anywhere on the unit by 
pressing "F3-N".  

The "Password Protection" dialog consists of 4 items: "set/modify Password" 
dialog, "Password Configuration" dialog, "Set Password to factory defaults", and 
a "Close" button. Use "F3" or "Space-F3” to move among the controls in the 
dialog. 

 

3.8.1 SETTING AND MODIFYING PASSWORDS 
When you open the "Password Protection" program, you are placed on the "Set 
Password" option. Press "Enter" to open the "Set Password" dialog. The "Set 
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Password" dialog consists of 4 controls: "Password" edit box, "Retype 
Password" edit box, "Confirm" button and a "Cancel" button".  

Type the password you wish to use into the "Password" edit box. Tab to the "Re-
type Password" edit box, and type it again. To save the password, press "Enter", 
or Tab to "Confirm" and press "Enter". To cancel saving the password, press 
"Space-Z", or Tab to the "Cancel" button and press "Enter". 

When a password is saved, the "Set Password" option is replaced with "Modify 
Password". Once you have entered a password, you can modify in very much 
the same manner. The "Modify Password" dialog consists of all the same 
controls, except you must type your current password, before you can type a 
new one. Once you have typed your current password, then the new password, 
you must re-type the new password. Press "Enter" on the "Confirm" button to 
save the new password, or "Enter" on the "Cancel" button to cancel the 
modification. 

 

3.8.2 PASSWORD CONFIGURATION 
The "Password Configuration" dialog allows you to define when you are 
prompted to enter the password. When you press "Enter" to open the "Password 
Configuration" dialog, you are prompted to enter your password to gain access 
to this configuration. Type your password, and press "Enter". 

The password configuration settings consist of 4 radio buttons: "Prompt for 
password on boot", "Prompt for password when in Sleep Mode", "Prompt for 
password when formatting" and "Prompt for password when upgrading." Use 
"Space-1" and "Space-4" to toggle these buttons between "Yes" and "no". When 
you have chosen your options, press "Enter" on the "Confirm" button to save 
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your settings. If you want to cancel the configuration, press "Enter" on the 
"Cancel" button. 

 

3.8.3 RESET PASSWORD TO FACTORY DEFAULTS 
Use this option to reset the password configuration and return your unit to its 
factory state of no password protection. 

When you press "Enter" to open this option, you are prompted, "Do you want to 
initialize the password settings?". Use "Space-1" and "Space-4" to choose 
between "yes" and "No". If you choose "yes", you are prompted for your current 
password. Type it, and press "Enter". The unit announces, "Password settings 
have been initialized" and you are placed on the "Set Password" option.  

 

3.9 Initialize Polaris Options 
You can use the "Initialize Polaris Options" item to restore the BrailleSense 
Polaris to the factory default settings. 

To launch this function, navigate to it in the "Settings" menu, and press "Enter", 
or press C.  

You are prompted, "Do you want to initialize options?" Use "Space" to choose 
"Yes" or "No". Choosing "Yes" initiates the factory reset process. Choosing "No" 
cancels the function and returns you to the "Settings" menu. You can also 
perform this function by holding the Forward Media key while pressing the 
Power Button. Once you see “HIMS” displayed on the Braille display, you can 
release the Forward key.  
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3.10 Voice Options 
The Voice options menu allows you to configure the text-to-speech engine and 
voice used on your Polaris.  

You can open the Voice options dialog quickly at any time by pressing “F3-V”. 
When the “Voice Options” dialog is opened, you are placed in a combo box with 
two “Voice Type” options: “Polaris Vocalizer” and “Android TTS”. Use “Space-1” 
and “Space-4” to move among the choices, and press “F3” to access further 
options for each choice. 

 

3.10.1 POLARIS VOCALIZER 
This option allows you to install and set alternative Vocalizer Expressive TTS 
voices. Available voice downloads are available via the “Download” option in this 
dialog. To download and install directly from the Polaris, choose the “Download” 
button, and use “Space-1” and “Space-4” to choose the voice you want and 
press “Enter”. The correct folder will be auto created, and the language pack will 
automatically be placed there and installed. 

You can also download voices manually via the HIMS website. 

When you have downloaded the language pack files, create a folder on your 
flashdisk called “TTSDATA”, and copy the files in to it.  

Once done, open the “Settings” menu, and press “V” to open the Voice options 
dialog and press “F3” from “Polaris Vocalizer”. . This dialog contains a voices 
list, a “Download” button, an “Install” button”, and Confirm and Cancel buttons. 
Use “F3” and “Space-F3” to move among the controls. 
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Press “Enter” on the “Install” button to install any language packs available in 
the “TTSDATA” folder. When voices are installed, an “Uninstall” button also 
appears in the dialog.  

When you have installed your voices, use “Space-1” and “Space-4” in the 
Voices list to choose your voice, and press “Enter”. Your speech should 
automatically begin outputting using the voice you chose. 

If you wish to remove a Vocalizer voice from your unit, navigate to it and press 
“Space-D” to delete it. 

 

3.10.2 ANDROID TTS 
The “Android TTS” option allows you to choose the speech used on your Polaris 
from among Google TTS and any other TTS engines you have installed via the 
play Store or other Android packages. Press F3 on the “Android TTS” item in the 
combo box and any TTS engine you have installed appears in a list. Use 
“Space-1” or “Space-4” to choose the engine you would like to use, and press 
“Enter”. 

*Note: While it is possible to control most voice adjustments including pitch, rate 
and punctuation via the various Polaris voice settings, it is necessary to control 
voice volume, the default voice for each engine, and other settings specific to 
the engine you are using via the Android system settings under “Text-to-speech” 
in either the “Accessibility” or “Language and Input” area. 

 

3.11 Language Profiles 
Language Profiles allow you to easily set a group of settings for each language 
you encounter regularly, and instantly and conveniently switch between them. 
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You can open the Language Profiles by pressing L from the “Settings” menu. 

The Language Profiles dialog consists of a Profiles list, an Add button, a Modify 
button, a delete button and a Confirm button. Press “Space-1” and “Space-4” to 
move among profiles in the list, and press “Tab” and “Shift-Tab” to move among 
the controls in the dialog. 

The profiles List will always consist of at least 1 item, the “Default” profile. This 
profile is automatically set using the current Voice Options and Global Options 
settings, and will be modified as you, either change those settings, or modify this 
profile in the Language Profiles dialog. 

Pressing Enter on a profile in the list will switch to using that profile. If you choose 
Add or Modify, the Language Profile Settings dialog includes the following items: 

“Profile Name”, “Language”, “Braille Code”, “View/Input Grade”, “Eight Dot Mode”, 
“Voice Type”, “Voice Name”, “Voice rate”, “Voice Pitch”, and confirm and Cancel 
buttons. 

 

3.12 Polaris Global Options 
The "Global Options" on the Polaris is a large dialog box for controlling many 
preferences/settings.  Open the "Polaris Global Options" from the main menu, 
by pressing S to open the “Settings” menu, then "O" for the "Global Options". 
You can also open "Global Options" from anywhere on the notetaker by pressing 
"Space-O".  

The "Global Options" dialog is organized into groups, making it easy to jump to 
a particular section in the long list of settings. You can navigate among the 
groups with "page down ("Space-3-4-5" or "F3-F4")" or "page up ("Space-1-2-6" 
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or "F1-F2")". When you navigate to a group, you are placed at the position 
where that group of options begins.  

You can navigate among the individual options using "Space-1" and "Space-4" 
or using the scroll keys. You can also use shortcut keys to quickly move to 
specific items.  

 Note: Often, the same shortcut key is used for multiple options. Thus, the 
first press of the shortcut key moves the focus to the first setting that 
matches; pressing the key again moves to the next setting that matches. 
If there are no more settings matching the shortcut, the Polaris wraps 
around to the first match. 

Many of the Global Options also have global hotkeys, allowing you to adjust 
these settings from anywhere on the unit.  

You can toggle an option on or off or cycle through the available values of a 
setting with the "space" and "Backspace" keys. To save your changes, press 
"Enter" or tab to the "Confirm" button and press "Enter". Polaris says, "Saved 
options," and you are returned to your previous position on the notetaker. To 
cancel without saving changes, press the "F4" key, "Space-E" or "Space-Z".  

 

3.11.1 GLOBAL OPTIONS IN DETAIL 
The "Global Options" dialog contains the following settings. For each setting, the 
shortcut key appears in parentheses, and the hotkey, if available, is shown in 
quotes.  

1) Braille display: (B). "Backspace-F3". Toggles the Braille display On/Off. 

2) Braille Cursor: (C). "F4-Up Scroll". Defines how the Braille cursor appears on 
the Braille display: "Always Up", "Blinking" or "Off". Note the cursor appears as 
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dots-7-8 in most situations. When selecting text, it notes the end of the selection 
with blinking dots-1-2-3-4-5-6-7-8. 

3) Eight Dot Mode: (E). "F4-Up Scroll". Toggles Eight Dot Mode on/off for ASCII 
text entry. 

4) View/input Braille Grade: (G). "Space-G". Lets you choose what grade of 
Braille you want to use when viewing/entering text: Uncontracted Braille, 
Contracted Braille, or Computer Braille.   

5) Braille Code: (C). "Backspace-Enter-B". Defines the rules by which Braille is 
translated to text and vice versa: "US", "UK", "UEB", or one of several foreign 
language Braille codes. When foreign language codes are set, you can read and 
write Braille according to that language's Braille rules. The Braille language also 
affects lists, combo boxes, and edit boxes. Prompts, menus, buttons and static 
boxes remain in English. 

6) Message Display Time: (M). defines how the Polaris deals with system 
messages: ignore, stand by until you press a key, or, display for from 1 to 10 
seconds before disappearing. 

7) Voice: (V). "Backspace-F2". Toggles the voice output On/Off. 

8) Punctuation Level: (P). Use this setting to choose how you want the Polaris to 
read punctuation marks and symbols: "All", "Off", "Punctuation," or "Symbols".  

9) Keyboard Echo: (K). Defines how Polaris speaks as you type: "On with 
characters and words," "On with characters," "On with words," or "Off".  

10) Capitalization alert: (U). Choose how the Polaris alerts you that a character 
is capitalized, either when typing or when navigating a document or edit box by 
character: "Off", "Say cap," or "Pitch". 
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11) Numbers: (N). Defines how Polaris speaks numbers: when set to "On", 
Polaris speaks numbers, and when set to "Off", it speaks digits. 

12) Voice Volume: (L). "Backspace-F1 and Backspace-F4". Raises or lowers the 
volume of the text-to-speech. 

13) Voice Rate: (R). "Space-F1 and Space-F4". Controls the rate of the speech. 

14) Voice Pitch: (T). "Enter-F1 and Enter-F4". Adjusts the pitch of the Polaris 
voice.  

15) Main Volume: (V). "Backspace-SPACE-F1 and Backspace-Space-F4", or 
the Volume Up and Down buttons. Controls the master volume of the unit, 
including system sounds, audio and speech. 

16) Headphone Volume: (V). Allows you to set a separate louder volume for 
headphones, useful when using high-end headphones with lower output. 

17) Scroll Voice: (S). Choose whether you want the Polaris to speak while using 
the scroll buttons as you read.  

18) LCD: (L). "Enter-4-5-6 from main menu". Turn the LCD On, On with 
Backlight, or Off. 

19) Flip LCD display: (F). Choose whether the LCD shows text in normal or 
reverse orientation. Reverse orientation can be useful for a sighted person 
viewing Polaris from across a table. 

20) LCD Font Size: (F). Adjust the size of the font on the LCD. 

21) Show Virtual Braille Display on HDMI: (B). This option determines if, when 
you are connected to an HDMI monitor, a visual representation of the braille 
display and its print translation appears at the bottom of the screen.  



 
 

 75  

  

 

22) Audio alerts: (A). Choose whether the Polaris alerts you to various events 
using audio signals, vibration signals, both, or no signal. 

23) Battery Alerts: (B). Choose how you are alerted when your battery is low: 
"Message", "Beep", "Final Message" or "Final Beep".  

24) Play Power On/Off Sound: (P). Choose whether you hear a sound when you 
turn on/off the Polaris.  

25) Left Scroll Buttons: (L). Define the operation of the left scroll buttons: "Scroll 
display", "Move by line", "Move by character", "Move by paragraph" and "Move 
by sentence".   

26) Right Scroll Buttons: (R). Define the operation of the Right Scroll buttons 
with the same options as above. 

27) Skip Empty Lines: (E). Choose to have the Polaris alert you to a blank line 
by announcing "Blank" or skip empty lines.  

28) Control Information: (I). Define where information is announced regarding 
the type of control on which you are currently located, a list item, menu, combo 
box, etc. Choose from Before, After and Off.  

29) Hide passwords: (P). Choose whether the characters of a password are 
hidden as you type them.  

30) Hot Key Information: (H). Defines how hot key information is announced: 
"Letters," "Dot patterns," or "Off".  

31) Announce shortcut keys: (S). Lets you choose whether the Polaris speaks 
the menu shortcut key for a function as you encounter it.  

32) power Button operation: (P) “Backspace-Enter-P”. Choose the state your 
Polaris goes in to when the Power button is pressed: “Screen Off”, as in the 
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case of a normal Android phone or tablet, or “Deep Sleep”, which turns off 
Bluetooth, Wi-fi, etc., similar to a traditional notetaker sleep mode. 

33) Sleep Mode: (P). Set Polaris to save power by automatically shutting down 
after a certain period of time: "On", "Off", or "Message". (Only active when using 
battery power.) 

34) Sleep Mode Kick In: (K). Use this option to set the time of inactivity before 
entering SLEEP Mode: 10 minutes, 20 minutes, or 30 minutes. 

35) Check Today's Schedule: (S). Set the Polaris to check today's schedule for 
appointments each time you turn it on.  

36) Touch Gestures: (J). Turn the use of Braille display touch gestures On/Off. 

37) One-Handed Mode: (H). This option allows users with only the use of one 
hand to use the Polaris in a specific mode adapted for that purpose. For detailed 
information about one-handed mode, refer to section 2.14.  

38) Enable Spell-check: (C). You may wish to disable spellcheck in educational 
situations where a student needs to be tested on spelling, etc. 

 Note: If "Enable Spellcheck" is turned off, Automatic Spellcheck cannot be 
used. 

39) Automatic spell-check: (C). Set whether the Polaris automatically checks 
spelling as you type in "multi line edit boxes" in programs such as the Schedule 
Manager, Address Manager, E-mail messages, the Word Processor, etc. If the 
option is "On", and you enter a misspelled word, Polaris emits a beep sound to 
indicate the misspelling.  

40) Default notepad Document Type: (Q). Set the default document type for new 
documents you create using the Notepad: “DOCX document”, "Sense 
document", "Braille document,", "DOC document" or "Text document".  
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41) Automatically synchronize with time server: (T). Using this feature, you can 
ensure the accuracy of the time on the Polaris by synchronizing with an atomic 
clock when Polaris is connected to the Internet.  

42) Time Announcement: (T). Set the Polaris to announce the time every 5 
minutes, every 10 minutes, 30 minutes or every hour.  

43) Progress indicator: (P). Defines how the progress of opening a document, 
copying files or opening a webpage is indicated: "Silent," (no progress 
indication) "Beep," (continuous beeps while the task is performed) and 
"Message" (progress is shown as a percentage).  

44) Bluetooth: (B). "Backspace-3-4-5-6". Toggles Bluetooth On/Off.  

45) Wireless LAN: (W). "Backspace-1-4-5-6". Toggles Wireless LAN On/Off.  

46) Screen Reader Hints: (H). Set whether to receive spoken hints about how to 
interact with the screen reader as you navigate the controls of 3rd party 
programs: "On/Off". 

47) Screen Reader Control Information: (I). Determines whether the screen 
reader speaks the type of control or field as you navigate 3rd party applications: 
"On/Off". 

48) Notification alerts: (N). Set whether you receive push notifications from 
Android applications.  

49) Enable Braille in standby Mode: (N). Set whether status messages are 
shown in Braille while in Sleep Mode.  

50) Language: (L). Allows you to easily change the system language of the unit 
to any open firmware localization. *Several things to note: Because this is 
connected specifically to an Android setting, all Android languages appear in this 
list. If you choose a language for which we do not have a localization, Polaris 
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prompts and menus appear in English, though you may operate in the chosen 
language on the android side. Currently Braille and TTS need to be changed 
separately via their respective options. Additionally, any open applications need 
to be closed and re-opened before they will appear in the changed language. 

 

3.13 Android Backup & Reset 
The “Android Backup & Reset” option opens the Restore and Reset options 
found in the Android System Settings in a more convenient location. Here, you 
can set options for backing up and restoring information related to your Android 
applications and accounts, and you can factory reset your device. WARNING! 
Performing a factory Reset in the “Android Backup & Reset” menu erases all 
personal data, including files, account information, installed applications, etc. 
This is also a long and involved process and should not be undertaken before 
consulting with tech support staff, as you will need special instructions to 
complete it properly. 

 

3.14 Android System Settings 
The “Android System Settings” is the final item in the “Settings” menu. You can 
launch it from anywhere using “F3-E”. 

This option opens the standard Android “Settings” dialog found on stock Android 
phones and tablets. While many settings are duplicated in the Polaris interface, 
the “Android System Settings” contains a standard Android interface, and must 
be navigated in the same manner as Android applications. Use “F3”, and 
“Space-F3” to move among objects on a screen. Use “Backspace-Space-1” and 
Backspace-Space-4” to adjust slider controls. Please see chapter 12 on the 
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Mobile Screen Reader, and chapter 15, Commands Summary, for more 
complete information on navigating the Android interface. 

4. File Manager 
 

4.1 Overview 
The functionality and structure of the "File Manager" on the Polaris are similar to 
"Windows Explorer" on a PC. To run the "File Manager", press F from the 
"Program" menu or press "Enter" when your cursor is placed on "File Manager". 
You can launch the "File Manager" from anywhere on the unit by pressing "F1-
F". Close the "File Manager" by pressing "Space-Z". 

The "File Manager" contains 2 basic areas: an "address window" and the 
content list. You can navigate between them using "F3" and "Space-F3". When 
you first open the "File Manager", you are placed in the drive list. By default, you 
are placed on the internal "flashdisk". If an SD card or USB drive is connected, it 
also appears in the list. You can use "Space-1" or "Space-4" or the scroll buttons 
to navigate the items in the drive list. Press "Enter" on the drive you want to 
open. The Polaris then displays the list of the files/folders on that drive.  

The "address window" contains the path of the current directory or file.  

The "File Manager" contains both menus and hot keys, allowing you to easily 
activate items in the program with a single keystroke as well as to access 
functions through the menus for commands you have not memorized. You can 
bring up the menus by pressing "Space-M" or "F2". For the purposes of the 
directions in this chapter and the rest of this manual, we will use F2. However, 
either keystroke will perform this function. 
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Use Space-1" and Space-4" to navigate among the available menus. To open a 
menu, press "Enter". Again, use "Space-1" or "Space-4" to navigate among the 
items in a menu, and press "Enter" to execute a menu item. 

The File Manager also contains dialogs. You can navigate among the controls in 
a dialog box by using the equivalents of "Tab" on a PC. You can use "F3" or 
"Space-4-5" for "Tab" and "Space-F3" or "Space-1-2" for "Shift-Tab". For the 
purposes of instructions in this manual, we will use "F3" and Space-F3", or you 
will be directed to "Tab" or "Shift-Tab". 

   

4.1.1 NAVIGATING THE FILE LIST 
The "File Manager" contains two kinds of lists: the "file list" and the "menu list", 
or rather, the list of items contained in the "File Manager" menu. The menus in 
the Polaris wrap. This means, when you reach the end of the list of items in a 
menu, the Polaris automatically brings you back to the top of the list when you 
press "Space-4". However, when you reach the end of a "file list," the Polaris 
remains at the end of the list, even if you press "Space-4". The following is a list 
of the keystrokes used for navigating lists: 

 Note: the following keystrokes can be used to navigate any list on the 
Polaris. 

1. Move to previous item: (Space-1) or up scroll button 

2. Move to next item: (Space-4) or down scroll button 

3. Move to the beginning of a list: Space-1-2-3 

4. Move to the end of a list: Space-4-5-6 

The following keystrokes are valid only in a "file list". 
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1. Jump to folder or file list: Space-5-6 

2. Move between file list and address window: (Space-4-5 or F3) / (Space-1-2 or 
Space-F3) 

3. Enter the selected folder or open the selected file: Enter 

4. Move back a level in the folder structure: Backspace 

5. Jump to the drive list: Space-1-2-5-6 

6. Move to the previous group of 32 items: Page up (space 1-2-6 or F1-F2) 

7. Move to the next group of 32 items: Page down (space 3-4-5 or F3-F4) 

8. Jump to a file or folder by pressing the first character of the folder or file 
name. You must use ASCII characters. 

 

4.1.2 SELECTING FOLDERS AND FILES 
1. Select individual items "Space": * is displayed in front of the item to denote its 
selection. Pressing "Space" again on the selected folder or file cancels the 
selection. 

2. Continuous selection "Enter-b": This selects all of the items from the point 
where this command is executed to the item where the cursor is located. * 
appears in front of the selected items. 

3. Select all "Enter-a": This selects all the files and folders in the current list. You 
can toggle selection and de-selection of items by pressing "Space". When the 
"Select All" command is executed, the Polaris says the number of selected files, 
and * appears in front of the selected files on the Braille display.  
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4.2 Working with Files and Folders 
When viewing the contents of a drive or folder, the items in quotation marks are 
folders, and the items without quotation marks are files.  

The items in the list are followed by numbers, such as 1/5 or 2/5. The numbers 
following the items indicate an item's placement in the list and the total number 
of items in the list. For example, "database 1/5," indicates "database" is the first 
folder in a list containing five items. 

 

4.2.1 ENTERING AND EXITING FOLDERS 
There are several ways to open a folder.  

1. Bring up the menu by pressing "F2". Select the "Open" option from the list 
and press "Enter".  

2. Press the hot key "Enter-O" to activate the "Open" command and open the 
desired folder. 

3. Finally, as described above, you can simply press "Enter" on the selected 
folder. 

To exit the current folder, use the "Backspace" key. You are returned to the 
previous level in the folder structure.  

 

4.2.2 EJECTING USB DRIVES AND SD CARDS 
The Android operating system requires that drives are ejected properly before 
removing them. If not done, re-inserting them in to the Polaris or connecting to 
other mobile devices or computers may result in all files appearing as though 
they have no data, or have a size of 0 bytes. Before disconnecting a USB drive 
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or SD card, press “Backspace-Enter-U” or “Backspace-Enter-3-6” to    it 
from the system. If your drive is showing files with no data, please re-insert it in 
to the Polaris, and press the Unmount key to eject it properly, and the data 
should, be visible once again. 

 

 

4.3 The File Menu 
To open the "File" menu, press "F2" to bring up the menu, and press "Enter" on 
"File". Use normal list commands to navigate to your desired option and press 
"Enter". 

The Polaris supports the following file formats:  

1. Document files: hbl, brl, txt, brf, rtf, doc/docx, XLS/XLSX, PPT/PPTX, PDF 
and unprotected EPUB. 

2. Web formats: url, and html.  

3. Media formats: ac3, asf, asx, m3u, mp2, mp3, MP4, ogg, pls, wav, wax, wma, 
wmv and flac.  

4. DAISY formats: DAISY 2.0, 3.0, BookShare.  

5. Programs: APK. Press “Enter” to install. 

 

The menu contains the following items. Shortcuts are placed in parentheses, 
and hotkeys are in quotes. 

1) Open: (O) "Enter-O". Opens the selected file in the associated application for 
its file type.  
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2) Open in Document Reader: (K) “Backspace-R”. Appears only for supported 
document types, allowing you to open the file in the Read only Document reader 
as opposed to  the default Notepad or Word Processor. 

3) Open With: (E) "Enter-E". Allows you to choose a compatible application with 
which to open the selected file. 

4) Zip (Z) "Enter-Z". Compresses the current file or folder. 

5) Unzip (U) "Enter-U". Appears only for compressed files, extracts the current 
file.  

6) Send To: (S) "Enter-S". Lets you send the current file or folder to a different 
location. Targets include any connected local drives, e-mail and exchange E-
mail, and “Android Program, which will allow you to send files to available 3rd 
party apps according to the file type you are sending. 

7) Rename (R) "Enter-R". Rename the current file or folder. 

8) New Document: (N) "Enter-N". Create a new document using DOCX, DOC, 
TXT, BRL, or HBL. 

9) New Folder: (F) "Enter-F". Creates a new folder. 

10) File Conversion: (T) "Enter-T". Converts selected document files to TXT, 
BRL, or HBL. 

11) Find File: (F) "Space-F". Search the current drive or folder for a specific file 
by name. 

12) Find Text: (F) "Backspace-F". Search Word, Text, and Braille files on the 
current drive or folder for specific text strings.  

13) Merge Files: (M) "Enter-M". Select 2 or more text or Braille files to merge 
together. 
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14) Split Files: (P) "Enter-P". Split text or Braille files by paragraph or word 
count, by size, or into a certain number of files of equal size.  

15) Information: (I) "Enter-I". Provides basic properties of the current file or 
folder. 

16) Exit: (Z) "Space-Z". Closes the File Manager. 

  

4.4 The Edit Menu 
The Edit Menu contains the following items: 

1) Copy: (C) "Enter-C". Copies the selected files or folders to the clipboard. 

2) Cut: (X) "Enter-X". Cuts the selected files or folders to the clipboard.  

3) Paste: (V) "Enter-V". Pastes the files or folders on the clipboard to the current 
location. 

4) Delete: (D) "Space-D". Deletes the selected files or folders. 

5) Select All: (A) "Enter-A". Selects all the files and folders in the current list. 

 

4.5 The View Menu 
The View Menu contains the following options: 

1) Sort Files By: (G) "Enter-G". Determines in what order files and folders are 
displayed. 

2) Set File Info: (L) "Enter-L". Determines what information is displayed about 
each file or folder in the list.  

3) Display Only Files of Type: (W) "Enter-W". Filters files by file type. 



 
 

 86  

  

 

4) Hide System Folders: (H) "Enter-H". Hides Android system folders that do not 
contain user content. These are hidden by default. 

5) Document Open Settings: (D) “Enter-D”. This setting lets you determine in 
which program DOC and DOCX files are opened by default, Word Processor or 
Notepad. You can also choose to “Always select”, in which case you will be 
prompted every time. 

 

4.6 Google drive 
You can use the File Manager to interact directly with your Google drive content 
in a similar fashion as you do with the Flashdisk and other drives connected to 
your unit in terms of selecting and moving files, editing and saving documents 
and playing media content. 

You can easily transfer files between your Google drive and Polaris, using the 
BrailleSense File Manager interface, Open and edit documents using the Word 
Processor and Notepad, attach files using the E-mail or Exchange E-mail 
programs, read spreadsheets using the Excel Viewer, and play media content in 
the Media player.  

*Note: you must login to your Google drive account from the file Manager before 
the content will be available via the other applications mentioned above. 

The first time you open Google drive, you are placed in a Google Sign In page. 
Use “F3” and “Space-F3” to navigate the page. 

If you have already signed in to your Google account, it should appear in the list. 
press Enter on your Account, then locate the Allow Button and press Enter. 
Once done, you should be able to press Enter on Google drive and load your file 
and folders structure from the File Manager. Google drive will also appear in the 
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Open/Attach File dialog under the drive list when using the applications 
mentioned previously, and you will be able to navigate and select files and 
folders as you would from local drives on the unit. 

Please be aware of the following conditions: 

• Note that the file management functionality is limited to manipulation of files 
and folders at this time, thus, you will find the menu items are limited to 
functions like delete, rename, Copy and Paste, as Google drive doesn’t 
support functions like Zip and Unzip, Braille and TXT File conversion, etc. 
Please use “Space-H” to get a complete list of the available functions.  

• Only supports selecting files or folders for the purposes of opening or saving. 
• The login function is not supported from programs other than the File 

Manager. Please login to Google drive from the file manager before trying to 
use additional functions or applications.  

• Streaming media files is not supported. We download the file in a temporary 
folder in the flashdisk before playing. 

• In general, it should be noted, due to transferring to and from Google Drive, 
opening and saving files is a bit slower than when accessing local files and 
folders. 

 

4.7 Using the Address Window 
This edit box lets you type the direct path of the file name you want to open. 
This window also contains the history list for easily accessing recently opened 
files or directories.  

When you are in a file or folder list, you can press "tab (Space-4-5)" to navigate 
to the address window. The Polaris displays the current path including the 
current drive name, such as "flashdisk/download/". The address window is only 



 
 

 88  

  

 

visible when you are in a file or folder list. When you are in the drive list, the 
address window is not available. 

You can edit the text by relocating the cursor with a cursor routing key, the 
Polaris inserts the text at the cursor location. If you know the exact path and file 
name, you can type in the path and file name to open the file with the 
appropriate application. For example, if you type in "flashdisk/download" in the 
address window and press "Enter," the Polaris displays the list of the files in the 
download folder. If you type "flashdisk/My Documents/sample.txt" in the address 
window, and press "Enter," the Polaris loads the Word Processor, and opens the 
file "sample.txt".  

Use "Space-1" or "Space-4" in the Address Window to review the history list (a 
list of file and folder paths you have recently opened). To open a file in the 
history list, press "Enter". The file opens with the appropriate application. (See 
section 4.2.3). 

 

 

5. Word Processor 
The Polaris Word Processor supports creation of formatted DOCX and DOC 
files, as well as opening of DOC/DOCX and PPT/PPTX/PPTM files. All other 
types should be opened using the notepad, described in the next chapter. 

You can launch the "Word Processor" in a couple of ways: 

Press "F1" to open the main "Program" menu. Navigate to "Word Processor" 
using "Space-4" and press "Enter". You can also press W from the main menu 
to quickly jump to and open the "Word Processor. 
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You can launch the "Word Processor" from anywhere on the unit by pressing 
"F1-W". 

When you launch the Word Processor on the Polaris, it places you in a new, 
blank document. You can activate all the functions of the Word Processor via the 
Word Processor menu or by using hot keys. The menu in the Word Processor 
consists of File, Edit, Go To, Read, and Layout. To access these menus, press 
"Space-M" or "F2". Select a menu item using "Space-1" or "Space-4", and press 
"Enter". Or, you can press "Space-M or "F2" followed by the shortcut for the 
corresponding menu item.  

Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate 
menus, settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and 
"Space-F3" to tab among controls in a dialog.  

Press "Enter" to execute an item. 

 

5.1 File Menu 
The File menu contains the following options: 

1) New: (N). Creates a new document, by default named "noname". You can 
create only DOCX files in the Word Processor. Other file types, like TXT, BRL 
and RTF can be created in the Notepad described in the next chapter.  

2) Open: (O) "Enter-O". Opens an existing file. Supported file types include 
DOC, DOCX, PPT, PPTX, PPTM. *Note: all these files can be read, but only 
DOC and DOCX files can be saved. Password protected word files, such as 
those used in health professions, can also be read, but cannot be created or 
saved. 
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3) Recent File list: (R “Backspace-Enter-H”. Displays files you’ve recently opened 
in the Word Processor. Press Enter on a file to open it. 

4) Opened Documents List: (D) “Backspace-Enter-O”. Displays all the currently 
open documents. Allows you to choose from a list rather than Tabbing and Shift-
Tabbing through all of them. 

5) Save: (S) "Enter-S". Save the current file. Tab between name and location. 
Use normal file management navigation to choose a different folder.  

6) Save As: (A) "Space-S". Save the current file under a different name or in a 
different location. Note: you can save both DOC and DOCX files once they are 
opened, but you cannot convert one to the other. 

7) Export: (X) “Backspace-Enter-X”. This function exports the current document 
to BRL, useful for translating a DOC or DOCX file, especially useful for saving 
math files to braille so that they can be embossed via the Notepad. 

8) Close Current document: (Q) “Space-Q”. Appears only if more than one 
document is currently open, and closes only the current file 

9) Print: (P) "Space-P". the document will be printed using the default print 
service set in the Android System Settings. 

10) Settings: (E) "Enter-E". Dialog to set various document options. Tab among 
settings list, location Info check boxes, Default folder, and Confirm and Cancel 
buttons. Settings list includes View Format Characters, Reading unit (affects 
functions of “Space-1” and “Space-4” and “Space-2-3” and “Space-5-6”),  Read 
Only On/Off, Automatic Save Interval, Auto Scroll Speed, Apply Settings to All 
Documents, Home/End movement unit, Math Braille Code, and new Document 
default name. Use “Space-1” and “Space-4” to move among the settings in the 
Settings list, and Space or Backspace to change the value of the setting. 
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11) File Open Setting: (T) “Backspace-Enter-O”. Determines how a document is 
loaded: Choose “Load completely” to open the document in whole before 
reading, choose “Load in Background” to start reading after the first page is 
loaded, and continue loading in the background. 

12) Dictionary: (D) "Backspace-Enter-D". Opens the Sense Dictionary installed, 
and inserts the word under the cursor in the lookup edit box.  

13) Exit: (Z) "Space-Z". Closes the Word Processor. 

 

5.2 Edit Menu 
The Edit Menu contains the following items: 

1) Start Selection: (B) "Enter-B". Marks the beginning of the selection. The end 
of the selection is marked by the current cursor position.  

2) Copy: (C) "Enter-C". Copies selected text to the clipboard. 

3) Cut: (X) "Enter-X". Cuts the selected text to the clipboard. 

4) Paste: (V) "Enter-V". Pastes text from the clipboard to the current location. 

5) Delete: (D) "Space-D". Deletes selected text. 

6) Delete Blank lines: (L) "Backspace-E". Deletes blank lines from the selected 
text area. 

7) Add to clipboard: (P) "Enter-P". Appends selected text to the clipboard without 
deleting the prior selection. 

8) Clear clipboard: (E) "Enter-D". Empties the clipboard. 

9) Select All: (A) "Enter-A". Selects all the text in the document.  
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10) Check spelling: (K) "Enter-K". Opens the Check Spelling dialog, and begins 
checking the document for errors. Use “F3” and “Space-F3” to move among the 
controls, and “Space-1” and “Space-4” to move through lists of options. You can 
also use the following hot keys: 

 A. Skip Once: Backspace-S. 

 B. Skip All: Backspace-I. 

 C. Modify Current: Backspace-C. 

 D. Modify All: Backspace-M. 

 E. Add to User Dictionary: Backspace-A. 

You can also check spelling of the current word with “Backspace-K”. 

 

5.3 Insert Menu 
1) Set Mark: (M) "Enter-M". Sets a bookmark at the current cursor position. 

2) Jump to Mark: (J) "Enter-J". Jumps to a previously set mark. 

3) Delete Mark: (D) "Backspace-D". Deletes a previously set mark. 

4) Insert from File: (I) "Enter-I". Inserts information from another file. 

5) Insert Date: (W) "Enter-W". Inserts the current date. 

6) Insert time: (T) "Backspace-W". Inserts the current time. 

7) Insert Tab: Backspace-Space-Enter-I. 

8) Insert Page Break: Backspace-Space-Enter-P. 
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5.4 Go to Menu 
1) Find: (F) "Space-F". Opens Find dialog where you can enter a text string to 
search, choose whether to match case, and choose the search direction.  

2) Find Next: (H) "Enter-F". Finds the next instance of the previously searched 
string. 

3) Find Previous: (V) "Backspace-F". Finds the previous instance of the search 
string from your current position. 

4) Find and Replace: (R) "Enter-R". Dialog to search for a text string and replace 
with an alternative string. Choose search direction, match case, and whether to 
replace one instance or all. 

5) Go To Location: (L) "Enter-L". Go to a location in the document according to 
page, paragraph, line or percentage. 

6) Go To Previous Sentence: (E) "Space-2-3-6". Moves back one sentence. 

7) Go To Next Sentence: (X) "Space-3-5-6". Moves forward one sentence. 

8) Go To Previous Page: (B) "Space-1-2-6). Moves back one page. 

9) Go To Next Page: (G) "Space-3-4-5". Moves forward one page. 

10) Go To Previous Document: (P) "Shift-Tab". If multiple documents are open, 
moves to the previous document in the order the files were opened. 

11) Go To Next Document: (N) "Tab". If multiple documents are opened, moves 
to the next document in the file open order.  

 

5.5 Read Menu 
1) Read Selected Text: (B) "Backspace-B". Reads the selected block of text. 
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2) Read beginning of Selected Text: (U) "Enter-U". Reads the first line of a 
selected text block. 

3) Read from Beginning to Cursor: (T) "Backspace-G". Reads from the 
beginning of the document to the current cursor position. 

4) Read from Cursor to End: (Q) "Enter-G". Reads from the current cursor 
position to the end of the document. 

5) Auto Scroll: (A) "Up/Down Scroll". Starts and stops the auto scroll function. 
Set the speed of the auto scroll in the Settings under the File menu.  

6) Read Current Sentence (E) "Space-1-4-5-6". Reads the current sentence. 

7) Read Current Line: (L) "Space-1-4". Reads the current line. 

8) Read Current Word: (W) "Space-2-5". Reads the current word. Press twice to 
spell. 

9) Read Current Character: (C) "Space-3-6". Reads the current character. Press 
twice to hear the military alphabet equivalent. 

10) Read Cursor Position: (R) "Space-1-5-6". Reads current cursor position as 
page, paragraph, word, and line. 

11) Read Status: (S) "Space-3-4". Reads title of document and indicates Insert 
or Overwrite mode. 

12) Read Character Count: (I) "Backspace-I". Reads the current and total 
character count of the current document. 

13) Read Font info: (F) “Backspace-Enter-N”. provides font, style, and formatting 
information for the text at your current position. 
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5.6 Layout Menu 
1) Font: (F) "Enter-backspace-F". Opens the font settings dialog. Acts on 
selected text. Change the default font by adjusting the setting values and 
choosing the “Set Current as default” button 

2) Style: (S) “Backspace-Enter-S”. Acts on current paragraph or selected text. Use 
“Space-1” and “Space-4” to change the setting values. 

3) Print Document Layout: (T) "Backspace-T". Determines the format of the 
pages of a printed document. 

4) Print Paragraph Layout: (C) "Backspace-2-3-4-6". Determines the print format 
and style of the current paragraph.  

*Note: if you find documents use incorrect word wrapping when transferred to 
computers or other devices, please Select All text with Enter-A, then turn Word 
Wrap off in the Print Paragraph Layout. 

 

5.7 Miscellaneous Functions 
The following commands can also be used in the Word Processor: 

1) Center current line: Backspace-Space-Enter-C. 

2) Left Justify: Backspace-Space-Enter-J. 

3) Right justify: Backspace-Space-Enter-R. 

4) Bold on/off: Control-B. 

5) italics On/off: Control-I. 

6) Underline On/Off: Control-U. 

7) Start/End Math Mode: Backspace-M. 
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8) Insert math symbol: Press Space-H in Math Mode, and press Enter on the 
symbol in the list. 

9) Next slide in PowerPoint file: Space. 

10) Previous Slide in PowerPoint file: Backspace. 

11) Go to slide in Power Point File: Enter-L. 

12) Move back by double carriage return: Backspace-Space-2-3. 

13) Move forward by double carriage return: Space-Enter-5-6. 

14) Move forward by heading: space-dots-2-5-6. 

15) Move back by heading: Space-dots-2-3-5. 

 

 

6. Notepad 
The Polaris Notepad supports reading and creation of RTF, TXT, HBL, BRL and 
BRF files as well as unformatted DOCX files, and will open PDF, EPUB, DOCX 
and DOC files. To read PowerPoint files, or to create and/or preserve formatting 
in Word documents, or to create mathematical expressions, please use the 
Word Processor described in the previous chapter.  

*Note: though you can open Word documents in the notepad, all document 
formatting will be stripped. Response time for navigation and searching will be 
reduced in the Notepad, but if a Word document is saved from within it, all 
formatting will be lost. 

You can launch the "Notepad" in a couple of ways: 
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Press "F1" to open the main "Program" menu. Navigate to "notepad" using 
"Space-4" and press "Enter". You can also press N from the main menu to 
quickly jump to and open the "notepad”. 

You can launch the "Notepad" from anywhere on the unit by pressing "F1-N". 

When you launch the Notepad on the Polaris, it places you in a new, blank 
document. You can activate all the functions of the Notepad via the Notepad 
menu or by using hot keys. The menu in the Notepad consists of File, Edit, 
insert, Go To, Read, and Layout. To access these menus, press "Space-M" or 
"F2". Select a menu item using "Space-1" or "Space-4", and press "Enter". Or, 
you can press "Space-M or "F2" followed by the shortcut for the corresponding 
menu item.  

Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate 
menus, settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and 
"Space-F3" to tab among controls in a dialog.  

Press "Enter" to execute an item. 

 

6.1 File Menu 
The File menu contains the following options: 

1) New: (N). Creates a new document, by default named "noname". You can 
create a DOCX or DOC file without formatting, or a TXT, BRL or HBL file. 

2) Open: (O) "Enter-O". Opens an existing file. Supported file types include all 
those listed at the beginning of this chapter. 

3) Recent File list: (R “Backspace-Enter-H”. Displays files you’ve recently opened 
in the Notepad. 
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4) Opened Documents List: (D) “Backspace-Enter-O”. Displays all the currently 
opened documents in a list, so that you do not have to Tab and Shift-Tab through 
all of them. 

5) Save: (S) "Enter-S". Save the current file. Tab between name, location and 
file type. Use normal file management navigation to choose a different folder.  

6) Save As: (A) "Space-S". Save the current file under a different name, as a 
type or in a different location. You can choose to password protect files by 
choosing the HPF file format. 

7) Print: (P) "Space-P". Supports only Braille embossing: the document will be 
printed using a connected embosser. 

8) Settings: (E) "Enter-E". Dialog to set various document options. Tab among 
settings list, location Info check boxes, Default folder, Set Password, and 
Confirm and Cancel buttons. Settings list includes View Format Characters, 
Reading unit for Space-1 and Space-4, Read Only On/Off, Automatic Save 
Interval, Auto Scroll Speed, Apply Settings to All Documents, Home/End 
movement unit, and new Document default name. Use “Space-1” and “Space-4” 
to move among the settings in the Settings list, and Space or Backspace to 
change the value of the setting. 

9) Dictionary: (D) "Backspace-Enter-D". Opens the Sense Dictionary installed, 
and inserts the word under the cursor in the lookup edit box.  

10) Exit: (Z) "Space-Z". Closes the Notepad. 

* The Polaris allows you to encrypt and password protect files which you do not 
wish for anyone else to be able to open. Before you save a document as a 
protected file, you must set a password in the "Settings" option under the "File" 
menu. The "Set Password" dialog consists of 5 items: "Delete the original file" 
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checkbox, ?, a "Password?" edit box, a "Retype Password" edit box, a "confirm" 
button, and a "cancel" button. Once the password is set, use the save as dialog, 
and choose HPF as your file type.  

 

 

6.2 Edit Menu 
The Edit Menu contains the following items: 

1) Start Selection: (B) "Enter-B". Marks the beginning of the selection. The end 
of the selection is marked by the current cursor position.  

2) Copy: (C) "Enter-C". Copies selected text to the clipboard. 

3) Cut: (X) "Enter-X". Cuts the selected text to the clipboard. 

4) Paste: (V) "Enter-V". Pastes text from the clipboard to the current location. 

5) Delete: (D) "Space-D". Deletes selected text. 

6) Delete Blank lines: (L) "Backspace-E". Deletes blank lines from the selected 
text area. 

7) Add to clipboard: (P) "Enter-P". Appends selected text to the clipboard without 
deleting the prior selection. 

8) Clear clipboard: (E) "Enter-D". Empties the clipboard. 

9) Select All: (A) "Enter-A". Selects all the text in the document.  

10) Toggle Insert/overwrite Mode: (I) “Space-I”. determines whether, when you 
type text, if it is inserted at the current position, or overwrites the current text. 

11) Check spelling: (K) "Enter-K". Opens the Check Spelling dialog, and begins 
checking the document for errors. Use “F3” and “Space-F3” to move among the 
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controls, and “Space-1” and “Space-4” to move through lists of options. You can 
also use the following hot keys: 

 A. Skip Once: Backspace-S. 

 B. Skip All: Backspace-I. 

 C. Modify Current: Backspace-C. 

 D. Modify All: Backspace-M. 

 E. Add to User Dictionary: Backspace-A. 

You can also spellcheck the current word with “Backspace-K”. 

 

6.3 Insert Menu 
1) Set Mark: (M) "Enter-M". Sets a bookmark at the current cursor position. 

2) Jump to Mark: (J) "Enter-J". Jumps to a previously set mark. 

3) Delete Mark: (D) "Backspace-D". Deletes a previously set mark. 

4) Insert from File: (I) "Enter-I". Inserts information from another file. 

5) Insert Date: (W) "Enter-W". Inserts the current date. 

6) Insert time: (T) "Backspace-W". Inserts the current time. 

 

6.4 Go to Menu 
1) Find: (F) "Space-F". Opens Find dialog where you can enter a text string to 
search, choose whether to match case, and choose the search direction.  

2) Find Next: (H) "Enter-F". Finds the next instance of the previously searched 
string. 
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3) Find Previous: (V) "Backspace-F". Finds the previous instance of the search 
string from your current position. 

4) Find and Replace: (R) "Enter-R". Dialog to search for a text string and replace 
with an alternative string. Choose search direction, match case, and whether to 
replace one instance, from cursor to end, or all. 

5) Go To Location: (L) "Enter-L". Go to a location in the document according to 
page, paragraph, line or percentage. 

6) Go To Previous Sentence: (E) "Space-2-3-6". Moves back one sentence. 

7) Go To Next Sentence: (X) "Space-3-5-6". Moves forward one sentence. 

8) Go To Previous Page: (B) "Space-1-2-6). Moves back one page. 

9) Go To Next Page: (G) "Space-3-4-5". Moves forward one page. 

10) Go To Previous Document: (P) "Shift-Tab". If multiple documents are open, 
moves to the previous document in the order the files were opened. 

11) Go To Next Document: (N) "Tab". If multiple documents are opened, moves 
to the next document in the file open order.  

 

6.5 Read Menu 
1) Read Selected Text: (B) "Backspace-B". Reads the selected block of text. 

2) Read beginning of Selected Text: (U) "Enter-U". Reads the first line of a 
selected text block. 

3) Read from Beginning to Cursor: (T) "Backspace-G". Reads from the 
beginning of the document to the current cursor position. 
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4) Read from Cursor to End: (Q) "Enter-G". Reads from the current cursor 
position to the end of the document. 

5) Auto Scroll: (A) "Up/Down Scroll". Starts and stops the auto scroll function. 
Set the speed of the auto scroll in the Settings under the File menu.  

6) Read Current Sentence (E) "Space-1-4-5-6". Reads the current sentence. 

7) Read Current Line: (L) "Space-1-4". Reads the current line. 

8) Read Current Word: (W) "Space-2-5". Reads the current word. Press twice to 
spell. 

9) Read Current Character: (C) "Space-3-6". Reads the current character. Press 
twice to hear the military alphabet equivalent. 

10) Read Cursor Position: (R) "Space-1-5-6". Reads current cursor position as 
page, paragraph, word, and line. 

11) Read Status: (S) "Space-3-4". Reads title of document and indicates Insert 
or Overwrite mode. 

12) Read Character Count: (I) "Backspace-I". Reads the current and total 
character count of the current document. 

 

6.6 Layout Menu 
1) Braille Paragraph Layout: (B) "Backspace-1-2-4-6". Determines the Braille 
format of the current paragraph. 

2) Braille Document Layout: (P) "Backspace-P". Determines Braille document 
format for embossing. 
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7. New E-mail 
To use the e-mail program, you must have an e-mail account, provided to you by 
your Internet service provider or sign up for a free account such as Gmail or 
Hotmail. Your e-mail account needs to support POP3 (Post Office Protocol 3), 
IMAP (Internet Message Access Protocol) and SMTP (Simple Mail Transfer 
Protocol), or a Microsoft Exchange server to be accessed with the BrailleSense.  

Before you use the e-mail program, you must also configure the BrailleSense to 
access the Internet, (see section 3.2 "Internet Setup"). 

 Note: The menus in the BrailleSense's e-mail program are specific to the 
task you are performing: for example, when checking the "Inbox" in the e-
mail program, the menu items are different from the available items when 
you are writing an e-mail or viewing mailboxes. Generally, the available e-
mail program menus are "File", "Edit", "Tools" and "Message". 

To access these menus, press "Space-M" or "F2". Select a menu item, and press 
"Enter". Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate 
menus, settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-
F3" to tab among controls in a dialog.  

 

7.1 Executing E-mail 
To use the e-mail program, you must configure the BrailleSense to access each 
of your e-mail accounts by entering your e-mail account information.  

To execute the e-mail program, navigate to "E-mail" in the "program" menu, by 
pressing "Space-1" and "Space-4" and press "Enter", or just press E from the 
main program menu. You can launch the "E-mail program from anywhere on the 
unit by pressing "F1-E".  
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When you launch the e-mail program for the first time, the BrailleSense says, "You 
must create at least 1 mail account from the accounts manager in the Tools menu". 
Then, the "Inbox" is opened.  

The "Inbox" is the main window of the E-mail program. When you run the e-mail 
program for the first time, this "Inbox" is empty and the BrailleSense displays "no 
items". 

If there are e-mail messages in the "Inbox", "Opening inbox." is announced; and 
"xx% processed" is displayed on the Braille display. Once progress has reached 
100%, the "Inbox" is opened and displays the received e-mail in the message list.  

Press "Shift-Tab (Space-1-2)", and you are placed in the mailbox list. By default, 
the BrailleSense contains the following mailboxes:  

1) Inbox: received mail that has not been deleted or saved to a different folder. 

2) Sent: sent messages you have chosen to store  

3) Outbox: messages waiting to be sent, either when you save mail in "Outbox" 
or sending mail fails. 

 

7.2 Setting Up an Account 
To access the "Accounts Manager", Open the menu with "F2", navigate to "Tools" 
and press "Enter". "Accounts Manager" is the first item in the "Tools" menu, thus, 
you can just press "Enter" again to open it. You can also launch the "Accounts 
Manager" from anywhere in e-mail by pressing "Enter-M". 

"Account name: no items" is displayed.  
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The "Accounts manager" dialog contains the following 6 items: "Accounts" list, 
"Information" button, "Add" button, "Modify" button, "Delete" button and "Close" 
button. 

 

To add an e-mail account, follow these steps: 

1) From the "Accounts Manager", press "F3", to move to "Add" and press "Enter". 

2) The dialog is opened and “default Mail Server” is displayed. Press “Space” to 
choose among POP3, IMAP, or exchange. The remaining items in the dialog will 
somewhat vary depending on your choice. 

3) If you choose POP3 or IMAP, "Server Type" is displayed. This is a combo box 
in which you can choose to manually setup your account, or ask BrailleSense to 
auto fill in server information from known server types like Gmail and iCloud. Use 
"Space-1" and Space-4" to navigate the Server types. If your server is not in the 
list, select "Manual". Press F3 to move to the next control. 

4) "Account name:" is displayed. Type the name by which you want to identify the 
e-mail account: (example, "Gmail" or "work e-mail"). 

5) Press "F3", to move to "Display name". Type the "Display name" in the edit box. 
This name is the name people will see when they receive an e-mail from you. 

6) Press "F3", to move to "Logon username". Type the "Logon username" in the 
edit box (using computer Braille if writing in US Braille). (Ex: Sense or 
sense@himsintl.com). 

  Note: some providers require you to use the entire e-mail address as the 
username, while others may use the part of the address before the at-sign. 
BE sure you type the username correctly for your e-mail provider. 
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 *** If you’ve chosen IMAP as your default mail server, and Google as your 
server type, your next control is a “Sign In with Google” button, which will 
take you to a Google sign in page, where you will enter your password and 
accept any permissions Google requests. For all other types, continue with 
the steps below. 

7) Press "F3", to move to "Password". Type the "password" in the edit box 
( computer Braille if using US Braille).  

 Note: By default, the password is hidden, and thus displays as asterisks. 
Be sure to type carefully as you cannot review your password unless you 
choose not to hide passwords in the "Global Options".  

8) Press "F3", to move to "E-mail address". Type your "E-mail address" in the edit 
box (again, use computer Braille if entering US Braille). (Ex: sense@himsintl.com) 

9) Press "F3", to move to "Incoming Server?". If you have selected "IMAP" as 
your incoming server type, "Incoming IMAP server?" is displayed. If you have 
chosen "POP3" as your incoming server type, "Incoming POP3 server" is 
displayed. Type the "Incoming server" in the edit box (in computer Braille for US 
Braille). (Ex: imap.himsintl.com, or pop.himsintl.com). Check with your account 
provider for your specific incoming server name.  

10) Press "F3", to move to "Outgoing SMTP server". Type the "Outgoing SMTP 
server" in the edit box (computer Braille if using US Braille). Check with your 
account provider for the exact name of your outgoing SMTP server.  

11) Note that if you have chosen Exchange as your account type, the process is 
the same, but the dialog has only “Account Name”, “Exchange Server URL”, 
“Logon Username”, and “Password”, as this is all the information required for 
Exchange accounts. 
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12) When you have filled in all the information, "Tab to the "Confirm" button and 
press "Enter". 

13) The BrailleSense checks the information and tries to connect to your account. 
If it cannot do so, you are given an error, and asked to modify the information. 

14) If connection is successful, it exits to the "Account name list" and shows the 
added account name (Ex: Account name: BrailleSense 1/1). 

15) When you finish adding accounts, press "Space-Z" to return to the "Inbox". 

 Note: Many e-mail service providers use secure servers with different port 
numbers. If your service provider requires you to use encryption, you must 
set these options in the "Advanced" dialog explained below: 

 Note: If you are not using UEB, several of the fields for setting up an e-mail 
account require you to use computer Braille. To type your ID, Password, 
and address,  

 

While adding your account, you can create a signature and set advanced options 
in the "Advanced" dialog.  

1) Open the "Accounts Manager" as described previously.  

2) If you're creating a new account, "Tab to the "Add" button and Press "Enter". If 
you need to add advanced settings to an account you've already created, Tab to 
the "Modify" button and press "Enter". 

3) When you have filled in everything in the main account settings list, press "F3" 
to move to "Advanced" and press "Enter". 

4) if you are setting up an Exchange account, this dialog will contain only the 
signature options. If using IMAP or POP3, everything below is displayed. 



 
 

 109  

  

 

5) First, BrailleSense displays "Use secure POP3 (or IMAP) (POP-SSL)". The 
default value of this check box is unselected. If the POP3 or IMAP server uses 
"SSL", select the check box by pressing "Space". 

6) Press "F3" to move to "POP3 (or IMAP) port number": POP3 is set to 110 by 
default, and IMAP is set to 143 by default. Type a different POP3 or IMAP port 
number in the edit box if your provider requires a different port number.  

 Note: if you check "SSL" above, the pop port number is automatically 
changed to 995 and the IMAP port to 993, as most servers with SSL require.  

7) Press "F3" to move to "SMTP encryption type". The setting values are "None", 
"SSL" and "TLS". If your Outgoing SMTP server uses "SSL" or "TLS", change the 
value by pressing "Space". 

8) Press "F3" to move to "SMTP port number": set to 25 by default. If you have 
chosen "SSL" as the encryption type, the default port number is set to 465 as is 
most commonly used for SMTP servers using SSL. If you have chosen TLS, the 
default SMTP port number is set to 587. Type a different value in the edit box if 
your provider uses a different SMTP port number.  

9) Press "F3" to move to "SMTP username". If your Internet account provider 
requires you to use a different SMTP username, enter it in this edit box. 

10) Press "F3" to move to "SMTP password". Type the password that corresponds 
to the above ID (using computer Braille if entering US Braille). If your SMTP 
username and password are not different, leave these items blank.  

11) Press "F3" to move to "Use as default send-from account" To use the 
username and password that were set in steps 7 and 8, select the check box by 
pressing "Space". 
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12) Press "F3", move to "Use signature". The default value is "No". To attach a 
signature to your mail, press "Space" to change "No" to "Yes". 

13) If you chose yes, press "F3", to move to "Signature" and press "Enter".  

14) You are placed in the "Signature:" multi edit box. Type the information for the 
signature you want to attach to your e-mails.  

15) Tab to "Confirm" and press "Enter".  

16) Tab to the "Confirm" button and press "Enter" to save the settings in the 
"Advanced" dialog. 

17) Tab to the "Confirm" button one more time to save the settings in the main 
"Account information" dialog. 

 

7.3 Managing Accounts 
To view the information about a stored e-mail account, open the "Accounts 
Manager" as described previously. Navigate to the account for which you want 
information and press "Enter" or Tab to "Information" and press "Enter". 

In this dialog you can read all information associated with an e-mail account. Use 
"Space-1" and "Space-4" to navigate the list of settings for the account. Press 
"Space-E" to return to the accounts list.  

To modify the information for an e-mail account, open the "Accounts Manager" 
and navigate to the desired account in the list. When the desired account is 
displayed, press "F3" to move to the "Modify" button, and press "Enter". Or, press 
Enter-M to activate the "Modify" button.  

You are placed in the "Account name" edit box. You can now make changes to 
the information presented. The "Modify" dialog is exactly like the "Account setup" 
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dialog, except that all the information is already filled in. Use normal editing and 
navigation commands to navigate to the information and make your desired 
changes.  

When you have finished making modifications, press "F3" to move to "Confirm" 
and press "Enter".  

 

Use the following steps to delete an E-mail account. 

1) Open the Accounts Manager in the manner previously described. 

2) Press "Space-4" or "Space-1" to move to the desired account in the account 
list. 

3) When the desired account is displayed, press "Space-D" Or, press "F3" to 
move to the "Delete" button, and press "Enter". 

4) BrailleSense prompts, "Are you sure you want to delete the (added account 
name) account? Yes".  

5) Press "enter" To delete it. Press "Space-Z" to cancel the deletion. 

 

7.4 Receiving E-mail 
To check for new mail, press "Enter-N". You can also choose "Check for New Mail" 
from the "Message" menu. For POP3 accounts, the BrailleSense displays "There 
are xx messages to receive. Now receiving." "x/y mail received;" "Successfully 
received x out of y message" is displayed. When the e-mail messages are 
downloaded from the server, the e-mail message list is displayed in the "Inbox".  

To cancel the download, press "F3" to move to the "Cancel" button, and press 
"enter", or press "Space-E".  
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When receiving messages via an IMAP or exchange server, you can both check 
the newest mail, according to the number of messages you have it set to 
automatically receive in the "Set options" dialog, or you can ask the BrailleSense 
to load older e-mail messages. To receive the newest e-mail messages, press 
"Enter-N" from the message list of the mailbox on which you are located. To 
receive previous mail, press "Backspace-P". You can also access "Get new mail" 
and "Get Previous mail" from the "Message" menu.  

In addition, when using IMAP or Exchange, as you navigate the various mail 
boxes in an account, new mail is automatically received for each mail box as you 
open it.  

 

7.5 Reading Messages 
E-mail messages are displayed in the Inbox and other mailboxes with the 
following information: "Subject", "Date", "From" (Sender), "CC", "Message" (main 
body of the e-mail) and "Attach" (displayed only for an e-mail with one or more 
attached files) you can move among the items by pressing "F3" or "Space-F3". 

If there is a file attached to the e-mail, an A is shown before the subject, and the 
number of attachments is announced as you navigate the message list. The 
BrailleSense also indicates which e-mail messages have been read, and which 
e-mail messages are unread. E-mail messages that have not yet been read have 
a dash placed in front of the subject.  

"Date" shows the date and time when the e-mail was received in the following 
order: day, month, date, and year. The time is displayed in the following order: 
hour, minute, and second using 24 hour time format.  
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"From" shows the sender information; "From: (sender's e-mail address) you can 
save the e-mail id of the sender to your contacts in the "Address Manager" using 
the following steps: 

1) Press "Enter-I" when the sender is displayed. 

2) The "add address" dialog is opened, and "Name: (sender's user name or e-
mail address)" is displayed. 

3) Type the sender's first and last name, or, if what is automatically filled in is 
acceptable, press "F3" to move to "confirm", and press "enter". The contact is 
saved, and you are returned to your previous position in the message list. If the 
contact already exists, you will be prompted, and given the option to modify the 
contact. 

You can also save the e-mail id of the carbon copy recipient (CC) to the Address 
Manager using the process described above. 

*Note: You can choose the content that is displayed in the Message List as well 
as the order in which it appears in the options menu described later in this chapter. 

 

You can move to the body of a message by pressing "F3". Or, you can press 
"enter" when "Subject", "Date", or "From" is displayed. When you press "enter", 
the entire message is automatically spoken. To interrupt reading, press 
"Backspace-enter". Navigate the message as you would a document in the "Word 
Processor". To return to the "Subject", press "Space-E".  

 Note: Messages in the BrailleSense are opened as plain text. If you receive 
an html e-mail, you can access the links and other HTML content by 
viewing the message in the BrailleSense's Web Browser. Open the 
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message with the Web browser by pressing "Backspace-O", or by selecting 
"Open Message in Web Browser" from the "Message" menu.  

You can find and download attached files by tabbing to "Attach" on messages 
containing attachments.  

To save an attachment, move to the desired file name in the attachments list and 
press "Enter". You are prompted, "Attachments will be saved to 
/flashdisk/download. Do you want to change this location? No". Press "enter". The 
selected file is saved in the "download" folder on the "flashdisk". If you have more 
than one attachment you want to download, you can press "Enter-A" to select all 
attachments in the list, or press space on any number of individual files to select 
them.  

To save attachments directly from the Message List, without opening a message, 
press “Backspace-F” when the message is focused. 

To change the download path: When you are prompted, "Attachments will be 
saved to /flashdisk/download. Do you want to change this location?", navigate to 
"Yes" and press "Enter". You are placed in the file list of the "Downloads" folder 
on the "flashdisk". Use normal file and folder navigation to locate the folder into 
which you want to save the attachments. Press "Space" to select the folder in 
which to save the attachments, and press "Enter". * Note: when using IMAP, the 
message must be opened before you can navigate to the attachments.  

You can delete e-mail messages individually, or you can select multiple messages 
and delete them simultaneously. Press "Space-D" to delete the current message, 
or select multiple messages with "Space", then press "Space-D" to delete all of 
them.  

When you delete messages, they are automatically moved to the "Trash" folder, 
where they remain until you delete them from there, or until you empty the "Trash" 
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folder. You can empty the "Trash" folder at any time by pressing "Enter-
Backspace-Q" or choosing 'Empty Trash' from the "Edit" menu.  

 Note: When messages are deleted from the "Trash" folder, they are 
permanently disposed of, and cannot be retrieved. 

 

7.6 Writing E-mail 
To write a new message, choose "Write New Message" from the "File" menu, or 
press "Enter-W" from the message list. "To:" is displayed on the Braille display. If 
you wish to use a different account from the default, Shift-Tab to the "Account" 
combo box, choose your desired account, and Tab back to the "To" field.  

Type the e-mail address of the recipient, or rather, the person to whom you are 
sending the message. If using US Braille, you must use computer Braille. To send 
to multiple recipients, place a semicolon between the e-mail addresses. 

You can also add recipients from the address list by selecting "Look up Address" 
from the "File" menu or pressing "Enter-L". Type the First name, last name or part 
of the e-mail address of the desired recipient, and press "enter".  

Addresses matching your search are displayed. If you press "enter" without typing 
in the desired name, all of the addresses in your address list are displayed. If 
there is no matching address, "No match" is announced. Move to the desired 
address, and press "enter". You can select more than one address by pressing 
"Space", then enter to input all of them.  

You can also type any of the information above directly into the To or CC fields, 
and the first match will automatically be filled in when you Tab to the next field. 
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When you are finished entering recipients in the "To" field, press "F3" to move to 
"CC:" and "BCC", and input any copy or blind copy recipients as described above. 
If you do not need to carbon copy anyone, you can skip to the next step. 

Press "F3" to move to "Subject", and type the subject of the e-mail message. 
Finally, press "F3" to move to "Message body:", and type the text of your e-mail 
message. Use the same input and editing methods as are used in the Word 
Processor.  

When you have finished writing your e-mail message, select "Send" from the 
"File" menu, or press "Enter-S" directly from your message. When the e-mail is 
finished sending, "Successfully sent new message" is displayed. If sending fails, 
the BrailleSense displays "Unable to send message", often with a specific error 
explaining the reason for the inability to send the message. If this occurs, the e-
mail is saved in the "Outbox". 

To cancel e-mail message creation or sending, press "Space-E" or "Space-Z" and 
you are returned to the "Inbox". 

 

7.6.1 ATTACHING A FILE 
To attach a file to a message, select "Attach File" from the "File" menu, or press 
"Enter-F" while writing an e-mail message. Use normal file and folder navigation 
keys to locate the file or files you want to attach.  

Press "enter" on the desired file to attach it. To attach more than one file, press 
"Space" to select each file you want to attach. * is displayed in front of the selected 
file names. Press "enter" To attach the selected files. Now, the "Attach" item is 
displayed in the tab order after the "Message body".  
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7.6.2 SAVING E-MAIL TO THE OUTBOX 
Messages are saved in the "Outbox" under 2 conditions: 

1. The user manually saves the e-mail to the "Outbox" for later sending. 

2. An e-mail is automatically saved to the "outbox" after it fails to send due to a 
network error or other reason. 

While writing a message, you can save by selecting "Save Mail in Outbox" from 
the "File" menu, or pressing "Space-S". A default file name is shown titled with the 
subject of the email. Press "Enter" to save the e-mail under the current file name, 
or type a new file name and change the path where the file is stored using the 
same method as in the "Save As" dialog of the Word Processor. 

 Note: If you choose to save the e-mail in a location other than 
"flashdisk/email/outbox", you cannot access the e-mail message in the 
"Outbox". Thus, you cannot send the e-mail unless it is returned to the 
"Outbox" folder. 

While creating a "message", press "Space-E" or "Space-Z" To cancel writing the 
e-mail. The BrailleSense displays "Currently writing mail. Save? Yes". Press Enter 
to save the message in the Outbox. To return to the "Inbox" without saving the e-
mail, press "Space" to change "Yes" to "No", and press "Enter". 

To send a message from the Outbox, "Shift-Tab" to the mailbox list, navigate to 
the Outbox, and Tab to the message list. Press "Space-1" or "Space-4", to move 
to the message you want to send. 

If you want to send all the e-mails in the list: Press "Enter-a (dot 1) to select all. If 
you want to send individual messages, use normal selection commands to select 
them. Press "Enter" on "Send" from the "File" menu, or just press "Enter-S" from 
the outbox, and the messages are sent.  
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7.7 Navigating Accounts and Mailboxes 
There are two ways to move to an account or mail box.  

You can access the accounts list or mailbox list by moving through the tab order 
until you reach "mailboxes" or "Accounts". Use "Space-1" or "Space-4" to move 
among the items in the list, and press "F3" to open the Account or mailbox.  

You can also use the following hot keys to navigate accounts and mailboxes: 

Go to next mailbox: Enter-3-4-5. 

Go to previous mailbox: Enter-1-2-6. 

Next account: Backspace-dots-3-4-5. 

Previous account: Backspace-1-2-6. 

 Note: These hot keys are not available from the account list or mail box list. 
 Also note: When using exchange, if your mailbox contains subfolders, 

press Enter to open these, and backspace to return to the parent folder.  

 

7.7.1 MANAGING MAILBOXES 
You can create additional mailboxes in the "E-mail" folder for sorting and storing 
your messages.  

To create a new mailbox, from the Mailbox list, open the "Edit" menu and select 
"Create New Mailbox", or press "Enter-N" to activate this function directly. Type 
the mailbox name you want to create, and press "Enter".  

The BrailleSense does not allow you to delete the "Inbox", "Sent", or "Outbox". 
However, you can delete folders/mailboxes you have created. 
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To delete a folder/mailbox, navigate to the mailbox you want to delete in the 
Mailbox list, open the "Edit" menu and choose "Delete Mailbox". You can also 
delete the current mailbox in the list by pressing "Space-D".  

You can also rename mailboxes you have created. To do this, from the mailbox 
list, navigate to the mailbox you wish to rename. Open the Edit Menu and select 
"Rename mailbox", or press "Enter-R" to open the "rename mailbox" dialog 
directly. Type the new name for the folder mailbox, and press "Enter".  

 

7.7.2 COPYING AND MOVING TO MAILBOXES 
You can copy and move e-mails using the "Copy to Mailbox" or "Move to Mailbox" 
commands in the "Edit" menu. 

The "move/Copy dialog" contains the following: 

1) "Folder" list. 

2) "Create mailbox" Button 

3) "Delete mailbox" Button 

4) "Rename mailbox" Button 

5) "Confirm" Button 

6) "Cancel" Button 

 

To copy and move an e-mail to another folder, follow these steps: 

1) Select individual e-mails by pressing "Space", select a continuous group with 
"Enter-B" or select all with "Enter-A".  
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2) Open the "Edit" menu, and press "SPACE-4", to move to "Copy to Mailbox" or 
"Move to Mailbox" and press "Enter". You can activate these functions directly 
from the message list by pressing "Backspace-C" for "Copy" and "Backspace-X" 
for "Move to".  

3) BrailleSense displays "Folder list".  

4) Press "Space-4", to move to the folder into which you want to copy or move 
messages and press "Enter0.  

5) The e-mail is moved or copied to the selected folder, and you are returned to 
the mailbox from which you activated the "Move" or "Copy" command. 

 

7.7.3 IMPORTING EMAIL 
You may wish to access e-mail on your BrailleSense from older Braille Sense 
devices or other units that use EML message files. You can do this using the 
Import function in the File Menu, or by pressing “Backspace-I” from the message 
or mailbox list.  

*Note: files and folders selected in this dialog will import to the currently open or 
focused mailbox. So, if you wish to import to a clean folder, you must create a 
folder as described previously, and be located within it or focused on it before you 
start this process. 

When you activate the import function, you are placed in an “Open File” dialog. 
Use normal file and folder navigation to locate the folder where you’re messages 
are stored. Use File management selection commands to select the folders and 
files you want to import, and press Enter. Import progress is shown as a 
percentage. 
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7.8 Advanced Message Features 
 

7.8.1 REPLY AND REPLY ALL 
When you reply to an e-mail, you can edit or add a message to the original 
message, or add another recipient. Choosing "Reply" sends an e-mail to only the 
original sender. Choosing "Reply To All" sends an e-mail back to the original 
sender as well as all other recipients of the original e-mail.  

 1) From "Subject", "Date", or "Message body" of a message in the "Inbox", select 
"Reply" or "Reply All" from the "Message" menu, or press "Enter-R" or 
"Backspace-R" respectively. 

2) You are placed in the message body, which already contains the original 
message body of the received e-mail; below "--- Original Message ---".  

3) You can type additional text, edit the original message, and/or edit any of the 
fields associated with the message including the subject and recipient fields. 

4) When you have finished, press "Enter-S" to send the e-mail. 

You can save replies just as you can save new messages in the "Outbox" for 
sending later. 

 

7.8.2 FORWARDING A MESSAGE 
"Forwarding" refers to sending an e-mail you received to another person.  

1) From the "Subject", "Date", or "Message body", open the "Message" menu and 
select "Forward", or press "Enter-F". 

2) BrailleSense displays "To:". Input the e-mail address of the new recipient, or 
multiple recipients, using computer Braille. 
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3) Press "F3", to move to "CC", "BCC", and "Subject" and edit them as you wish. 
The subject will appear as "FW: (original subject)". 

4) "Tab" to the message body. The original e-mail message is shown following, "-
---- Forwarded Message -----". 

5) Type any additional text you wish to add to the message, or make any edits to 
the forwarded text, and press "Enter-S" to send.  

If you don't want the e-mail to appear in the same message body as the e-mail 
you are writing, you can also forward the current e-mail as an attachment. Use 
"Backspace-W" to send the current e-mail as an attachment, then use the process 
described above. 

 

7.8.3 SAVING AN E-MAIL 
There may be times when you wish to save a received message as a file. Please 
note that there is a small difference between IMAP and POP3.  

1) Using Pop3: when placed on one of the fields of an e-mail message you want 
to save, select "Save as Text" from the "File" menu, or press "Space-S". 

2) BrailleSense displays "File name: (subject of e-mail being read.txt".  

3) Press "Enter" to save the message under the current file name. If you wish, 
you can rename the file using the same method as in the "Save As" dialog of the 
"Word Processor".  

If you are using IMAP or Exchange, you must first navigate to and open the 
message before you can save it. Otherwise the steps are exactly as those above. 
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7.8.4 FINDING MESSAGES 
The "Find" command is used to search for messages in the current mailbox. The 
"Find" function looks for text that matches the text you enter in "Subject", "Date", 
and/or "From". This function only works in the "Subject", "Date", or "From" controls. 
Use "Space-F" to open the "Find" dialog, or open the "Edit" menu and press 
"Enter" on "Find".  

Use "F3" and "Space-F3" to move among the controls. Type the text to search in 
the Edit box. Choose what parts of the message to "Search". Choose the direction 
to search, and press "Enter".  

The "Find Again" command finds the next occurrence of the text according to the 
search text and direction specified in the "Find" dialog. As with "Find", the "Find 
Again" function only works in the "Subject", "Date", or "From" fields. Open the 
"Edit" menu and press "Enter" on "Find Again", or press "Backspace-F" from the 
message list. 

 

7.8.5 MOVE TO NEXT UNREAD MESSAGE 
The "Move To Next Unread Message" command allows you to move to the next 
unread message. If you use this function on the last unread message in a list, you 
are taken to the first unread message in the list.  

To activate this function from the "Subject", "Date", or "From" field, open the "Edit" 
menu and select "Move to next Unread Message" or press "Enter-U" to activate 
this function directly.  
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7.8.6 ACTIVATING LINKS 
Many e-mail messages contain web links, either to general websites, or to 
calendar/online events. 

You can open a link in the BrailleSense Browser by pressing “Enter-L” when your 
cursor is placed on the Web address. 

If you are activating a link to a Zoom meeting, Google Meet invitation, a Teams 
live event, or other item that requires launching of an installed app, you must open 
this link in an Android browser, as the BrailleSense browser does not 
automatically launch other programs.  

To open a link located in the current paragraph in the default Android browser, 
press “Backspace-L”. The browser will launch, which will then, in turn, activate the 
associated Android program, provided that program is installed on your 
BrailleSense. For example, if you want to launch a Zoom meeting, you need to 
install the Zoom application on your BrailleSense installed on Google Play. 

 

7.9 Using the Tools Menu 
In addition to the "Accounts Manager", the "Tools" menu contains options for 
setting the save path, spam filters and other e-mail options.  

 

7.9.1 SET PATH 
"Set Path" sets the default download path where file attachments and e-mail are 
stored. To set the download path, open the "Tools" menu and press "Enter" on 
"Save Path", or press "Enter-T" from the message list. 

The "Set Path" dialog contains three settings: 
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1) Save attachments path 

2) Send attachments path 

3) Disk to save mail in 

 

You can move among these items by pressing "Space-4" and "Space-1". Each 
item consists of "Path", "Modify", and "Close". At "Path", the default path is 
displayed. You can move among this information by pressing "F3" or "Space-F3". 
If you choose to modify any path, use normal file management navigation to locate 
your desired folder, and press "Enter". 

 

7.9.2 SET OPTIONS 
To open the "Set options" dialog, press "Enter" on "Options" from the "Tools" menu, 
or press "Enter-O" to activate this item directly. 

The first item in the "Set options" dialog is "Default server?” You can set the default 
server to any of your established accounts, or to “Off”. If you set the default server 
to off, when the E-mail program is opened, you are placed in your accounts list. 
Setting it to any of your accounts will display the inbox for that account when E-
mail is launched. Use "Space" to change the value of the setting. 

The next item in the Set Options dialog is “Use as default send From Account”. 
Press “Space to choose among the accounts you have set up. 

The next option in the dialog is "Number of Messages to receive.”  This applies to 
the number of messages retrieved with a refresh of an IMAP or Exchange mailbox. 
The default is set to 32. Use "Space" or "Backspace" to cycle through the various 
options. The available values are All, 32, 64, 96, and 128. 
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The next option in the dialog is an option for choosing the "Exchange Message 
List Type". 

This is related to the speed at which e-mail messages are received. If you 
choose to display less header information, e-mail is received faster. The settings 
are "Detailed" and "Simple". 

The "Detailed" setting displays the Attachment count, title, sender name, sender 
email, and the date. The "Simple" view displays the Attachment count, title, 
sender name, and the date. 

This setting also affects the Spam Settings in the "Tools" menu. If you select the 
"Detailed" option, you can add the subject, address or host to the spam filter. If 
you select the "Simple" option, you can add only the subject to the spam filter.  

The next 5  options relate to how information appears in the Message List.  

The “Display Header Labels” option lets you choose whether field titles such as 
“subject”, “Date”, appear when messages are displayed. When this is set to off, 
the specific e-mail addresses of senders and recipients are not displayed, only 
their names. 

For each of the 4 message headers, you can choose to display the sender, (From, 
the recipient (To), subject of the message (Subject), or the date and time the 
message was received (Date). For the 2nd, 3rd and 4th headers, you also have the 
option not to display them at all (Off). This option is not available for the 1st header 
as, if all headers were turned off, the Message list would display no content. This 
allows you to show only the content you want to see in the Message list, as well 
as to determine in what order it appears. 

As you make choices for each header, these disappear from the options for the 
remaining headers. For example, if you choose “Subject” for the 1st header, you 
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will not see this as an option for your 2nd, 3rd and 4th headers. But, if you change 
the first header to “From”, the “Subject” option will re-appear, and the “From” 
option will not appear for the rest of the headers.  

When you have finished adjusting the settings, press "Enter" to save the options, 
or tab to the "Confirm" button and press "Enter". If you do not wish to save your 
changes, tab to the "cancel" button and press "Enter" or press "Space-Z".  

 

7.9.3 SPAM SETTINGS 
When the BrailleSense downloads e-mail from the e-mail server, there may be a 
number of e-mail messages that are spam. In this case, you can avoid 
downloading these spam e-mail messages by identifying specified words in the 
subject or specifying e-mail addresses you know are from spammers. 

The spam e-mail messages that are identified by your "Spam Settings" are not 
downloaded into the BrailleSense, and remain on the e-mail server. 

Use the following steps to set spam e-mail filters: 

1) Open the "Tools" menu and select "Spam Settings", or press "Enter-E" to 
activate this item without accessing the menus. 

2) The "Spam Settings" dialog contains 6 items: "Type" combo box, "List", "Add" 
button, "Modify" button, "Delete" button, and a "Close" button. 

3) "Type" can be set to 1 of 3 options: "Subject", "E-mail address string", and 
"Host". You can move among these options by pressing "Space-1" or "Space-4". 
The "list" is displayed according to the "Type" you choose. 

— If you have selected "Subject", the list is displayed as "Subject: (Registered 
word) 1/xx". If you selected "E-mail address string", it is displayed as "E-mail 
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address string: (Registered e-mail address string) 1/xx". It is displayed as "no 
items" if there is no registered word or e-mail address string. 

 

How to register Spam Settings: 

1) Press A when "Type: Subject 1/3" is displayed. Or, press "F3" to move to the 
"Add" button, and press "enter". 

2) The "add dialog" is opened and "Subject add:" is displayed. 

3) Type the words, by which you want to identify spam messages and press 
"Enter". Or, "Tab" to the "Confirm" button, and press "enter".  

4) "Successfully added spam data". is announced and you are returned to the 
"list". "Subject: (registered word) 1/1" is displayed. 

By adding the word in the manner just described, if there are e-mail messages 
that include the words you entered in the subject of the message, the BrailleSense 
downloads those e-mails from the e-mail server, but deletes them automatically.  

You can also avoid receiving e-mail messages from a specific sender or host by 
registering it in the same manner. 

To cancel setting spam filters from the "Add dialog", press "F3" to move to the 
"Cancel" button, and press "Enter". Or, press "Space-E" or "Space-Z".  

 

To modify a spam filter you have set, do the following: 

1) Access the "Spam Settings" dialog as described previously, and navigate to the 
"Type" of spam setting you want to modify by pressing "Space-1" or "Space-4".  

2) Press "F3" to move to the list of registered items in that category.  
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3) Navigate to the item you want to modify using "Space-1" or "Space-4".  

4) Press M, or press "F3" to move to the "Modify" button, and press "Enter".  

5) Make the modifications in the edit box. 

6) Press "F3" to move to the "confirm" button, and press "Enter" to save the 
changes.  

 

You can also delete an item that has been registered in the spam list.  

1) Access the "Spam Settings" dialog as described previously, and navigate to the 
"Type" of spam setting you want to delete by pressing "Space-1" or "Space-4".  

2) Press "F3" to move to the list of registered items in that category.  

3) Navigate to the item you want to delete using "Space-1" or "Space-4".  

4) Press D or press "F3" to move to the "Delete" button, and press "Enter". 

 

8. E-mail V1 
To use the e-mail program, you must have an e-mail account, provided to you by 
your Internet service provider or sign up for a free account such as Gmail or 
Hotmail. Your e-mail account needs to support POP3 (Post Office Protocol 3) or 
IMAP (Internet Message Access Protocol) and SMTP (Simple Mail Transfer 
Protocol) to be accessed with the Polaris.  

Before you use the e-mail program, you must also configure the Polaris to 
access the Internet, (see section 3.2 "Internet Setup"). 

 Note: The menus in the Polaris's e-mail program are specific to the task 
you are performing: for example, when checking the "Inbox" in the e-mail 
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program, the menu items are different from the available items when you 
are writing an e-mail or viewing mailboxes. Generally, the available e-mail 
program menus are "File", "Edit", "Tools" and "Message". 

To access these menus, press "Space-M" or "F2". Select a menu item, and 
press "Enter". Use "Space-1" and "Space-4" or the Up and Down scroll keys to 
navigate menus, settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" 
and "Space-F3" to tab among controls in a dialog.  

 

8.1 Executing E-mail 
To use the e-mail program, you must configure the Polaris to access each of 
your e-mail accounts by entering your e-mail account information.  

To execute the e-mail program, navigate to "E-mail" in the "program" menu, by 
pressing "Space-1" and "Space-4" and press "Enter", or just press E from the 
main program menu. You can launch the "E-mail program from anywhere on the 
unit by pressing "F1-E".  

When you launch the e-mail program for the first time, the Polaris says, "You 
must create at least 1 mail account from the accounts manager in the Tools 
menu". Then, the "Inbox" is opened.  

The "Inbox" is the main window of the E-mail program. When you run the e-mail 
program for the first time, this "Inbox" is empty and the Polaris displays "no 
items". 

If there are e-mail messages in the "Inbox", "Opening inbox." is announced; and 
"xx% processed" is displayed on the Braille display. Once progress has reached 
100%, the "Inbox" is opened and displays the received e-mail in the message 
list.  
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Press "Shift-Tab (Space-1-2)", and you are placed in the mailbox list. By default, 
the Polaris contains the following mailboxes:  

1) Inbox: received mail that has not been deleted or saved to a different folder. 

2) Sent: sent messages you have chosen to store  

3) Outbox: messages waiting to be sent, either when you save mail in "Outbox" 
or sending mail fails. 

 

8.2 Setting Up an Account 
To access the "Accounts Manager", Open the menu with "F2", navigate to 
"Tools" and press "Enter". "Accounts Manager" is the first item in the "Tools" 
menu, thus, you can just press "Enter" again to open it. You can also launch the 
"Accounts Manager" from anywhere in e-mail by pressing "Enter-M".   

"Account name: no items" is displayed.  

The "Accounts manager" dialog contains the following 6 items: "Accounts" list, 
"Information" button, "Add" button, "Modify" button, "Delete" button and "Close" 
button. 

 

To add an e-mail account, follow these steps: 

1) From the "Accounts Manager", press "F3", to move to "Add" and press 
"Enter". 

2) The dialog is opened and "Server Type" is displayed. This is a combo box in 
which you can choose to manually setup your account, or ask BrailleSense to 
auto fill in server information from known server types like Gmail and iCloud. 
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Use "Space-1" and Space-4" to navigate the Server types. If your server is not 
in the list, select "Manual". Press F3 to move to the incoming server type. 

3) "Default mail server" is displayed. Use Space to choose between POP3 and 
IMAP. Press "F3" to move to the account settings list. 

4) "Account name:" is displayed. Type the name by which you want to identify 
the e-mail account: (example, "Gmail" or "work e-mail"). 

5) Press "Space-4", to move to "Display name". Type the "Display name" in the 
edit box. This name is the name people will see when they receive an e-mail 
from you. 

6) Press "Space-4", to move to "Logon username". Type the "Logon username" 
in the edit box (using computer Braille if writing in US Braille). (Ex: Sense or 
sense@himsintl.com). 

  Note: some providers require you to use the entire e-mail address as the 
username, while others may use the part of the address before the at-
sign. BE sure you type the username correctly for your e-mail provider. 

7) Press "Space-4", to move to "Password". Type the "password" in the edit box 
( computer Braille if using US Braille).  

 Note: By default, the password is hidden, and thus displays as asterisks. 
Be sure to type carefully as you cannot review your password unless you 
choose not to hide passwords in the "Global Options".  

8) Press "Space-4", to move to "E-mail address". Type your "E-mail address" in 
the edit box (again, use computer Braille if entering US Braille). (Ex: 
sense@himsintl.com) 

9) Press "Space-4", to move to "Incoming Server?". If you have selected "IMAP" 
as your incoming server type, "Incoming IMAP server?" is displayed. If you have 
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chosen "POP3" as your incoming server type, "Incoming POP3 server" is 
displayed. Type the "Incoming server" in the edit box (in computer Braille for US 
Braille). (Ex: imap.himsintl.com, or pop.himsintl.com). Check with your account 
provider for your specific incoming server name.  

10) Press "Space-4", to move to "Outgoing SMTP server". Type the "Outgoing 
SMTP server" in the edit box (computer Braille if using US Braille). Check with 
your account provider for the exact name of your outgoing SMTP server.  

11) "Tab to the "Confirm" button and press "Enter". 

12) The Polaris exits to the "Account name list" and shows the added account 
name (Ex: Account name: Polaris 1/1). 

13) When you finish adding accounts, press "Space-Z" to return to the "Inbox". 

 Note: Many e-mail service providers use secure servers with different port 
numbers. If your service provider requires you to use encryption, you 
must set these options in the "Advanced" dialog explained below: 

 Note: If you are not using UEB, several of the fields for setting up an e-
mail account require you to use computer Braille. To type your ID, 
Password, and address,  

 

While adding your account, you can create a signature and set advanced 
options in the "Advanced" dialog.  

1) Open the "Accounts Manager" as described previously.  

2) If you're creating a new account, "Tab to the "Add" button and Press "Enter". 
If you need to add advanced settings to an account you've already created, Tab 
to the "Modify" button and press "Enter". 
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3) When you have filled in everything in the main account settings list, press 
"F3" to move to "Advanced" and press "Enter". 

4) Polaris displays "Use secure POP3 (or IMAP) (POP-SSL)". The default value 
of this check box is unselected. If the POP3 or IMAP server uses "SSL", select 
the check box by pressing "Space". 

5) Press "F3" to move to "POP3 (or IMAP) port number": POP3 is set to 110 by 
default, and IMAP is set to 143 by default. Type a different POP3 or IMAP port 
number in the edit box if your provider requires a different port number.  

 Note: if you check "SSL" above, the pop port number is automatically 
changed to 995 and the IMAP port to 993, as most servers with SSL 
require.  

6) Press "F3" to move to "SMTP encryption type". The setting values are 
"None", "SSL" and "TLS". If your Outgoing SMTP server uses "SSL" or "TLS", 
change the value by pressing "Space". 

7) Press "F3" to move to "SMTP port number": set to 25 by default. If you have 
chosen "SSL" as the encryption type, the default port number is set to 465 as is 
most commonly used for SMTP servers using SSL. If you have chosen TLS, the 
default SMTP port number is set to 587. Type a different value in the edit box if 
your provider uses a different SMTP port number.  

8) Press "F3" to move to "SMTP username". If your Internet account provider 
requires you to use a different SMTP username, enter it in this edit box. 

9) Press "F3" to move to "SMTP password". Type the password that 
corresponds to the above ID (using computer Braille if entering US Braille). If 
your SMTP username and password are not different, leave these items blank.  
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10) Press "F3" to move to "Use as default send-from account" To use the 
username and password that were set in steps 7 and 8, select the check box by 
pressing "Space". 

11) Press "F3", move to "Use signature". The default value is "No". To attach a 
signature to your mail, press "Space" to change "No" to "Yes". 

12) If you chose yes, press "F3", to move to "Signature" and press "Enter".  

13) You are placed in the "Signature:" multi edit box. Type the information for the 
signature you want to attach to your e-mails.  

14) Tab to "Confirm" and press "Enter".  

15) Tab to the "Confirm" button and press "Enter" to save the settings in the 
"Advanced" dialog. 

16) Tab to the "Confirm" button one more time to save the settings in the main 
"Account information" dialog. 

 

8.3 Managing Accounts 
To view the information about a stored e-mail account, open the "Accounts 
Manager" as described previously. Navigate to the account for which you want 
information and press "Enter" or Tab to "Information" and press "Enter". 

In this dialog you can read all information associated with an e-mail account. 
Use "Space-1" and "Space-4" to navigate the list of settings for the account. 
Press "Space-E" to return to the accounts list.  

To modify the information for an e-mail account, open the "Accounts Manager" 
and navigate to the desired account in the list. When the desired account is 
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displayed, press "F3" to move to the "Modify" button, and press "Enter". Or, 
press Enter-M to activate the "Modify" button.  

You are placed in the "Account name" edit box. You can now make changes to 
the information presented. The "Modify" dialog is exactly like the "Account 
setup" dialog, except that all the information is already filled in. Use normal 
editing and navigation commands to navigate to the information and make your 
desired changes.  

When you have finished making modifications, press "F3" to move to "Confirm" 
and press "Enter".  

 

Use the following steps to delete an E-mail account. 

1) Open the Accounts Manager in the manner previously described. 

2) Press "Space-4" or "Space-1" to move to the desired account in the account 
list. 

3) When the desired account is displayed, press "Space-D" Or, press "F3" to 
move to the "Delete" button, and press "Enter". 

4) Polaris prompts, "Are you sure you want to delete the (added account name) 
account? Yes".  

5) Press "enter" To delete it. Press "Space-Z" to cancel the deletion. 

 

8.4 Receiving E-mail 
To check for new mail, press "Enter-N". You can also choose "Check for New 
Mail" from the "Message" menu. For POP3 accounts, the Polaris displays 
"There are xx messages to receive. Now receiving." "x/y mail received;" 
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"Successfully received x out of y message" is displayed. When the e-mail 
messages are downloaded from the server, the e-mail message list is displayed 
in the "Inbox".  

To cancel the download, press "F3" to move to the "Cancel" button, and press 
"enter", or press "Space-E".  

When receiving messages via an IMAP server, you can both check the newest 
mail, according to the number of messages you have it set to automatically 
receive in the "Set options" dialog, or you can ask the Polaris to load older e-
mail messages. To receive the newest e-mail messages, press "Enter-N" from 
the message list of the mailbox on which you are located. To receive previous 
mail, press "Backspace-P". You can also access "Get new mail" and "Get 
Previous mail" from the "Message" menu.  

In addition, when using IMAP, as you navigate the various mail boxes in an 
account, new mail is automatically received for each mail box as you open it.  

 

8.5 Reading Messages 
E-mail messages are displayed in the Inbox and other mailboxes with the 
following information: "Subject", "Date", "From" (Sender), "CC", "Message" 
(main body of the e-mail) and "Attach" (displayed only for an e-mail with one or 
more attached files) you can move among the items by pressing "F3" or "Space-
F3". 

If there is a file attached to the e-mail, an A is shown before the subject, and the 
number of attachments is announced as you navigate the message list. The 
Polaris also indicates which e-mail messages have been read, and which e-mail 
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messages are unread. E-mail messages that have not yet been read have a 
dash placed in front of the subject.  

"Date" shows the date and time when the e-mail was received in the following 
order: day, month, date, and year. The time is displayed in the following order: 
hour, minute, and second using 24 hour time format.  

"From" shows the sender information; "From: (sender's e-mail address) you can 
save the e-mail id of the sender to your contacts in the "Address Manager" using 
the following steps: 

1) Press "Enter-I" when the sender is displayed. 

2) The "add address" dialog is opened, and "Name: (sender's user name or e-
mail address)" is displayed. 

3) Type the sender's first and last name, or, if what is automatically filled in is 
acceptable, press "F3" to move to "confirm", and press "enter". The contact is 
saved, and you are returned to your previous position in the message list. If the 
contact already exists, you will be prompted, and given the option to modify the 
contact. 

You can also save the e-mail id of the carbon copy recipient (CC) to the Address 
Manager using the process described above. 

*Note: You can choose the content that is displayed in the Message List as well 
as the order in which it appears in the options menu described later in this 
chapter. 

 

You can move to the body of a message by pressing "F3". Or, you can press 
"enter" when "Subject", "Date", or "From" is displayed. When you press "enter", 
the entire message is automatically spoken. To interrupt reading, press 
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"Backspace-enter". Navigate the message as you would a document in the 
"Word Processor". To return to the "Subject", press "Space-E".  

 Note: Messages in the Polaris are opened as plain text. If you receive an 
html e-mail, you can access the links and other HTML content by viewing 
the message in the Polaris's Web Browser. Open the message with the 
Web browser by pressing "Backspace-O", or by selecting "Open Message 
in Web Browser" from the "Message" menu.  

You can find and download attached files by tabbing to "Attach" on messages 
containing attachments.  

To save an attachment, move to the desired file name in the attachments list 
and press "Enter". You are prompted, "Attachments will be saved to 
/flashdisk/download. Do you want to change this location? No". Press "enter". 
The selected file is saved in the "download" folder on the "flashdisk". If you have 
more than one attachment you want to download, you can press "Enter-A" to 
select all attachments in the list, or press space on any number of individual files 
to select them.  

To change the download path: When you are prompted, "Attachments will be 
saved to /flashdisk/download. Do you want to change this location?", navigate to 
"Yes" and press "Enter". You are placed in the file list of the "Downloads" folder 
on the "flashdisk". Use normal file and folder navigation to locate the folder into 
which you want to save the attachments. Press "Space" to select the folder in 
which to save the attachments, and press "Enter". * Note: when using IMAP, the 
message must be opened before you can navigate to the attachments.  

You can delete e-mail messages individually, or you can select multiple 
messages and delete them simultaneously. Press "Space-D" to delete the 
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current message, or select multiple messages with "Space", then press "Space-
D" to delete all of them.  

When you delete messages, they are automatically moved to the "Trash" folder, 
where they remain until you delete them from there, or until you empty the 
"Trash" folder. You can empty the "Trash" folder at any time by pressing "Enter-
Backspace-Q" or choosing 'Empty Trash' from the "Edit" menu.  

 Note: When messages are deleted from the "Trash" folder, they are 
permanently disposed of, and cannot be retrieved. 

 

8.6 Writing E-mail 
To write a new message, choose "Write New Message" from the "File" menu, or 
press "Enter-W" from the message list. "To:" is displayed on the Braille display. If 
you wish to use a different account from the default, Shift-Tab to the "Account" 
combo box, choose your desired account, and Tab back to the "To" field.  

Type the e-mail address of the recipient, or rather, the person to whom you are 
sending the message. If using US Braille, you must use computer Braille. To 
send to multiple recipients, place a semicolon between the e-mail addresses. 

You can also add recipients from the address list by selecting "Look up Address" 
from the "File" menu or pressing "Enter-L". Type the First name, last name or 
part of the e-mail address of the desired recipient, and press "enter".  

Addresses matching your search are displayed. If you press "enter" without 
typing in the desired name, all of the addresses in your address list are 
displayed. If there is no matching address, "No match" is announced. Move to 
the desired address, and press "enter". You can select more than one address 
by pressing "Space", then enter to input all of them.  
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You can also type any of the information above directly into the To or CC fields, 
and the first match will automatically be filled in when you Tab to the next field. 

When you are finished entering recipients in the "To" field, press "F3" to move to 
"CC:" and "BCC", and input any copy or blind copy recipients as described 
above. If you do not need to carbon copy anyone, you can skip to the next step. 

Press "F3" to move to "Subject", and type the subject of the e-mail message. 
Finally, press "F3" to move to "Message body:", and type the text of your e-mail 
message. Use the same input and editing methods as are used in the Word 
Processor.  

When you have finished writing your e-mail message, select "Send" from the 
"File" menu, or press "Enter-S" directly from your message. When the e-mail is 
finished sending, "Successfully sent new message" is displayed. If sending fails, 
the Polaris displays "Unable to send message", often with a specific error 
explaining the reason for the inability to send the message. If this occurs, the e-
mail is saved in the "Outbox". 

To cancel e-mail message creation or sending, press "Space-E" or "Space-Z" 
and you are returned to the "Inbox". 

 

8.6.1 ATTACHING A FILE 
To attach a file to a message, select "Attach File" from the "File" menu, or press 
"Enter-F" while writing an e-mail message. Use normal file and folder navigation 
keys to locate the file or files you want to attach.  

Press "enter" on the desired file to attach it. To attach more than one file, press 
"Space" to select each file you want to attach. * is displayed in front of the 
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selected file names. Press "enter" To attach the selected files. Now, the "Attach" 
item is displayed in the tab order after the "Message body".  

 

8.6.2 SAVING E-MAIL TO THE OUTBOX 
Messages are saved in the "Outbox" under 2 conditions: 

1. The user manually saves the e-mail to the "Outbox" for later sending. 

2. An e-mail is automatically saved to the "outbox" after it fails to send due to a 
network error or other reason. 

While writing a message, you can save by selecting "Save Mail in Outbox" from 
the "File" menu, or pressing "Space-S". A default file name is shown titled with 
the subject of the email. Press "Enter" to save the e-mail under the current file 
name, or type a new file name and change the path where the file is stored 
using the same method as in the "Save As" dialog of the Word Processor. 

 Note: If you choose to save the e-mail in a location other than 
"flashdisk/email/outbox", you cannot access the e-mail message in the 
"Outbox". Thus, you cannot send the e-mail unless it is returned to the 
"Outbox" folder. 

While creating a "message", press "Space-E" or "Space-Z" To cancel writing the 
e-mail. The Polaris displays "Currently writing mail. Save? Yes". Press Enter to 
save the message in the Outbox. To return to the "Inbox" without saving the e-
mail, press "Space" to change "Yes" to "No", and press "Enter". 

To send a message from the Outbox, "Shift-Tab" to the mailbox list, navigate to 
the Outbox, and Tab to the message list.  Press "Space-1" or "Space-4", to 
move to the message you want to send. 
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If you want to send all the e-mails in the list: Press "Enter-a (dot 1) to select all. 
If you want to send individual messages, use normal selection commands to 
select them. Press "Enter" on "Send" from the "File" menu, or just press "Enter-
S" from the outbox, and the messages are sent.  

 

8.7 Navigating Accounts and Mailboxes 
There are two ways to move to an account or mail box.  

You can access the accounts list or mailbox list by moving through the tab order 
until you reach "mailboxes" or "Accounts". Use "Space-1" or "Space-4" to move 
among the items in the list, and press "F3" to open the Account or mailbox.  

You can also use the following hot keys to navigate accounts and mailboxes: 

Go to next mailbox: Enter-3-4-5. 

Go to previous mailbox: Enter-1-2-6. 

Next account: Backspace-dots-3-4-5. 

Previous account: Backspace-1-2-6. 

 Note: These hot keys are not available from the account list or mail box 
list.  

 

8.7.1 MANAGING MAILBOXES 
You can create additional mailboxes in the "E-mail" folder for sorting and storing 
your messages.  
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To create a new mailbox, from the Mailbox list, open the "Edit" menu and select 
"Create New Mailbox", or press "Enter-N" to activate this function directly. Type 
the mailbox name you want to create, and press "Enter".  

The Polaris does not allow you to delete the "Inbox", "Sent", or "Outbox". 
However, you can delete folders/mailboxes you have created. 

To delete a folder/mailbox, navigate to the mailbox you want to delete in the 
Mailbox list, open the "Edit" menu and choose "Delete Mailbox". You can also 
delete the current mailbox in the list by pressing "Space-D".  

You can also rename mailboxes you have created. To do this, from the mailbox 
list, navigate to the mailbox you wish to rename. Open the Edit Menu and select 
"Rename mailbox", or press "Enter-R" to open the "rename mailbox" dialog 
directly. Type the new name for the folder mailbox, and press "Enter".  

 

8.7.2 COPYING AND MOVING TO MAILBOXES 
You can copy and move e-mails using the "Copy to Mailbox" or "Move to 
Mailbox" commands in the "Edit" menu. 

The "move/Copy dialog" contains the following: 

1) "Folder" list. 

2) "Create mailbox" Button 

3) "Delete mailbox" Button 

4) "Rename mailbox" Button 

5) "Confirm" Button 

6) "Cancel" Button 
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To copy and move an e-mail to another folder, follow these steps: 

1) Select individual e-mails by pressing "Space", select a continuous group with 
"Enter-B" or select all with "Enter-A".  

2) Open the "Edit" menu, and press "SPACE-4", to move to "Copy to Mailbox" or 
"Move to Mailbox" and press "Enter". You can activate these functions directly 
from the message list by pressing "Backspace-C" for "Copy" and "Backspace-X" 
for "Move to".  

3) Polaris displays "Folder list".  

4) Press "Space-4", to move to the folder into which you want to copy or move 
messages and press "Enter0.  

5) The e-mail is moved or copied to the selected folder, and you are returned to 
the mailbox from which you activated the "Move" or "Copy" command. 

 

8.7.3 IMPORTING EMAIL 
You may wish to access e-mail on your polaris from older Braille Sense devices 
or other units that use EML message files. You can do this using the Import 
function in the File Menu, or by pressing “Backspace-I” from the message or 
mailbox list.  

*Note: files and folders selected in this dialog will import to the currently open or 
focused mailbox. So, if you wish to import to a clean folder, you must create a 
folder as described previously, and be located within it or focused on it before 
you start this process. 
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When you activate the import function, you are placed in an “Open File” dialog. 
Use normal file and folder navigation to locate the folder where you’re messages 
are stored. Use File management selection commands to select the folders and 
files you want to import, and press Enter. Import progress is shown as a 
percentage. 

 

8.8 Advanced Message Features 
 

8.8.1 REPLY AND REPLY ALL 
When you reply to an e-mail, you can edit or add a message to the original 
message, or add another recipient. Choosing "Reply" sends an e-mail to only 
the original sender. Choosing "Reply To All" sends an e-mail back to the original 
sender as well as all other recipients of the original e-mail.  

 1) From "Subject", "Date", or "Message body" of a message in the "Inbox", 
select "Reply" or "Reply All" from the "Message" menu, or press "Enter-R" or 
"Backspace-R" respectively. 

2) You are placed in the message body, which already contains the original 
message body of the received e-mail; below "--- Original Message ---".  

3) You can type additional text, edit the original message, and/or edit any of the 
fields associated with the message including the subject and recipient fields. 

4) When you have finished, press "Enter-S" to send the e-mail. 

You can save replies just as you can save new messages in the "Outbox" for 
sending later. 
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8.8.2 FORWARDING A MESSAGE 
"Forwarding" refers to sending an e-mail you received to another person.  

1) From the "Subject", "Date", or "Message body", open the "Message" menu 
and select "Forward", or press "Enter-F". 

2) Polaris displays "To:". Input the e-mail address of the new recipient, or 
multiple recipients, using computer Braille. 

3) Press "F3", to move to "CC", "BCC", and "Subject" and edit them as you wish. 
The subject will appear as "FW: (original subject)". 

4) "Tab" to the message body. The original e-mail message is shown following, 
"----- Forwarded Message -----". 

5) Type any additional text you wish to add to the message, or make any edits to 
the forwarded text, and press "Enter-S" to send.  

If you don't want the e-mail to appear in the same message body as the e-mail 
you are writing, you can also forward the current e-mail as an attachment. Use 
"Backspace-W" to send the current e-mail as an attachment, then use the 
process described above. 

 

8.8.3 SAVING AN E-MAIL 
There may be times when you wish to save a received message as a file. 
Please note that there is a small difference between IMAP and POP3.  

1) Using Pop3: when placed on one of the fields of an e-mail message you want 
to save, select "Save as Text" from the "File" menu, or press "Space-S". 

2) Polaris displays "File name: (subject of e-mail being read.txt".  
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3) Press "Enter" to save the message under the current file name. If you wish, 
you can rename the file using the same method as in the "Save As" dialog of the 
"Word Processor".  

If you are using IMAP, you must first navigate to and open the message before 
you can save it. Otherwise the steps are exactly as those above. 

 

8.8.4 FINDING MESSAGES 
The "Find" command is used to search for messages in the current mailbox. The 
"Find" function looks for text that matches the text you enter in "Subject", "Date", 
and/or "From". This function only works in the "Subject", "Date", or "From" 
controls. Use "Space-F" to open the "Find" dialog, or open the "Edit" menu and 
press "Enter" on "Find".  

Use "F3" and "Space-F3" to move among the controls. Type the text to search in 
the Edit box. Choose what parts of the message to "Search". Choose the 
direction to search, and press "Enter".  

The "Find Again" command finds the next occurrence of the text according to 
the search text and direction specified in the "Find" dialog. As with "Find", the 
"Find Again" function only works in the "Subject", "Date", or "From" fields. Open 
the "Edit" menu and press "Enter" on "Find Again", or press "Backspace-F" from 
the message list. 

 

8.8.5 MOVE TO NEXT UNREAD MESSAGE 
The "Move To Next Unread Message" command allows you to move to the next 
unread message. If you use this function on the last unread message in a list, 
you are taken to the first unread message in the list.  
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To activate this function from the "Subject", "Date", or "From" field, open the 
"Edit" menu and select "Move to next Unread Message" or press "Enter-U" to 
activate this function directly.  

 

8.8.6 ACTIVATING LINKS 
Many e-mail messages contain web links, either to general websites, or to 
calendar/online events. 

You can open a link in the Polaris Browser by pressing “Enter-L” when your 
cursor is placed on the Web address. 

If you are activating a link to a Zoom meeting, Google Meet invitation, a Teams 
live event, or other item that requires launching of an installed Android ap, you 
must open this link in an Android browser, as the Polaris browser does not 
automatically launch other programs.  

To open a link located in the current paragraph in the default Android browser, 
press “Backspace-Enter-L”. The browser will launch, which will then, in turn, 
activate the associated Android program, provided that program is installed on 
your polaris. For example, if you want to launch a Zoom meeting, you need to 
install the Zoom application on your polaris from the Play Store. 

 

8.9 Using the Tools Menu 
In addition to the "Accounts Manager", the "Tools" menu contains options for 
setting the save path, spam filters and other e-mail options.  
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8.9.1 SET PATH 
"Set Path" sets the default download path where file attachments and e-mail are 
stored. To set the download path, open the "Tools" menu and press "Enter" on 
"Save Path", or press "Enter-T" from the message list. 

The "Set Path" dialog contains three settings: 

1) Save attachments path 

2) Send attachments path 

3) Disk to save mail in 

 

You can move among these items by pressing "Space-4" and "Space-1". Each 
item consists of "Path", "Modify", and "Close". At "Path", the default path is 
displayed. You can move among this information by pressing "F3" or "Space-
F3". If you choose to modify any path, use normal file management navigation 
to locate your desired folder, and press "Enter". 

 

8.9.2 SET OPTIONS 
To open the "Set options" dialog, press "Enter" on "Options" from the "Tools" 
menu, or press "Enter-O" to activate this item directly. 

The first item in the "Set options" dialog is "Default server?” You can set the 
default server to "IMAP" or "POP3". Use "Space" to change the value of the 
setting. 

The next item in the "Set Options" dialog is "Use inbox as default mailbox when 
using POP3 server? Yes.". If you want the e-mail program to always place you 
in the "inbox" when starting e-mail using POP3, leave this setting as is. If you 
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would like to use a different mailbox, press "Space" to change this option to 
"no".  

The next option in the dialog is "Get the number of mail at once when using 
IMAP". The default is set to 64. Use "Space" or "Backspace" to cycle through 
the various options. The available values are All, 32, 64, 96, and 128. 

The next 4 options relate to how information appears in the Message List. For 
each of the 4 message headers, you can choose to display the sender, (From, 
the recipient (To), subject of the message (Subject), or the date and time the 
message was received (Date). For the 2nd, 3rd and 4th headers, you also have 
the option not to display them at all (Off). This option is not available for the 1st 
header as, if all headers were turned off, the Message list would display no 
content. This allows you to show only the content you want to see in the 
Message list, as well as to determine in what order it appears. 

As you make choices for each header, these disappear from the options for the 
remaining headers. For example, if you choose “Subject” for the 1st header, you 
will not see this as an option for your 2nd, 3rd and 4th headers. But, if you change 
the first header to “From”, the “Subject” option will re-appear, and the “From” 
option will not appear for the rest of the headers.  

When you have finished adjusting the settings, press "Enter" to save the 
options, or tab to the "Confirm" button and press "Enter". If you do not wish to 
save your changes, tab to the "cancel" button and press "Enter" or press 
"Space-Z".  
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8.9.3 SPAM SETTINGS 
When the Polaris downloads e-mail from the e-mail server, there may be a 
number of e-mail messages that are spam. In this case, you can avoid 
downloading these spam e-mail messages by identifying specified words in the 
subject or specifying e-mail addresses you know are from spammers. 

The spam e-mail messages that are identified by your "Spam Settings" are not 
downloaded into the Polaris, and remain on the e-mail server. 

Use the following steps to set spam e-mail filters: 

1) Open the "Tools" menu and select "Spam Settings", or press "Enter-E" to 
activate this item without accessing the menus. 

2) The "Spam Settings" dialog contains 6 items: "Type" combo box, "List", "Add" 
button, "Modify" button, "Delete" button, and a "Close" button. 

3) "Type" can be set to 1 of 3 options: "Subject", "E-mail address string", and 
"Host". You can move among these options by pressing "Space-1" or "Space-4". 
The "list" is displayed according to the "Type" you choose. 

— If you have selected "Subject", the list is displayed as "Subject: (Registered 
word) 1/xx". If you selected "E-mail address string", it is displayed as "E-mail 
address string: (Registered e-mail address string) 1/xx". It is displayed as "no 
items" if there is no registered word or e-mail address string. 

 

How to register Spam Settings: 

1) Press A when "Type: Subject 1/3" is displayed. Or, press "F3" to move to the 
"Add" button, and press "enter". 

2) The "add dialog" is opened and "Subject add:" is displayed. 
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3) Type the words, by which you want to identify spam messages and press 
"Enter". Or, "Tab" to the "Confirm" button, and press "enter".  

4) "Successfully added spam data". is announced and you are returned to the 
"list". "Subject: (registered word) 1/1" is displayed. 

By adding the word in the manner just described, if there are e-mail messages 
that include the words you entered in the subject of the message, the Polaris 
downloads those e-mails from the e-mail server, but deletes them automatically.  

You can also avoid receiving e-mail messages from a specific sender or host by 
registering it in the same manner. 

To cancel setting spam filters from the "Add dialog", press "F3" to move to the 
"Cancel" button, and press "Enter". Or, press "Space-E" or "Space-Z".  

 

To modify a spam filter you have set, do the following: 

1) Access the "Spam Settings" dialog as described previously, and navigate to 
the "Type" of spam setting you want to modify by pressing "Space-1" or "Space-
4".  

2) Press "F3" to move to the list of registered items in that category.  

3) Navigate to the item you want to modify using "Space-1" or "Space-4".  

4) Press M, or press "F3" to move to the "Modify" button, and press "Enter".  

5) Make the modifications in the edit box. 

6) Press "F3" to move to the "confirm" button, and press "Enter" to save the 
changes.  
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You can also delete an item that has been registered in the spam list.  

1) Access the "Spam Settings" dialog as described previously, and navigate to 
the "Type" of spam setting you want to delete by pressing "Space-1" or "Space-
4".  

2) Press "F3" to move to the list of registered items in that category.  

3) Navigate to the item you want to delete using "Space-1" or "Space-4".  

4) Press D or press "F3" to move to the "Delete" button, and press "Enter". 

 

 

9. Media 
The "Media" menu on the BrailleSense Polaris consists of programs related to 
media playback: specifically music, videos, and DAISY content. The "Media" 
menu contains 3 items: "Media Player", "FM Radio", and "DAISY Player".  

You can open the "Media" menu by pressing "F1" to bring up the main 
"Program" menu, then navigating to "Media" using the DOWN scroll key and 
pressing "Enter". Or, you can quickly jump to and open the "Media" menu by 
pressing M from the main menu. 

 

9.1 Media Player 
You can use the Media Player to play audio files as well as listen to the audio for 
some video file formats. The Media Player plays the following formats, ac3, asf, 
asx, m3u, mp2, mp3, MP 4, mpa, mpg, ogg, pls, wav, wax, wma, flac, midi and 
wmv.  
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You can control the playing of media files using either Braille keyboard 
commands or the media buttons on the front panel of the Polaris. To launch the 
"Media Player", navigate to it in the "Media" menu and press "Enter". Or, launch 
it from anywhere on the unit by pressing "F1-M". 

 

9.1.1 USING THE MEDIA BUTTONS 
Near the center of the front panel on the Polaris is a group of 5 buttons. These 
buttons can be used to control the Media Player. Moving from left to right, the 
buttons are: "Back", "Record", "Stop", "Play/Pause", and "Forward".  

The media buttons can control media playback, DAISY content playback, or 
application operation, depending on the position of the Media Mode switch, 
located to the left of the media buttons. Slide this switch to the right-most 
position, "Media Mode", to control media playback.  

If the "Play/Pause" button is pressed while you are using another program on 
the Polaris, the unit opens the Media Player and begins playing the files in the 
most recently played list. If there are no files in the playlist, the Polaris says, 
"There are no items to display". "Back", "Stop", and "Forward" are available after 
audio playback is started.  

 Note: As the Polaris is able to multi-task, initiating audio playback with the 
"Play/Pause" button does not close the program you were running when 
you pressed it. To return to your former position, press "F2-F3" to cycle 
through the running programs until you reach your former location.  

A playlist can contain only 1 file, or many files. If there is more than one file in 
the playlist when you press the "Play/Pause" button, the Polaris plays all the 
files in the list one after another. If you press the "Play/Pause" button during 
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playback, audio playback is paused. To resume playing, press the button again. 
If you press the "Play/Pause" button while you are in the "Record" dialog, the 
most recently recorded file is played.  

If you press the "Forward" button, the next file in the playlist is played, and 
pressing the "Back" button plays the previous file. If you press the "Forward" 
button (while the last file in the list is playing, (or the "Back" button (while the first 
file in the list is playing), it has no effect, as there is no file to navigate to.  

You can use the "Record" button to create a recording using the internal 
microphone or an external microphone from anywhere on the unit provided the 
Media Mode switch is set to the right-most position. Pressing the "Record" 
button once opens the "Record" dialog. Press the "Record" button again to start 
recording. Press the "Record" button while you are recording to pause 
recording. Resume recording by pressing the "Record" button one more time. 
Press the "Stop" button to stop and save your recording. The recorded file is 
saved in the "flashdisk/music/record" folder.  

The "Stop" button is located in the center of the group and has a dot on it. It is 
used to stop playback or recording.  If you press "Stop" during audio playback, 
the next time media playback is launched, the Polaris starts playing the first file 
in the playlist. If you press this button while recording, the Polaris stops and 
saves the recording. If you press the "Stop" button in the "Record" dialog when 
not recording, the dialog closes. 

 

9.1.2 MEDIA PLAYER LAYOUT 
You can use the Braille keyboard to perform the same functions as the media 
buttons as well as more advanced features in the Media Player.  
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The playback dialog contains two information tabs: "playback information" and 
"playlist". Press "F3" or "Space-F3" to move between these tabs. 

The "playback information" tab displays the track number, the file name, and the 
current playback status: (play, pause, or stop). If there are no files in the playlist, 
the Polaris displays "Title: There are no items to display". If you press "Space-
4", the Polaris displays playback time information.  

When in the Playback tab, you can use the cursor routers to jump to specific 
areas of the media file. For example, if you want to move to a place near the 
middle of the file, press cursor router 16 or 17. If you want to move to a place 
near 75%, press cursor router 24 or 25. 

The "playlist" tab displays all the files in the playlist. For each file in the playlist, it 
displays the track number, file name, the location of the file in the list, and the 
total number of files in the list. If there is no file in the playlist, the Polaris 
displays the message "no items". 

The Polaris's Media Player supports the viewing of lyrics for MP3 files which 
contain them. The "Lyrics tab appears in the tab order only if the file you are 
playing contains lyrics in its file information. The lyrics are displayed in a multi 
edit box which you can read and navigate using normal document navigation 
commands.  

The Media Player menu contains five items: "File", "Play", "Record", "Position", 
"Mark" and "Settings".  

To open the Media Player menu, press "Space-M" or "F2". Select a menu item 
using "Space-1" or "Space-4" and press "Enter". Or, you can press "Space-M or 
"F2" followed by the shortcut for the corresponding menu item. For example to 
open the Record menu, press "Space-M" or "F2" to open the menu, and press 
R.  



 
 

 158  

  

 

The Media Player also contains various lists and dialog boxes. Use "Space-1" 
and "Space-4" or the Up and Down scroll keys to navigate menus, settings or 
file lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab among 
controls in a dialog. For the purposes of these instructions, we will generally 
refer to using "F3" and "Space-F3" or simply "Tab". However, in these instances, 
"Space-4-5" and "Space-1-2" can also be used. Press "Enter" to execute an 
item. 

 

9.1.3 THE FILE MENU 
1) Open File: (O) "Enter-O". Opens a media file and creates a new playlist. 

2) Open Folder: (F) "Enter-F". Creates a new playlist with all the media files in 
the selected folder. 

3) Add File: (A) "Backspace-O". Adds the selected files to the current playlist. 

4) Add Folder: (I) "Backspace-F". Adds all the media files in the selected folders 
to the current playlist. 

5) Save Playlist: (S) "Space-I". Saves the current playlist. 

6) Save As Playlist. Saves the currently playing files as a playlist. 

7) Delete Item: (D) "Space-D". Deletes the current item from the playlist. 

8) Tag Information: (T) "Enter-T". Opens the properties for the current media file. 

9) Open URL: (U) "Enter-U". Opens a website for streaming playback. 

10) Exit: (Z) "Enter-Z". Exits the Media Player. 

 



 
 

 159  

  

 

9.1.4 THE PLAY MENU 
1) Play (P) "Enter". Initiates playback. You can also press the "Play" button. 

2) Previous Track: (B) "Dot-3". Moves back 1 track. You can also press the 
"Back" button. 

3) Next Track: (N) "Dot-6". Moves forward 1 track. You can also press the 
"Forward" button. 

4) Back 5 Tracks: (D) "Dots-2-3". Moves back 5 tracks. 

5) Forward 5 tracks: (U) "Dots-5-6". Moves forward 5 tracks. 

6) First Track: (T) "Dots-1-3". Moves to the first track in the playlist. 

7) Last Track: (E) "Dots-4-6". Moves to the last track in the playlist. 

8) Volume Up: (H) "Space-Up Scroll". Increases the volume. 

9) Volume Down: (L) "Space-Down Scroll". Decreases the volume. 

10) Speed Up: (K) "Dots-3-4-5". Increases the playback speed. 

11) Slow Down: (M) "Dots-1-2-6". Decreases playback speed. 

12) Pause: (A) "Space". Pauses playback. Press again to resume. You can also 
use the "Play" button. 

13) Stop: (S) "Backspace". Stops playback. You can also use the "Stop" button. 

 

9.1.5 MAKING RECORDINGS 
1) Record: (R) "Enter-R". Places you in standby mode. Press again to initiate 
recording. Press "Space-Z" when finished. You can also use the "Record" button 
to start recording and the "Stop" button to finish. 
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9.1.6 THE POSITION MENU 
1) Mark Position: (M) "Enter-M". Marks the current position for later use. 

2) Delete marked Position: (D) "Enter-D". Unmark the marked position. 

3) Jump to Marked Position: (J) "Enter-J". Go to the position previously marked. 

4) Go to Time: (G) "Enter-G". Go to a specific time in the file.  

5) Go to Percent: (E) "Backspace-P". Move to a place in the file according to its 
percentage. 

6) Set Start Point: (L) "Enter-P". Set a start point for repeat play. 

7) Release Point: (R) "Space-E". Set the end point for repeat playback. 

 

9.1.7 THE MARK MENU 
1) Set Mark: (S) "Backspace-M". Bookmark a specific point the media file.  

2) Jump to Mark: (M) "Backspace-J". Move to a previously set mark. 

3) Previous Mark: (P) "Backspace-dot-3". Moves back one mark from your 
current position. 

4) Next Mark: (N) "Backspace-dot-6". Moves to the next mark after your current 
position. 

5) Delete Mark: (D) "Backspace-D". Deletes a mark. 

6) Mark Manager: (K) "Backspace-K". View and modify all marks in the current 
file. 
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9.1.8 THE SETTINGS MENU 
1) Configuration: (C) "Backspace-C". Lets you configure file information display, 
and exit position saving. 

2) Playback Settings: (P) "Enter-S". Settings for Repeat Shuffle and other 
playlist settings.  

3) Record Settings: (R) "Backspace-S". Choose recording source, file type, 
sample rate, bitrate, etc. 

4) Effect Settings: (E) "Enter-E". Set Equalizer and bass boost. 

   

9.2 FM Radio 
To use the "FM Radio" on the Polaris, you must connect headphones to the 
headphone jack on the unit, as the headphone cord serves as the antenna, and 
without it, radio reception will be poor to nonexistent.  

From the Media menu, use the scroll buttons to navigate to "FM Radio" and 
press "Enter". You can also press R to quickly jump to and launch the "FM 
Radio". You can launch the "FM Radio" from anywhere on the unit by pressing 
"F1-R".  

When the FM Radio is launched, your Polaris announces the radio frequency. If 
you have used the FM Radio program previously, the Polaris tunes to the 
frequency that you last listened to. 

 Note: the frequency range of the FM Radio is 87.5MHz to 108MHz. 
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9.2.1 LISTENING TO FM RADIO VIA THE INTERNAL SPEAKERS 
When you execute the FM Radio after connecting headphones, sound from the 
radio is directed through the headphones. As previously explained, it is 
necessary to connect the headphones to provide an antenna for radio reception. 
However, there may be times when you wish for the sound from the radio to 
output through the speakers on the Polaris. To listen to the radio through the 
internal speakers, press X, to toggle internal speaker output on/off.  

You can adjust the radio volume using Space with the Up and Down scroll 
buttons.  

 

9.2.2 FREQUENCY CONTROL 
To tune to another frequency, use the following commands: 

Press "dot 5" to scan forward for the next radio station, and "dot 2", to auto scan 
backward. Press "dot 6", to increase the frequency by0.1MHz, and "dot 3", to 
decrease the frequency by0.1MHz. Press "Space-F" to input the frequency 
directly. Type the frequency in numbers in the edit box and press "Enter".  

You can also use the media buttons on the front panel to control the FM Radio. 
The Media mode switch should be moved to the left-most position, "Application 
Mode." Pressing the "Back" button scans backward, and pressing the "Forward" 
button scans forward. 

You can also activate frequency movement commands from the "Frequency" 
menu. 
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9.2.3 ADDING AND NAVIGATING PRESETS 
To add the currently selected frequency as a preset, select "Add Preset" from 
the "Presets" menu, or press "Enter-S".  

The "add preset" dialog is opened and "Frequency: (current frequency)" is 
announced. "Tab" to the "Label" edit box. Type the name by which you want to 
identify the preset. Press "Enter" to save the preset. 

To add a frequency other than the one you're currently listening to, you may type 
the number of the frequency you wish to add in the "Frequency" edit box of the 
"add preset" dialog.  

You can navigate your presets by using "dot 1" to move back, and "dot 4" to 
move forward a preset.  

To delete a preset, navigate to the preset and press "Space-D".  

 Note: when this command is executed, the preset is deleted instantly 
without any warning or verification.  

You can also add and delete presets using the Preset Manager dialog. Select 
"Preset Manager" from the "Presets" menu, or press "Enter-M".  

The Preset Manager dialog contains the "Preset list", an "Add" button, a 
"Delete" button, a "Modify" button and a "Close" button.  

Pressing "Enter" on the "add" button opens the "add preset" dialog explained 
above. The "Modify" dialog lets you change the label of the current preset in the 
list. Use the "Delete" button to delete a preset from the preset list. To exit the 
Preset Manager" dialog navigate to the "Close" button and press "Enter" or 
press "Space-E".  

You can also use the media buttons on the front panel to add and move among 
presets. Press the "record" button for more than 2 seconds, to open the "add 
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preset" dialog. To move to the previous preset, press the "Back" button for more 
than 2 seconds. Pressing the "Forward" button for more than 2 seconds moves 
to the next preset. Pressing the "stop" button for more than 2 seconds deletes 
the selected preset. 

 

9.2.4 RECORDING FROM THE FM RADIO 
To record the audio of the radio station to which you are currently listening, 
Select "Record" from the radio's menu, or press "Enter-R". The "record" dialog is 
opened and the Polaris begins recording. 

While recording the radio, "Tab" to the "Pause" button and press "Enter", or 
press A to pause recording. The name of this button is changed to "Continue". 
Activate the "Continue" button or press G, recording resumes. To stop the 
recording, press S. Or, "Tab" to the "Stop" button and press "Enter".  

To check the duration of the current recording press "Space-4". The unit 
announces the current recording run time and total possible recording time.  

Recorded files are saved in the "flashdisk/music/radio" folder. The files are 
named according to the preset label and frequency. If you are recording a radio 
station that is not in your preset list, the recording is named "radio" followed by 
the frequency.  

You can also instantly start recording by pressing the "record" button on the front 
panel. Press the "Stop" button to stop and save the recording. Press the 
"Record" button again to pause and resume recording. Pressing the "Back" and 
"Forward" buttons moves among the controls in the "record" dialog.  
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9.2.4.1 Changing record folder 
To change the folder where recorded files are saved, select "Recording 
Settings" from the "File" menu or press "Backspace-S". 

You are placed in the "Recording Settings" dialog on the first item, "Recording 
type: mp3". "Tab" to the "Record folder" setting. 

"Record folder: /flashdisk/music/radio" is displayed. Press "Enter". Use normal 
folder navigation to locate your desired folder for storing recorded files. Press 
"Space" to select it and press "Enter", and you are returned to the "Record 
Settings" dialog. Press "Enter" again to save the settings and exit the dialog.  

In the Record Settings dialog, you can also set recording type, sample rate, and 
bit rate. To change the recording type, press "Space" to toggle between "wav" 
and "mp3". 

 

9.2.5 ADDITIONAL FEATURES 
1) Sensitivity adjustment 

If the Polaris cannot tune to the broadcast frequency you desire, adjust the 
scanning sensitivity. Open the "Settings" dialog. Press "Space-4" to navigate to 
"Sensitivity" and press "Space" or "Backspace" to adjust the sensitivity. Higher 
values increase the scanning sensitivity of the radio. If the sensitivity is 
increased, you can fine tune to more frequencies. 

2) Mute 

While listening to the radio, press "Space" to mute the audio. Pressing "Space" 
once again unmutes the radio. You can also mute the radio by pressing the 
"stop" button on the front panel, and unmute by pressing the "play" button.  
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9.3 DAISY Player 
Using the DAISY Player on the Polaris, you can listen to files and read books 
that use the DAISY format. DAISY is an acronym for (DIGITAL ACCESSIBLE 
INFORMATION SYSTEM). One advantage to DAISY books is that you can 
listen to the audio as well as read the associated text with the audio in DAISY 
books where both text and audio are present.  

The Polaris supports DAISY books that are version 3.0 or earlier. The DAISY 
Player supports the following book types: 

DAISY 2.0/2.02/3.0, DAISY XML/Digital Talking Book. 

ANSI/NISO Z39.86 2002, 2005. 

Bookshare.org DAISY content,  

NIMAS 1.1  

DRM: supports 2006 PDTB2 authentication.  

 

9.3.1 ARRANGEMENT OF THE DAISY PLAYER 
To launch the DAISY Player, press "Enter" on "DAISY Player" in the Polaris 
"Media" menu. You can also launch the DAISY player from anywhere on the unit 
by pressing "F1-D".  

When you launch the DAISY Player, you are placed in Polaris's drive list. Press 
"Enter" on the drive containing the DAISY book you want to open. 

Use normal folder navigation to locate the folder containing a DAISY book you 
want to open. Press "Space" to select it, then press "Enter" to open it. You must 
first select the folder containing the book, because a DAISY book contains 
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multiple files, thus, Polaris needs to know exactly from which folder to get all the 
book text and information.  

If you replay a book that you have listened to before, playback resumes from the 
location where you last exited. To stop playing a DAISY book, press "Space-Z". 
A prompt box appears asking if you would like to exit the DAISY Player. Select 
"Yes" or "No" with "Space" or "Backspace" and press "Enter".  

You can also control DAISY playback using the media buttons on the front 
panel. The Media Mode switch must be set to the center position, "DAISY 
Mode". Start DAISY playback by pressing the "play" button on the front panel. 
Press "play" again to pause playback. Press the "Back" button to move back 1 
navigational element, and press the "Forward" button to move forward by1 
navigational element. Use the "Record" button to set the navigational element 
by which the "Back" and "Forward" buttons move.  

Open the DAISY Player menu by pressing "Space-M" or "F2". The menu 
contains "File", "Document", "Mark", and "Heading". You can navigate the menu 
items using "Space-1" and "Space-4". To activate a menu item, press "Enter".  

Or, you can press "Space-M or "F2" followed by the shortcut for the 
corresponding menu item. For example to open the "Heading" menu, press 
"Space-M" or "F2" to open the menu, and press H.  

The DAISY Player also contains various lists and dialog boxes. Use "Space-1" 
and "Space-4" or the Up and Down scroll keys to navigate menus, settings or 
file lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab among 
controls in a dialog. For the purposes of these instructions, we will generally 
refer to using "F3" and "Space-F3" or simply "Tab". However, in these instances, 
"Space-4-5" and "Space-1-2" can also be used. Press "Enter" to execute an 
item. 
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While playing DAISY content, you are placed in a dialog in which four 
controls/components are available: "heading", "Information", "Play" and "Pause". 
"Tab" through this information using "F3".  

"Heading" shows you a prefixed heading or navigation element as well as the 
text under that element if text exists. In "information", you can find the current 
page, level, phrase, elapsed time, and running time. You can move among these 
items with "Space-1" or "Space-4". You can press "Enter" on "Pause" or "Play", 
to pause or play the audio. From anywhere in the dialog, you can also toggle 
play/pause with "Space". 

 

9.3.2 THE FILE MENU 
1) Open DAISY: (O) "Enter-O". Calls the "Open DAISY" dialog. 

2) Voice Settings: (S) "Enter-S". Set auto playback settings as well as rate, pitch 
and volume of the reading voice. 

3) Book Info: (I) "Enter-I". Obtain information about the currently playing DAISY 
book. 

4) Exit: (Z) "Space-Z". Closes the DAISY Player. 

5) Exit and delete Bookmark: (Q) “Enter-Z”. exits and deletes any existing exit 
mark. 

6) Exit Without Bookmark: © “Backspace-Z”. Closes without marking your exit 
position. 
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9.3.3 THE DOCUMENT MENU 
1) Play/Pause: (P) "Space-P". Pause and resume playback. You can also use 
the "Play" button. 

2) Previous Page: (U) "Dots-1-2-6". Moves back one page. 

3) Next Page: (D) "Dots-3-4-5". Moves forward one page. 

4) Go To Page: (G) "Enter-G". Enter the number of the specific page you want to 
go to. 

5) Move by Previous Movement Unit: (H) "Dot-3". Move back by specified 
movement type. 

6) Move by Next Movement Unit: (L) "Dot-6". Move forward by specified 
movement type. 

7) Change to Previous Movement Unit: (I) "Dots-2-3". Cycle backward one 
movement type.  

8) Change to Next Movement Unit: (E) "Dots-5-6". Cycle forward one movement 
type. 

 

9.3.4 THE MARK MENU 
1) Set Mark: (M) "Enter-M". Bookmark a position. 

2) Jump to Mark: (J) "Enter-J". Move to a previously set mark. 

3) Delete Mark: (D) "Space-D". Delete a previously set mark. 

 

9.3.5 THE HEADINGS MENU 
1) Headings List: (L) "Enter-H". Open the list of headings in the book. 
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2) Scan for Next Heading: (N) "Enter-N". Move to the next available heading. 

3) Read Current Heading: (W) "Enter-W". Read the heading under which the 
current text is located. 

4) First Heading: (T) "Dots-1-3". Move to the first heading. 

5) Last Heading: (B) "Dots-4-6". Move to the final heading of the book. 

6) Find: (F) "Space-F". Search for text. 

7) Find Again: (R) "Enter-F". Find the next instance of the search string you 
specified in the "Find" dialog. 

 

9.3.6 THE MEMO MENU 
1) Insert Memo: (M) "Backspace-M". Insert an annotation. 

2) Read Memo: (R) "Backspace-R". Read the current memo. 

3) Previous Memo: (P) "Backspace-P". Move back one memo from your current 
position. 

4) Next Memo: (N) "Backspace-N". Move to the next memo from your current 
position. 

5) Delete Memo: (D) "Backspace-D". Delete the current memo. 

 

9.4 Document Reader 
The Document Reader allows you to open files in most supported text-based formats in a Read Only 

environment with special navigation features. In general, it allows you to read and interact with the 

elements of these files in a fashion similar to the DAISY Player, or a file opened in Read Only mode. 
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The Document Reader supports the following file types: Txt, RTF, BRL, BRF, Doc, DOCX, PDF, EPUB, XML, 

HTM and HTML.  

You can activate all the functions of the Document Reader via the menu or by using hot keys. The menu 

consists of File, Edit, Go To, Read, and Mark. To access these menus, press "Space-M" or "F2".  Select a 

menu item using "Space-1" or "Space-4" , and press "Enter". Or, you can press "Space-M or "F2" followed 

by the shortcut for the corresponding menu item.  For example to open the edit menu, press "Space-M" or 

"F2" to open the menu, and press E.   

The Document Reader also contains various lists and settings dialogs. Use "Space-1" and "Space-4" or the 

Up and Down scroll keys to navigate menus, settings or file lists. Use "Space-4-5" and "Space-1-2" or "F3" 

and "Space-F3" to tab among controls in a dialog.  

 

9.4.1 GENERAL DOCUMENT NAVIGATION 
When you first launch the Document Reader, by default, you are placed in the "Open" dialog. You can 

change the Document Reader's start position using the "Start Settings" described later. You can also access 

the Open File" dialog any time by selecting "Open" from the "File" menu, or pressing "Enter-O".   

You are placed in the list of folders and files in your "DOCUMENTS" folder. Use normal File and folder 

navigation to locate the file you want, and press "Enter". 

By default, when you press "Enter" to open a document, BrailleSense places you at the position at which 

you last exited the file. If you wish to have the document automatically start reading aloud, you can change 

this behavior in the "Voice Settings" described in section 9.2.2. 

You may navigate as the file reads aloud (continuous Reading Mode) or you may press "enter" to toggle to 

"Manual Mode" in which case, text is only read as you navigate to it, and only the selected element is read.  

In addition to the navigation keys described in the remaining sections of this chapter, you may use normal 

document navigation commands to read documents in the Document Reader as described in chapter 5 of 

this manual. 
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9.4.2 THE FILE MENU 
1) Open: (O) "Enter-O". Brings up the "Open File" dialog from which you can open any of the supported file 

types listed above. 

2) Recent Documents: (R) "Enter-R". Shows documents recently opened in the Document Reader in a list. 

Press "Enter" on a document you want to read.  

3) Page Settings: (P) "Backspace-P". The page settings allow you to define how the document reader 

determines the amount of text to move by when navigating by page. The "Page Settings" dialog contains 4 

items: an edit box in which you can "Set lines per page", edit box in which you can "Set characters per line", 

a "Confirm" button and a "Cancel" button.  

4) Voice Settings: (S) "Enter-S". The "Voice Settings" let you define how the document is read when using 

speech, including the ability not to use speech at all.  The "Voice Settings" list includes the following: Voice: 

(On/Off), Default Reading Mode: (Continuous or Manual), Set Volume, Set Speed and Set Pitch.  

5) Document Information: (I) "Enter-I". The "Document Information" option provides information on your 

current position in the document relative to the whole. The information includes the current and total page, 

paragraph, sentence and line, as well as the title of the document you are currently reading.  

6) Start Setting: (E) "Enter-E". The "Start setting" determines where you are placed when the Document 

Reader is launched. The options in the "Start Setting" combo box are "Open File dialog", "Recent 

Documents", and "No Startup Action", in which case, the unit simply lands on a blank screen, from which 

you can choose what function to perform. 

7) Exit with Bookmark: (Z) "Space-Z". Use this to close the "Document Reader and save the position in your 

current document. 

8) Exit and delete all marks: (Q) "Enter-Z". This option closes the Document Reader and deletes any existing 

marks in the current document. 

9) Exit without bookmark: (C) "Backspace-Z". This option closes the Document Reader, but does not save 

your position in the current document. 
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9.4.3 THE EDIT MENU 
1) Start Selection: (B) "Enter-B". Allows you to select a certain portion of text that you would like to copy to 

the clipboard. The end point of the selected text is determined by the location at which you place the cursor 

after setting the start pointwith "Enter-B".  

2) Copy: (C) "Enter-C". After selecting text, activate "Copy" from the "Edit" menu, or press "Enter-C" while 

in a document.  

3) Add to Clipboard: (P) "Enter-P". To add selected text to the clipboard, select "Add to Clipboard" from the 

"Edit" menu, or press "Enter-P" while in a document.   

4) Clear Clipboard: (E) "Enter-D". To delete the text in the clipboard, select "Clear Clipboard" from the 

"Edit" menu, or press "Enter-D" while in a document.   

5) Select All: (A) "Enter-A". Selects all the text in your current document. 

 

9.4.4 THE GO TO MENU 
1) Find: (F) "Space-F". The find function allows you to search for text in a document. The Find dialog 

consists of "Text to find", "Search direction", "Match case", a "Confirm" button, and a "Cancel" button.  

2) Find Next: (H) "Enter-F". "Find Again" looks for additional instances of the text that was searched for in 

the previous "Find".  

3) Find Previous: (V) "Backspace-F". The "Find Previous" function works the same ways the 'Find Again" 

function described above, however, searches the document in the backward direction. 

4) Go to Location: (G) "Enter-L". The "Go to Location" command moves quickly to a specific page, 

paragraph, or line.  

5) Go to Headings List: (T) "Enter-T". The "Go to Headings List" function only appears when you are reading 

HTML, XML, or EPUB documents, and brings up a list of headings in your current document. Use "Space-1" 

and "Space-4" to move among the headings, and press "Enter" to jump to the current heading in the list.  

6) Go to Previous Heading: (P) "Backspace-space-2-3-5". Moves to the previous heading in an EPUB, XML, 

HTM, HTML or DOCX document. 
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7) Go to Next Heading: (N) "Backspace-Space-2-5-6". Moves to the next heading in an EPUB, XML, HTM, 

HTML, or DOCX document. 

 

9.4.5 THE READ MENU 
1) Read Selected Text: (B) "Backspace-B". Speaks the text you currently have selected. Note: this option is 

only available in "Manual Reading Mode".  

2) Toggle Reading Mode: (G) "Enter". The "Toggle Reading Mode" option allows you to toggle between 

"Continuous" and "Manual" reading modes. Press "Enter" while reading a document to toggle between 

Manual and Continuous reading. 

3) Read Current Page: (C) "Backspace". Speaks the current page. Read the prior page using "dots-1-2-6", 

and read the next page using "dots-3-4-5".  

4) Read Current Paragraph: (P) "Space-2-3-5-6". Speaks the current paragraph. Read the prior paragraph 

using "Space-2-3", and read the next paragraph using "Space-5-6". 

5) Read Current Line: (L) "Space-1-4". Speaks the current line.  Read the prior line using "Space-1", and 

read the next line using "Space-4". 

6) Read Current Sentence: (S) "Space-1-4-5-6". Speaks the current sentence. 

 

9.4.6 THE MARK MENU 
1) Set Mark: (M) "Enter-M". You can set marks while playing a file to note positions you would like to 

return to later. You may set up to 1000 marks per document.  

2) Jump to Mark: (J) "Enter-J". You are prompted for the "Mark name to move to:". Type the mark name in 

the edit box and press "Enter".  

3) Delete a Mark: (D) "Space-D". You are prompted to "Enter mark name to delete". Type it and press 

"Enter".  
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4) Next Mark: (N) "Enter-N". The "Next Mark" function allows you to move to a marked location ahead of 

your current position.  

5) Previous Mark: (B) "Backspace-M". The "Previous Mark" function allows you to move to a marked 

location before your current position.  

6) Mark List:  (K) "ENTER-K". Use "Space-1" and "Space-4" to navigate the list, and press "Enter" on a mark 

to go to its location in the document. 

7) Mark Alert Options: (O)  "Backspace-O". You can use the Mark Alert Options" setting to configure how 

you want to be alerted when marks appear in your document as you read. The alert options are "Beep", 

"Message" and "No alert".  

 

10. Organizer. 
The "Organizer" menu contains items to help you organize and synchronize 
appointments and contacts. It contains the "Address Manager", and the 
"Schedule Manager".  

Open the "Organizer" menu by navigating to "Organizer" in the main "Program" 
menu, or just by pressing "O from the main menu. 

 

10.1 Address Manager 
The "Address Manager" is a program you can use to keep track of your contact 
information for friends and colleagues, such as company addresses, home 
addresses, e-mail addresses, as well as other information. You can also 
synchronize your contacts with your Google account under Accounts in the 
Settings menu of All Apps. 
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The "Address Manager" consists of two main dialogs: "Add Address" for 
entering contact information, and "Search Address" for retrieving this 
information.  

In the "Organizer" menu, you can quickly jump to an open the "Address 
Manager" by typing "a" or by navigating to the "Address Manager" and pressing 
"Enter".  

When the "Address Manager" is opened, the "Search Address" dialog is 
displayed. The Polaris prompts, "Last name:"  

You can use the menus to conveniently browse and execute all of the available 
commands. To open the menu, press "Space-M" or "F2". Select a menu item 
using "Space-1" or "Space-4”, and press "Enter". Or, you can press "Space-M or 
"F2" followed by the shortcut for the corresponding menu item. Use "Space-1" 
and "Space-4" or the Up and Down scroll keys to navigate menus, settings or 
file lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab and 
Shift-Tab among controls in a dialog.  

 

10.1.1 ADDING AN ADDRESS 
This dialog allows you to enter new contacts. Select "Add Address" from the 
menu, or press "Enter-I" directly from in the "Address Manager". 

The "Add address" dialog contains an Account Name combo box, a list of 22 
input fields, the "Memo" field, a "Confirm" button, and a "Cancel" button. Use the 
account Name combo box to choose to which account you want to add this 
particular contact. In the input fields, enter the information corresponding to the 
22 fields of a record. You can move from one field to the next using "Space-1" 
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and "Space-4" or the up and down scroll keys. You do not have to fill in all the 
fields, simply leave blank those you do not need to use.  

If using US Braille, you can enter telephone numbers using computer Braille 
(without a number sign) or regular grade 1 Braille (with or without a number 
sign). To enter a dash, press "Space" or "dots 3-6". To put an extension number 
after any phone number, enter the phone number as described above, and then 
type a comma (,), followed by the extension number, as in "000-000-0000,100." 
In this case, Press "dot 6" to enter the comma in computer Braille or "dot 2" in 
grade 1 Braille. When you enter a home page address or an e-mail address, you 
should also use computer Braille.  

After filling in the desired information, Tab to the "Memo" field. You can type in 
multiple lines of text in the "Memo" field. If you do not wish to enter a memo, 
leave it blank.  

When you have entered all the relevant information, Tab to the "Confirm" button 
and press "Enter". Or, just press "Enter" from any field. To cancel the contact 
entry, Tab to "Cancel" and press “Enter". After canceling or adding an entry, you 
are placed in a new blank record.  

 

10.1.2 SETTING ADD ADDRESS FIELDS 
There are 22 fields in a record, but you may not want to enter information in 
every one of the 22 fields. You can use "Set Address Fields" to select only the 
fields that you need. 

To use this function, Select "Set Address Fields" from the menu, or, press 
"Enter-O" from the "Add Address" dialog. On the right side of each field name, 
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"used" or "unused" is displayed. The default value is set to "used". To toggle the 
value, press "Space". 

After setting all the fields you want to change, Tab to "Confirm" and press 
"Enter". To cancel changes, press "Space-E".  

 

10.1.3 SEARCHING FOR AN ADDRESS 
The "Search Address" dialog enables you to search for specific records in the 
"Address Manager". The "Search Address" dialog is opened automatically when 
the "Address Manager" is launched. To open "Search Address" from "Add 
Address", you can either select it from the menu, or press "Enter-S" from the 
"Add Address" dialog. "Last name" is displayed as this is the first field in the 
address data.  

Type a last name to search for and press "Enter". Press "Enter" without entering 
text to search, and all records are shown. To search by a different field, navigate 
to it using "Space-4", type the search text in the edit box, and press "Enter".  

You can move among found records using "Space-1" and "Space-4". Press F3 
on the record you wish to view. The information appears in a multi-line read box 
which you can navigate using normal text navigation commands. 

If a record contains an e-mail Address, you can press "Enter" to launch the e-
mail program and send an e-mail to that person. If a field contains a web page, 
you can press "Enter" on it to open the page in the Web browser.  

When you enter text to be searched, you do not have to type the entire content 
of a field. For example, to find a record about "Edward", type in "ed" in the 
"search name" field. Then, all the records whose name field contains "ed" are 
found. 
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10.1.4 SETTING SEARCHING ADDRESS FIELDS 
This option enables you to select the fields that you want to search. Select "Set 
Address Search Fields" from the menu, or press "Enter-O" from the "Search 
Address" dialog. 

All the address fields are displayed. Press "Space", to toggle the value of a field 
between "used" and "unused".  

 

10.1.5 BACKING UP AND RESTORING THE ADDRESS LIST 
If you perform a hard reset, or if your battery dies, all of the data in the "Address 
Manager" is lost. Thus, it is very important that you make a backup file every 
time you make a change to the address list. Select "Backup Address List" from 
the menu, or press "Enter-U" from anywhere in Address Manager.  

If you already have a backup file, you are prompted, "Backup file already exists. 
Continue to backup? Yes". If you have made changes to your address list, press 
"Enter" to create a new backup file. To keep the previous backup file press 
"Space-4", to move to "No", and press "Enter". When you create a backup file in 
your address list, you will have a new backup file in the database folder on the 
Flashdisk. 

To restore the address list after a hard reset, select "Restore Address List" from 
the menu, or press "Enter-R" from anywhere in Address Manager. 

If you already have an address list, you are prompted, "Address file already 
exists. Which do you prefer? Append". If you press "Enter", the backup address 
list is appended to the current address list. If you press "Space-4" once and 
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press "Enter" on "Overwrite", the new backup file is restored, erasing the old 
backup file. 

You can backup your address list automatically using the "Set Backup Options". 
Select "Set Backup Options" from the menu, or press "Enter-E".  

The "Backup mode" has three radio buttons: "Always backup changes when 
exiting", "Manual backup", and "Prompt backup changes when exiting". Move 
through the radio buttons using "Space" and "Backspace". Press "Enter" to save 
your setting. 

 

10.1.6 IMPORTING FROM CSV 
"CSV" is the acronym for Comma Separated Value. A CSV file is used for the 
digital storage of data structured in a table form, with the information in the 
various columns separated using commas. The "Address Manager" can import 
a CSV contact file created using MS outlook or some cell phones. You can also 
export a CSV file of your contacts for use on other devices. 

To import the data from a CSV file, select "Import from CSV" from the menu, or 
press "Backspace-I" from anywhere in the Address Manager. Type the name of 
the file you want to import in the edit box. To browse for a file, "Shift-Tab to the 
path search list, and use normal file navigation commands to choose your file 
and press "Enter".  

When the CSV file is imported, "Last name: unused 1/xx" is displayed. You can 
choose whether the data from the CSV file for each field should be imported. 
Some CSV files may contain data that is not equivalent to any of the fields in the 
"Address Manager", or you may simply not wish to import certain pieces of 
information.   
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This dialog contains all the fields in the "Address Manager", a check box for 
allowing fields in the first record, and "Confirm" and "Cancel" buttons. Tab and 
Shift-Tab among these items.  For each "Address Manager" field, there is a list 
box containing "Unused" and all of the fields of the CSV file being imported. Use 
"Space-1" and "Space-4" to move among the fields. If there is no equivalent field 
in the CSV file for an "Address Manager" field, select "unused".   

Often, the first set of fields in a CSV file represent field titles. For this reason, 
there is a check box for allowing fields in the first record to be imported or not. If 
the first set of fields does contain title data, make sure that the "allow fields in 
first record" item is not checked.  

To complete the import, Tab to "Confirm" and press "Enter". You are prompted, 
"Address file already exists. Which do you prefer?" The default value is 
"Overwrite". The setting values are "Overwrite" and "Add". You can either 
replace the existing file with the data imported from the CSV file, or you may add 
it to the existing address list. To change the setting value, press "Space", and 
press "Enter" to save the data. 

 

10.1.7 EXPORTING TO CSV 
To export address data to CSV, select "Export to CSV" from the menu, or press 
"Backspace-X". Type a file name for the exported data and press "Enter". To 
change the location where the file is stored, Shift-Tab to the file list and use 
normal file and folder navigation to select the location.  
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10.1.8 EDITING, SAVING, AND DELETING ADDRESSES 
To edit information in a record, find the desired address by using the "Search 
Address" function. Select "Modify Address" from the menu, or press "Enter-M" to 
activate this command directly. You can now enter new information in any of the 
fields. When you have modified the information, press "Enter". The Polaris 
saves the changes, and you are returned to your previous position. You can 
press “Space-E” to cancel the modification. 

To delete the record you are currently reading, select "Delete Address" from the 
menu, or press "Space-D" while viewing the record. You can also delete more 
than one record at a time by first selecting individual records with "Space", or by 
selecting all records with "Enter-A". 

You can also save selected records to a file. Select "Save addresses As File" 
from the menu, or press "Enter-T" from the "Search Address" dialog. The "file 
save" dialog is displayed and you are asked to enter the file name and select a 
file format. After you type the file name, and select one of the available file 
formats, press "Enter" on "Confirm", and the selected records are saved.  

 

10.1.9 SYNCING CONTACTS 
Contacts entered or imported into the Polaris can be synchronized with your 
Google Account, and thus also, any other accounts that synchronize with your 
Google Account. 

You can set your sync preferences in the Android System Settings, under the 
accounts item, then Google. All of your Google accounts are listed and identified 
whether Sync is enabled. Press Enter to open a dialog in which you can choose 
what items you would like to have synced. If you choose to sync your contacts, 
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they are automatically synchronized when you make changes. You can also 
manually “Sync Now” in the More options menu of the Accounts dialog. 

Note: if you make too many changes, such as when importing a CSV, or 
synchronizing many new contacts, you may receive “Sync Errors”. If this occurs, 
press Space-1-2-3-4-5-6 to open the Notification Shade, and press Enter to 
open the error. From there, you are given options as to how you would like to 
handle the errors. 

 

10.2 Schedule Manager 
The "Schedule Manager" is a program used to manage information about 
appointments, anniversaries, and events. It can also inform you of appointments 
at a specified time using alarms. You can start the "Schedule Manager" from the 
"Organizer" menu, by navigating to it with "Space-4" and pressing "Enter". You 
can launch the "Schedule Manager" from anywhere on the unit by pressing "F1-
S".  

The "Schedule Manager" has two main dialogs: "Add appointment" and "Search 
appointments". In "Add appointment", you can enter information for a new 
appointment. Using "Search appointments", you can look for information about a 
specific appointment and edit or delete the information.  

When the "Schedule Manager" is opened, the "Search appointments" dialog box 
is displayed. You are prompted for a "Find date:" with the current date filled in as 
the default. To add a new appointment, select "Add appointment" from the 
menu, or press "Enter-I" from the "Search appointments" dialog. 

 Note: Due to the nature of appointments, it is very important that dates 
and times are entered correctly to ensure that your schedule is accurate 
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and you are alerted to your appointments at the proper times through the 
"Check Today's SCHEDULE" option as well as the alarms that can be 
associated with appointments. Please be sure your time and date are set 
correctly. (See section 3.1)  

 

10.2.1 ADDING AN APPOINTMENT 
To add a new appointment, press "Enter-I" from the "Search appointments" 
dialog. The "Add appointment" dialog has a set of input fields, a "Confirm" 
button, and a "Cancel" button. Use "F3" and "Space-F3" to move through the 
controls. 

When you start "Add appointment", you are prompted to choose the 
appointment type. Use Space-1 or Space-4 to choose between “Anniversary” or 
“Appointment”. 

The next field is the "Start date" edit box. To use the date displayed, Tab to the 
next field. To enter a new date, type month/day/year.  

 Note: If you have not searched for an appointment, or have searched by 
subject, the default "Start date" is today's date. If you have searched 
appointments by date, it is the last date for which you searched. 

Tab to the "Start Time" field. By default, this field shows the current time. Enter 
the time as hhmm or use navigation keys to select your appointment time. If 
you're using "12 hour" format, press "Space-X" to change between am and pm. 

The next field is the end date. By default, the end date is the same as the "Start 
date". To use this date, Tab to the next field. To enter a new date, type 
month/day/year. 
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By default, the end time is the same time as you set in the "Start time" field. To 
change the time, type the time as hhmm. 

The next field is the subject of the appointment. If you do not enter anything in 
this field, you cannot save the record. If you press "Enter" after typing in the 
subject, the record is saved, leaving the "Location" and "Memo" field empty, and 
the "Alarm time" field set to its default value ("off"). Type your subject and Tab to 
the next field. 

Type the location of your appointment. Press “Enter" to save the appointment, or 
Tab to the next field. 

In the "Memo" field, you can enter detailed information about an appointment. 
This is a multi-line edit box, meaning you can type more than one line of text. 
You can use most of the editing commands that are used in the "Word 
processor". You can leave this field blank if you wish. 

The "Alarm time" function allows you to set when you are reminded about an 
appointment. The alarm is set relative to the appointment time. For example, 
you may want the alarm to sound 30 minutes before your appointment, so that 
you are not late. The default value for this field is set to "off".  

The time can be set anywhere from one minute to two weeks before the 
appointment. Use the same navigation keys as when setting the time and date. 
If you do not wish to have an alarm reminder, press "Space-1" to "Alarm off". 
After setting the "Alarm time", press "Enter" to save the appointment.  

 

10.2.2 SETTING A RECURRING APPOINTMENT 
Set this option when the appointment you are creating recurs at regular 
intervals. If it is unchecked, the appointment is set to occur once. To set a 
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recurring appointment, check this box with "Space", then Tab to the resulting 
combo box for setting the recurrence pattern. You can select from "Daily", 
"Weekly", "Monthly" and "Yearly". 

If you select "Daily", Tab to the "Recurring interval of day" edit box. You can type 
a number between 1 and 999 to represent the number of days between 
recurrences. If you enter 1, the appointment recurs every day, and if you enter 2, 
it recurs every other day. Be sure the difference between the start and end date 
is shorter than the recurring interval value.  

Tab to the "Set recurrence end date" check box. By default, it's unchecked, 
which indicates that the appointment recurs indefinitely. If you check this box, an 
edit combo box for entering the end date appears in the tab order. 

If you set the "Recurrence" to weekly, Tab to the "Recurring interval" edit box, 
and type the number of weeks between appointments in numbers from 1 to 999. 
As with daily, the appointment duration should be shorter than the recurring 
interval.  

Tab to a list box where you can select the day of the week on which the 
appointment recurs. To select or unselect the current item, press "Space". You 
can make more than one selection, thus the appointment recurs on more than 
one day during the week. If you don't select a day, it is set to the today's week 
day.  

If you set the "Recurrence to monthly", Tab to the "Recurring type" combo box. 
You can set the recurring type as "Date" or "Day of the week". "Date" is used 
when you want to set an appointment recurring on the same day of a month, for 
example, on the 17th of every month, or every other month. On the other hand, 
"Day of the week" is used when you want to set an appointment recurring on the 
same week and day of the week of a month, for example, on Wednesday of the 



 
 

 187  

  

 

second week of every month. After selecting the "Recurring type", Tab to the 
"Recurring interval", and type a number of months between appointments in 
numbers from 1 to 999.  

Different fields are shown in the Tab order depending on what you have selected 
in "Recurring type". If you set the "Recurring type" to "Date", an edit box 
appears for typing the day of the month for the recurrence. By default the "Start 
date" is shown. Tab to "Set recurrence end date" and make your choices. 

If you set the "Recurrence" to "Yearly", Tab to the "Recurring type" combo box. 
Select either "date" or "day of the week". If you set the "Recurring type" to 
"Date", you can set the month and the day of the month when the appointment 
recurs. If you set it to "Day of the week", you can set the month, the week, and 
the day of the week when the appointment recurs every year. After setting 
"Recurring type", Tab to the "Month for recurrence" combo box. Select the 
month of the year using "Space-1" or "Space-4". From here, different fields 
appear in the tab order depending on how you have set the "Recurring type".  

If you have set the "Recurring type" to "Date", the focus moves to "Day of 
recurrence" edit box. You can type a number between 1 and 31. Then, Tab to 
the "Set recurrence end date" check box. If the "Recurring type" is set to "Day of 
the week", you have to set "recurring week" and "Day of week for recurrence".  

 

10.2.3 SEARCH APPOINTMENTS 
When you start "Schedule Manager", the "Search appointments" dialog is 
opened. You can also open this dialog from the "Add appointment" dialog, by 
pressing "Enter-S" or selecting "Search appointments" from the menu. There are 
two methods for searching an appointment: "searching by subject" and 
"searching by date".  
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When "searching by subject", you can find an appointment using keywords in 
the subject field. When "searching by date", you can find appointments 
according to a specified date. To toggle the search mode, Select "Toggle Search 
Mode" from the menu, or press "Enter-F". The last search mode you used is 
saved when you exit the Schedule Manager.  

You can also determine how searches are done by default using the “Search 
options” item from the menu. This allows you to choose your default search mode, 
as well as whether to search the entire calendar, or to search from the current 
date forward when searching by subject. 

When you search by date, by default, the Polaris searches for appointments 
occurring today. To search for another date, type the date in the format 
"mm/dd/yyyy", or use the "move by date" hotkeys. Press "Enter", and the 
appointments occurring on the chosen day are shown. If there is no appointment 
on that day, the unit announces, "There is no appointment registered".  

The first appointment is announced in the form of "date, time, and subject". If the 
appointment lasts for more than one day, "continuous schedule" is announced. If 
the appointment recurs, "recurring schedule" is announced. If you scheduled 
more than one appointment for that day, move among the appointments using 
"Space-1" or "Space-4". To move to the first appointment, press "Space-1-3", 
and to move to the last appointment on that day, press "Space-4-6".  

To move to the appointments on another day, press "Space-2" or "Space-5". The 
previous/next appointment occurring within four months is displayed. To move to 
the first appointment stored in the Schedule Manager, press "Space-1-2-3", and 
to move to the last appointment stored in the Schedule Manager, press "Space-
4-5-6". To obtain details on an appointment, press "Enter".  
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To search by subject, type in the keywords to search and press "Enter". All 
appointments with the keywords are displayed. If you press "Enter" without 
typing text, Polaris displays all appointments in the “Schedule Manager". 

To move to the next or previous appointment, press "Space-4" or "Space-1" 
respectively. Pressing "Space-1-3" and "Space-4-6" move to the first and last 
items in the appointment list. 

For recurring appointments and multiple day appointments, the Polaris only 
shows the appointments of the first day if you search the schedule by subject. 
Press "Enter" on an appointment to read the details. Press "Space-E" to return 
to the appointment list. To search other keywords, Tab to the "Search subject" 
edit box, and type new search text. 

Some appointments you enter or receive may contain links to a Zoom meeting, 
Google Meet invitation, a Teams live event, or other item that requires launching 
of an installed Android ap. These are generally located in the Memo or location 
fields.  You can open these links in an Android browser, as the Polaris browser 
does not automatically launch other programs.  

To open a link located in the current paragraph in the default Android browser, 
press “Backspace-Enter-L”. The browser will launch, which will then, in turn, 
activate the associated Android program, provided that program is installed on 
your polaris. For example, if you want to launch a Zoom meeting, you need to 
install the Zoom application on your polaris from the Play Store. 

 

10.2.4 EDITING, SAVING, AND DELETING APPOINTMENTS 
To modify an existing appointment, move to the appointment and select "Modify 
Appointment" from the menu, or press "Enter-M" from the search results list. If 
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the appointment is a recurring schedule, a prompt, displaying "Recurrence 
appointment. Open type?" appears. Choose whether you want to modify the 
recurring appointment or the appointment for a specific day. If you select "This 
occurrence", your changes affect the appointment of the day, but the recurring 
appointments on other days are not changed. If you select "The series", your 
changes affect all the recurrences.  

The "Modify appointment" dialog contains the same controls as in the "Add 
appointment" dialog. The only difference is that each field has the value entered 
previously. If you have made changes you wish to save, tab to "Confirm" and 
press "Enter".  

To delete an appointment, move to the appointment in the search results list. 
Select "Delete Appointment" from the menu, or press "Space-D" from the search 
results list. If the selected appointment is a recurring appointment, you are 
prompted, "Recurring appointment. Delete type?" is displayed. You can choose 
whether you want to delete the recurring appointment, or just the appointment 
for that day. If you select "This occurrence", only the current appointment is 
deleted. If you select "The series", all recurrences of the appointment are 
deleted.  

To completely initialize the Schedule Manager, select "Delete All Appointments" 
from the menu, or press "Backspace-Enter-q" from anywhere in the Schedule 
Manager.  

You can also save selected appointments as a document. Select "Save 
Appointments as File" from the menu, or press "Enter-T" from the search results 
list. The Polaris asks you to specify the beginning and end dates of the 
appointments to be saved. After setting the beginning and end dates, press 
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"Enter", and you are prompted to enter the name and the format of the file to be 
saved. This dialog is the same as the "Save As" dialog in the "Word processor".  

 

10.2.5 BACKING UP AND RESTORING YOUR APPOINTMENTS 
If you perform a hard reset, or your battery dies, all of the data in the Schedule 
Manager is lost. Thus, it is very important to create a backup file each time you 
change your schedule. To backup your schedule, Select "Backup Appointments" 
from the menu, or press "Enter-U" to activate this function directly. 

If you already have a backup file, you are prompted, "Backup file already exists. 
Backup anyway? Yes". If you have made changes to your schedule, press 
"Enter" to create a new backup file. To keep the previous backup file, press 
"Enter" on no. If you make a backup file again in the Schedule Manager, a new 
backup file is created with the extension DAT, and another file is created with the 
extension BAK containing your previous backup file.  

To restore your schedule after a hard reset, Select "Restore Appointments" from 
the menu, or press "Enter-R" to activate this function directly. 

If you have an existing schedule, you are prompted, "Schedule file already 
exists. Which do you prefer? Append" or, press "Space-4" to move to 
"Overwrite". If you choose to append, and the backup file contains appointments 
that also exist in your current file, you will have redundant appointments. If you 
choose to overwrite and your current schedule contains appointments the 
backup file does not, these appointments are lost.  

You can back up the schedule automatically by activating the "Set Backup 
Options" function. Select "Set Backup Options" from the menu, or press "Enter-
E".  
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The "backup Options" dialog has three controls, "Backup mode" radio button, a 
"Confirm" button, and a "Cancel" button. To move between the radio buttons, 
press "Space and Backspace". 

The options are: "Always backup changes when exiting", "Manual backup", and 
"Prompt backup changes when exiting". 

If you select the "Always backup changes when exiting", a new backup file is 
created automatically if you have modified or added to your schedule.  

If you select the "Manual backup", a new backup file is not created, even if there 
are changes to your schedule. If you select this option, you can only create a 
new backup file by using the "Backup Schedule" function. 

If you select "Prompt backup changes when exiting", you are prompted, "Backup 
changes? Yes" if you have modified or added to your schedule. Press "Enter" on 
"Yes", and a new backup file is created before exiting the Schedule Manager.  

Choose your setting, and press "Enter". 

 

10.2.6 MULTIPLE ACCOUNTS AND SYNCING 
BrailleSense Polaris allows you to use multiple calendars, and automatically 
makes associations with any Google account connected to Polaris. To view 
available calendars, choose the “Calendar Settings” option from the Schedule 
Manager menu. 

By default, there is an account called “BrailleSense Polaris”. In addition, any 
Google account you have signed in to with Polaris is also available in this list. 

The dialog contains three settings: “calendar to add appointment”, “Calendar to 
print appointments”, and “Calendar Type”. This allows you to set appointments 
in multiple calendars, and view, add and output appointments from your chosen 
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calendars. This can be useful for creating separate calendars for work and 
personal use. 

Use the “Calendar Type” setting to determine whether the Calendar view shows 
the Solar Calendar, lunar Calendar, or both. By default, this is set to show the 
Solar calendar only. If both are shown, use “F3” and “Space-F3” to toggle the 
dates between lunar and Solar on the current day. 

In addition, you can synchronize these calendars with Google using the 
“Accounts” dialog of the Android Settings under All Apps. See section 10.1.9 for 
more information on syncing using the Android System Settings. 

You can also sync directly with the cloud from the polaris Schedule Manager, 
using the “Refresh” command in the menu, or by pressing “Backspace-R”. 

Note: as with the Address Manager, if too many items are changed, added or 
deleted, you may experience sync errors. If you receive a Sync Error 
notification, press Space-1-2-3-4-5-6 to open the Notification Shade, and press 
Enter on the Sync Error to see your options. 

 

10.2.7 SETTING ALARM OPTIONS 
You can open the "Set Alarm Options" dialog by pressing "Enter-O" or by 
pressing "Enter" on "Set Alarm Options" in the menu. Alarm option fields include 
"type of echo", "Alarm duration", "Alarm repeat interval" and "Repeat". You can 
move between these fields using "Space-1" or "Space-4".  

The "type of echo" option lets you set what type of alarm you would like to use 
to alert you to your appointment: Choose from several audio alarm types, 
including a media file, the FM Radio, or 1 of 3 alarm melodies. You can also 
choose a vibration, or both (All). Press "Space" to cycle among the options. 
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You can change the duration of the alarm sound. You can set this option to a 
value that is between 5 and 600 seconds. The default value is set to 30 
seconds.  

When the alarm goes off, if you do not stop it with "Backspace-Enter", the 
Polaris keeps giving you a notice about the appointment after a specified time 
interval. The "Alarm repeat interval" option allows you to change this interval. 
You can set the value anywhere from 1 to 60 minutes, the default value is set to 
5 minutes.  

The "Repeat" field allows you to decide how many times the alarm will sound. 
You can set the value from 1 time to 10 times; the default value is set to 3. To 
change the value, type a number between 1 and 10.  

Press "Enter" on the "Confirm" button to save your settings. Cancel saving the 
alarm options by pressing "Enter" on "Cancel" or pressing "Space-e". 

 

10.3 Database Manager 
The "Database Manager" is a program which can be used to create a database 
in the form that you specify. You can use the "Database Manager" to add records 
and search for data in your records.  

To launch the "Database Manager", navigate to it in the "Organizer" menu, and 
press "Enter". Or, launch the "Database Manager" from anywhere on the unit by 
pressing "F3-D".  

Database Terminology 

A table contains at least one record, and a record consists of at least one field. 
You can specify attributes for each of the fields. In other words, a record is made 
up of a group of one or more fields, and a table is made up of one or more records. 
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When the "Database Manager" is started, it checks whether or not a table has 
been created. If no table has been created, a "Table Manager" dialog appears to 
take you through the process of creating a new table. If there is at least one table 
created, the "Search Records" dialog appears and the "Search" edit box is 
focused, so that you can search for data. To close the program while adding or 
searching a table, press "Space-Z".  

The general navigation keys for the ""Database Manager"" are as follows. 
1. Moving among controls in a dialog. 

Move to the previous control: Shift-Tab (Space-1-2) or Space-F3 

Move to the next control: Tab (Space-4-5) or F3 
2. Moving in a list box 

Move to the previous list item: Space-1 or up scroll button 

Move to the next list item: Space-4 or down scroll button 
3. Changing the selection in a prompt box 

Select the next value: Space-4, Space or down scroll button 

Select the previous value: Space-1, Backspace or up scroll button 

Open the menu by pressing "Space-M" or F2. 

 

10.3.1 TABLE MANAGER 
Use the "Table Manager" dialog to create, delete, or modify a table. This dialog 
contains the following controls. 

1. Table name list: Displays the name of created tables, and their order in the 
list. 

2. Add table button: Use this option, to create a new table. 
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3. Modify table button: Use this option, to change the name of a table, or 
modify the structure of the table, by adding or deleting fields. 

4. Delete table button: Use this option, to delete the table that you have 
selected in the table name list. 

5. Set default table button: Use this option, to set the table that opens by 
default when you run the program. 

6. Close button: After closing the "Table Manager" dialog, BrailleSense  
returns you to your previous position in the program. When there is no table 
created, if you press "Enter" on the "Close" button, the "Database Manager" 
program is closed. 

 

10.3.1.1 Add Table 
The "Add Table" dialog contains "Table name" edit box, "created fields" list, "Add 
field" button, "Modify field" button, "Delete field" button, "Previous field" button, 
"Next field" button, "Confirm" button and "Cancel" button.  

Suppose you want to create a table called "address book" which contains 4 fields: 
name, telephone, address, and memo. Create this table as follows. 

1. In the "Table Manager" dialog, Tab to the "Add table" button, and press 
"Enter".  

2. The "Add Table" dialog appears, and the "Table name" edit box is focused. 
3. Type "address book".  
4. Tab to the "created fields" list. As you have not yet added fields, "no items" 

is displayed in the list. As you add fields to this table, they are added to this 
list box. 

5. Tab to the "Add field" button, and press "Enter".  
6. The "Add field" dialog is opened, and the "Field name" edit box is focused. 
7. Type "name" in the edit box as this is the field title. 
8. Tab to the "Field type" combo box. Choose "edit box" from the list as the 

name field is an edit box. 
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9. TAB to the "Set primary key" check box. To set the current field as the 
primary key, press "Space" to check it. 

10. Tab to the "Confirm" button, and press "Enter". Now, the "name" field 
has been added to the "address book" table. 

 

To cancel adding the field, Tab to the "Cancel" button, and press "Enter". If you 
have added a new field, you get a message saying that a new field has been 
added. The "created fields" list is shown again. Now, "name" field appears in the 
list, with the form, "name (edit box, pri) 1/1". Since only one primary key exists in 
a table, if you have set a field as the primary key, the "Set primary key" check box 
is not shown in the "Add field" dialog when you add another field.  

Add the "telephone", "address", and "memo" fields by repeating steps 5 through 
10 above. Note that you will likely want to set the "Field type" of the "telephone" 
field to "number", "address" to "edit box", and "memo" to "multi line edit box".  

To change the name of a created field, move to the field in the "created fields" list. 
Press “Enter-M” or Tab to "Modify field" and press "Enter". "Field name: (selected 
field name)" is displayed. Type the new name for the field and press "Enter". 
Though you can change the name of a field, it is not possible to change the 
properties of a field once it is created. 

To delete a created field, navigate to it in the list and press “Space-D” or Tab to 
"Delete field" and press "Enter".  

To change the placement of a field in your table, navigate to it in the list and press 
“Enter-P” or “Enter-N” for "Previous" or "Next" field. Or Tab to the "Previous field" 
or "Next field" button and press "Enter". 

Once you have added all of the fields you wish to add, Tab to the "Confirm" button 
of the "Add Table" dialog, and press "Enter". The "Add Table" dialog is closed, and 
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the "table name" list box is shown again. The newly created table is added to this 
list, and "address book 1/1" is shown in the list. To close the "Table Manager" 
dialog, press "Enter" on the "Close" button, Or press "Space-Z". The "Search 
Records" dialog is opened, and the "name" field, the first field of the "address 
book" table, is shown.  

 

10.3.1.2 Modify Table 
"Modify table" is used to modify the name or structure of a created table.  To 
modify a table, select "Table Manager" from the menu, or press "Enter-T". When 
the "Table Manager" dialog is opened, Move to the table that you want to modify, 
and press “Enter-M” or Tab to the "Modify table" button, and press "Enter".  

The "Modify Table" dialog is the same as the "Add Table" dialog. The only 
difference is that the "Table name" edit box, and "created fields" list contain the 
information already stored in the table. You cannot change the name of a table. 

To add additional fields, Tab to "Add field" and press "Enter". You can also delete 
fields, modify field names, and change the position of fields as previously 
described.  

 

10.3.1.3 Delete table 
Open the "Table Manager" from the menu, or press "Enter-T". Move to the table 
you want to delete, and press “Space-D” or Tab to the "Delete" button and press 
"Enter". You are prompted, "Delete table? Yes". To delete press "Enter". To 
cancel, press "Space" to select "No", and press "Enter". 
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10.3.1.4 Set Default Table 
When you set a table as the default table, each time the "Database Manager" is 
started, this table is displayed and you are placed in the search dialog. If you have 
created more than one table and you use one of them more frequently than the 
others, it may be convenient for you to set this table as the default table. If no 
table is set as the default table, the last table used is displayed when opening the 
"Database Manager".  

To set a table as the default table, open the "Table Manager, and the "table name" 
list is focused. Move to the name of the table you want to set as the default. Press 
“Enter-D” or Tab to the "Set default table" button and press "Enter". Or simply 
press "Enter" on the name of the table in the "table name" list. The BrailleSense 
announces that the table is set as the default table, and the "Table Manager" 
dialog is closed. 

 

10.3.2 ADD RECORD 
Use this option to add information to a table that you have created. When the 
"Database  Manager" is started, the "Search Records" dialog is opened. Select 
"Insert a New Record" from the menu, or press "Enter-I" from the Search dialog.  

Let's consider the "address book" table you created in the previous section. YOU 
can add records to this table using the method described below: 

1. Open the Insert A New Record" dialog as just described. 
2. The "name" field, the first field in the "address book" table, is shown. Type 

the name of the person for whom you want to create a record.  
3. TAB to the "telephone" field. Type the person's phone number. Since this 

field is a "number" field, a limited set of characters including numbers and 
hyphen is available. Enter a number without the number sign. If you press 
"Space" instead of "(hyphen), the hyphen is entered. 
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4. Tab to the "address" field. Type the address. 
5. Tab to the "memo" field. Since this field is a "multi edit box", you can type 

multiple lines of text.  
6. Tab to the "Confirm" button and press "Enter" to save the record. Press 

"Space-e" or press "Enter" on the "Cancel" button to cancel the record 
creation. 

The "name" field is focused again so you can add another record.  

To return to the "Search Records" dialog, press “F4". 

To access the Table Manager, press “Space-F3” from the search area to access 
the Table list, then press “Enter-T”.  

 

10.3.3 SEARCH RECORDS 
To search for information in your records, use the "Search Records" dialog. When 
you Tab forward on a table in the list, The "Search Records" dialog is opened, and 
the first field of the table is focused. Type the text that you want to search for and 
press "Enter". If you press "Enter" without typing text, all the records in the 
database are displayed.   

Using the Address Book example, the focused field is the "name" field. Thus, type 
a person's name in the edit box to look up "/her  record and press “Enter”.  

The "List of records that matched your search, is opened. In the "List of Records 
Found", each record is shown in the following form. "(the name of the first field) : 
(other information in the record) xx/yy". "yy" is the total number of records found, 
and "xx" is the order of the current record in the list. If no record is found, you are 
informed, "No records found", and the current field is shown again, so you can 
type another search queery. Navigate records as follows. 

Move to the next record: Space-4 or down scroll button 
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Move to the previous record: Space-1 or up scroll button 

Move to the last record: Space-4-5-6 

Move to previous same field different record: Space-3 

Move to next same field different record: Space-6 

Move to the first record: Space-1-2-3 

Move to the next field: Space-5 

Move to the previous field: Space-2 

Move to the last field: Space-4-6 

Move to the first field: Space-1-3 

 

To delete a record, move to the record, and press "Space-D". You are asked if 
you really want to delete the record. Select "Yes" or "No" by pressing "Space" or 
"Backspace". If you press "Enter" after selecting "Yes", the record is deleted, and 
if you select "No", the deletion is canceled.  

To change the content of a record, move to the record, and press "Enter-M" from 
any field in the record. A dialog similar to the "Insert a New Record" dialog is 
opened. To change the content of a field, Tab to the field, and type the new 
content.  To save the modifications, press "Enter" after typing new content for all 
the fields you want to change. Or Tab to the "Confirm" button and press "Enter".  

 

10.3.4 SETTING BACKUP OPTIONS 
You can backup your database file, manually using the "Backup Database" 
function. You may also backup your database file automatically by using the "Set 
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Backup Options". Select "Set Backup Options", or press "Enter". Or, press "Enter-
E" to activate this function directly.  

The "Backup Options" dialog has three controls: "Backup mode" radio button, a 
"Confirm" button, and a "Cancel" button. There are 3 Backup modes: "Manual 
backup", "Always backup changes when exiting", and "prompt to backup changes 
when exiting". Use "Space" and Backspace" to cycle through the settings. Press 
"Enter" to save the option.  

1.  If you select the "Manual backup", it does not create a new backup file 
even if there are changes in the database. In this case, you can only create 
a new backup file by using the "Backup Database" menu. 

2.  If you select the "Always backup changes when exiting", a new backup file 
is automatically created on exit if you modify or add to the database.  

3.  If you select the "Prompt to backup changes when exiting", if you have 
modified or added to the database, you are prompted, "Backup changes? 
Yes" when you exit the "Database Manager". If you press "Enter" on "Yes", 
it automatically creates a new backup file and exits the "Database 
Manager". If you press "Space-4" once and press "Enter" on "No", it exits 
without creating a new backup file. 

 

10.3.5 BACKUP DATABASE 
If a hard reset is performed, or if your battery dies, all of the data in the "Database 
Manager" is lost. Thus, it is very important that you create a backup file every time 
you make a change to the Database file. Select "Backup Database" from the 
menu, or, press "Enter-U" to activate this function directly. 

If you already have a backup file, you are prompted, "Backup changes? Yes". 
Press "Enter" to create a new backup file. To keep the previous backup file, 
navigate to "No", and press "Enter". When you create a backup file in your 
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"Database Manager", a file called "BrailleSense_Database_bak.db" is saved in 
the “Database” folder of the flashdisk. 

 

10.3.6 RESTORE DATABASE 
To restore the database file after a hard reset, Select "Restore Database" from 
the menu, or press "Enter-O" to activate this function directly. 

If you already have a database file, you are prompted, "Database file already 
exists. Restore? Yes". Press "Enter" to continue with the restore.   To cancel, 
navigate to "No" and press "Enter".  

 
10.3.7 IMPORTING AND EXPORTING CSV 
"CSV" is the acronym for Comma Separated Value. A CSV file is used for the 
digital storage of data structured in a table form, with the information in the various 
columns separated using commas. The "Database Manager" can import a CSV 
file created using Excel or other programs and can also output data to a CSV file. 

 

10.3.7.1 Import from CSV 
You can only execute this function, when you are in "Add mode", or rather, when 
you are in the process of adding records. 

To import the data from a CSV file in to an existing database, select "Import from 
CSV" from the menu, or press "Backspace-I" from anywhere in the Database 
Manager. The "Import from CSV" dialog has the following controls: 

1) "File name" edit combo box 
2) "Confirm" Button 
3) "Cancel" Button 
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4) "Path search" list 

Type the name of the file you want to import in the edit box. To browse for a file, 
"Shift-Tab to the path search list, and use normal file navigation commands to 
choose your file and press "Enter".  

To cancel the import, Tab to "Cancel" and press "Enter", or press "Space-E" or 
"Space-Z".  

 

10.3.7.2 Adding the data from the CSV file to the "Database Manager" 
When the CSV file is imported, "First field: unused 1/xx" is displayed. You can 
choose whether the data from the CSV file for each field should be imported. 
Some CSV files may contain data that is not equivalent to any of the fields in the 
existing database, or you may simply not wish to import certain pieces of 
information.    

You are presented with a dialog that contains all the fields in the database into 
which you are importing, a check box for allowing fields in the first record, and 
"Confirm" and "Cancel" buttons. Tab and Shift-Tab among these items.   For each 
database field, there is a list box containing "Unused" and all of the fields of the 
CSV file being imported. This allows you to choose which field of the CSV file 
should be imported into each field of the current database. Use "Space-1" and 
"Space-4" to move among the fields. If there is no equivalent field in the CSV file 
for a given field in the current database, select "unused".    

Often, the first set of fields in a CSV file represent field titles rather than actual 
data. For this reason, there is a check box for allowing fields in the first record to 
be imported or not. If the first set of fields does contain title data, make sure that 
the "allow fields in first record" item is not checked.  
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To complete the import, Tab to "Confirm" and press "Enter" to import the data. If 
you search for records in the current database, the data from your CSV file should 
now appear in your results. 

 

10.3.7.3 Exporting CSV 
You can export the data from the "Database Manager" as a CSV file, using this 
function.  

 Note: You must be in a list of found records to export to CSV. 

Select "Export to CSV" from the menu, or press "Backspace-X". The "Export to 
CSV" dialog contains the following controls:  

1) "File name" edit combo box 
2) "Confirm" Button 
3) "Cancel" Button 
4) "File storage" list 

Type a file name for the exported data and press "Enter". To cancel this function, 
press "Space-Z".  

To change the location where the file is stored, Shift-Tab to the file list and use 
normal file and folder navigation to select the location.  

 

10.3.8 CREATING A TABLE FROM CSV 
In addition to importing CSV data into existing tables, you can create a table from 
a CSV file. You can activate this function from anywhere in the "Database 
Manager".  

Select "Create Table from CSV" from the menu, or press "Enter-X". 
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You are prompted for the file name of the CSV you wish to use to create the table. 
Type it in the edit box, or "Shift-Tab" to the File List and use normal file navigation 
commands to select the file and press "Enter". 

Braille Sense announces, "File successfully loaded" and displays the "Table 
creation" dialog. This dialog consists of a "Table name" edit box" followed by 
combo boxes for each of the fields in the CSV file, "Allow fields in first record" 
check box, a "Confirm" button, and a "Cancel" button.  

Type your desired name for the table in the edit box. Tab to the first field in the 
CSV file, and use "Space-1" and "Space-4 to move among your options for 
defining this field.  

 Note: field titles  are determined by information from the first line of the CSV 
file. Be sure the first line contains field information for correct and sensible 
importing of the data. 

The options in the field definition combo box are: "Unused", "Edit Box", "Number", 
"Computer Edit Box", "Multi-Line Edit Box", "Date", "Time" and "Check Box". If 
you do not wish to import the information in the current field as part of the data 
set, choose the "Unused" item. If you wish to import the information, navigate to 
the type of form control most appropriate for the information in that field. For 
example, if the field contains a serial number or phone number, choose "Number". 
If the field contains e-mail addresses or web addresses, choose "Computer Edit 
Box". Tab to each of the fields in your CSV file and repeat this process. 

When you finished defining the characteristics of the fields, Tab to the "Allow fields 
in first record" and press "Space" to toggle the check box to your desired setting. 
Because the first line of a CSV file often contains field titles rather than actual 
data, this option is unchecked by default. 
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When you have finished defining how your table should be created, Tab to the 
"Confirm" button and press "Enter". If you wish to cancel the table creation, "Press 
"Enter" on the "Cancel" button. 

 

11. Web Tools 
The "Web Tools" menu consists of programs used to assist in the searching and 
downloading of web content. Currently, this menu contains only the Web 
Browser.  

 

11.1 Web browser 
You can use the "Web Browser" to read pages on the web, as well as to read 
html documents you have saved to disk. You can also download files and 
stream audio content.  

To launch the "Web Browser, from the "Web Tools" menu, navigate to "Web 
Browser" and press "Enter". Or, press B. You can launch the "Web Browser" 
from anywhere on the unit by pressing "F1-B". The Polaris opens the "Web 
Browser" and connects to the "home page".  

You can also launch the Web Browser" by using the global hot key for opening a 
web page: Press "Space-W" from anywhere on the unit. The Polaris, opens up a 
computer edit box into which you can type in the URL you want to go to and 
press "Enter". The Browser is launched, and takes you to the web page you 
requested. 

You can access the Web Browser's functions using hot keys, or via its menus. 
To access these menus, press "Space-M" or "F2". Select a menu item using 
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"Space-1" or "Space-4", and press "Enter". Or, you can press "Space-M or "F2" 
followed by the shortcut for the corresponding menu item. Use "Space-1" and 
"Space-4" or the Up and Down scroll keys to navigate menus, settings or file 
lists. Use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab among 
controls in a dialog. For the purposes of these instructions, we will generally 
refer to using "F3" and "Space-F3" or simply "Tab". Press "Enter" to execute an 
item. 

 

11.1.1 THE FILE MENU 
1) Open URL: (U) "Enter-U". Type the web address of the page you wish to go 
to and press "Enter". 

2) Open: (O) "Enter-O". Open an HTML file or URL stored on your Polaris. 

3) Save As: (S) "Space-S". Save the current webpage to your Polaris. 

4) Copy URL: (D) "Backspace-D". Copy the URL of the current page to the 
clipboard. 

5) Copy Link: (C) "Backspace-L". Copy the address of the focused link to the 
clipboard. 

6) Page Information: (I) "Enter-I". Opens a dialog of general information about 
the current webpage. 

7) File Download Dialog: (L) “Backspace-3-4”. Opens a dialog to show current 
download progress as well as file download history. 

8) Exit: (Z) "Space-Z". Closes the Web Browser. 
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11.1.2 THE EDIT MENU 
1) Start Selection: (B) "Enter-B". Begin selecting a block of text. The end of the 
selection is determined by your cursor position. 

2) Copy: (C) "Enter-C". Copy selected text to the clipboard. 

3) Add to clipboard: (P) "Enter-P". Append selected text to the clipboard. 

4) Select All: (A) "Enter-A". Select all the text on the current page. 

 

11.1.3 THE GO TO MENU 
1) Go To Home page: (S) "Backspace-H". Return to your home page. 

2) Go To Previous Page: (P) "Backspace-P". Go to the page you were viewing 
before the current one. 

3) Go To Next Page: (N) "Backspace-N". Move forward one page in your 
viewing history. 

4) Go To Previous Heading: (U) "Backspace-B". Move back one heading. 

5) Go To Next Heading: (D) "Backspace-F". Move forward one heading. 

6) Go to Previous Text: (B) "Dots-2-4-6". Go to the block of text before your 
current position. 

7) Go To Next Text: (P) "Dots-1-2-4-5-6". Go to the next block of text below your 
current position. 

8) Refresh: (R) "Enter-R". Reload the current page. 

9) History: (H) "Enter-H". Open a list of pages you have recently viewed. Press 
“Space-D to delete the current item, or use the Clear All button to clear the 
entire history. 
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10) Find: (F) "Space-F". Find text on the current page. 

11) Find Again: (E) "Enter-F". Search for the next instance of the text string you 
entered in the "Find" dialog. 

12) Links List: (I) "Backspace-I". Displays all the links on a page in a list view. 

13) RSS Feed list: (J) "Enter-J". Displays any RSS feeds on the current page.  

*Note: you can also navigate headings by level using the Control and Alt keys with 
dot numbers. For example, to move forward by heading level 2, type Alt with dot-
2. To move back by heading level 4, type Control with dot-4. 

 

11.1.4 THE READ MENU 
1) Read from Beginning to Cursor: (T) "Backspace-G". Reads the text from the 
top of the page to your current position. 

2) Read from Cursor to End: (G) "Enter-G". Reads the text from your current 
position to the bottom of the page. 

3) AutoScroll: (A) "Up and Down Scroll". STARTS and stops the auto scroll 
function.  

 

11.1.5 THE FAVORITES MENU 
1) Set Current as Home Page: (S) "Enter-S". Set the current page as your home 
page. 

2) Add to Favorites: (A) "Backspace-A". SAVE the current page as a favorite. 

3) Favorites List: (L) "Enter-L". Open the list of favorites you have saved 
previously. 



 
 

 211  

  

 

 

11.1.6 OPTIONS 
Use the "Options" dialog to manage Web browser preferences. Navigate the 
settings with "F3" and "Space-F3". 

 1) User Agent: use "Space" to choose between Mobile and desktop. 

2) Show visited links: Use "Space" to choose On or Off. 

3) Show images: Use “Space” to choose On or Off. 

4) Show cell information: (in tables) Use “Space” to choose On or Off. 

5) Default Download Folder: Press Enter to open folder list and choose desired 
download folder. 

6) Clear Cookies: press "Enter" to clear all cookies. 

 

11.1.7 NAVIGATING PAGE ELEMENTS 
On a web page, there are links, controls, and other various elements, as well as 
text. To read web pages properly, the "Web Browser" should classify each 
element, and notify the user with its information. 

When reading a web page by moving with "Space-4" or "Space-1", one element 
is displayed on one line. The links and controls are displayed with their 
respective symbols so the user can distinguish each element. To move among 
controls without viewing the text between them, use "F3" and "Space-F3". 

A control is a link, an edit box, a radio button, or a combo box. Each control has 
different purposes. Therefore, the user has to know exactly what type of control 
is being used.  
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When you find controls in web pages, the Polaris displays control symbols 
ahead of the contents of the control. The following is a list of control symbols. 

Control name 

Symbol 

Link 

LN 

Visited link 

LNV 

Anchor 

ANC 

Edit box 

EB 

Multi edit box 

MEB 

List Box 

LB 

Combo box 

CB 

Radio button select 

SRB 

Radio button unselect 

URB 
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Check box check 

SCHB 

Check box uncheck 

UCHB 

Button 

BT 

To change a selection in the combo box, press "Backspace-Space-4" or 
"Backspace-Space-1". You can move to the next item by pressing "Space-4". 
The page is renewed automatically when you change a selection in a combo 
box. 

To select or unselect a checkbox or radio button, press "Space". 

You can move to the previous form field: with Space-1-2-3-4-6, and to the next 
form field: with Space-1-3-4-5-6. 

Move to the previous frame with Space-3-4-6, and to the next frame with Space-
1-4-6. 

 

11.1.8 TABLE NAVIGATION 
At the beginning position of the table, the Polaris shows the table number, and 
the number of rows and columns on the table. 

For example, there are two large tables (we call these "upper level tables") on 
one web page. Each table has 3 sub tables (we call these "lower level tables") 
with 3 rows and 2 columns on each. In this case, when the Polaris shows the 
first sub table on the second large table, it displays "table 2-1 3 rows, 2 
columns". At the end of the sub table, the Polaris displays "table 2-1". 
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If the table consists of only 1 row and 1 column, or empty space that has only 
border or background, such tables are not considered tables in the Polaris. 

The Polaris provides a way to move table by table, and cell by cell, in order for 
the user to comprehend the structure of the table. To move cell by cell, the cell 
position and contents of the cell are displayed. However, the position information 
is only announced with speech. 

For example, if you have move to a cell that is positioned on the second row and 
third column, and the content of the cell is "news", the Polaris announces, "row 2 
cell 3 news". In this case, "row 2 cell 3" is announced with speech only, while 
"news" is displayed in Braille. 

If a table is included in the cell, the Polaris announces "table cell". If there is not 
a table in the cell, you hear "empty cell". 

In the "table cell", To move to any cell within the lower level table, press "Space-
4" to move to the beginning line of the lower level table.  

Moving by cell is only valid in the table. If this command is executed outside of 
the table, a warning sound is played. 

1. Move to the previous table: Space-3-4-5-6 

2. Move to the next table: Space-1-4-5-6 

3. Move to the previous cell: Space-2-3 

4. Move to next cell: Space-5-6 

5. Move to upper cell: Space-3-5 

6. Move to lower cell: Space-2-6 

7. Read current cell: Space-2-3-5-6 

8. Move to the previous cell in the upper level table: Backspace-2-3 
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9. Move to the next cell of the upper level table: Backspace-5-6 

10. Move to the upper cell of the upper level table: Backspace-3-5 

11. Move to the lower cell of the upper level table: Backspace-2-6 

12. Check the current position: Space-1-5-6 

 

11.1.9 PLAYBACK OF STREAMING AUDIO FILES 
While navigating a web page, if you come across a link for a streaming audio 
file, you can simply press "Enter" on it. The Media player program is launched 
with lists of address inside of the streaming file, and the streaming audio file on 
the first address is played. The supported streaming file formats are "m3u", 
"pls", "asf", "asx". 

For other formats, if you press "Enter" the "Web Browser" program plays the 
streaming audio file directly. When you play the streaming audio file in the "Web 
Browser", the "Add To Favorites" dialog appears. You can add the streaming 
address to the "Favorites list" and the streaming file is saved with "ASF-WAS" at 
the beginning of the file name. "ASF" denotes that the link is a streaming audio 
file. 

While you play a streaming audio file in the "Web Browser", if you exit the "Web 
Browser" program or you lose the internet connection, the streaming audio file 
stops playing. 

You can use the following playback commands in the "Web Browser" while 
playing a streaming audio file. 

1. Play: "play" button on the front panel 

2. Stop: "stop" button on the front panel 
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3. Turn up the volume: Space-up scroll button 

4. Turn down the volume: Space-down scroll button 

Playback of a streaming audio file does not stop if you switch to another 
program, unless you press the "stop" button on the front panel after returning to 
the "Web Browser".  

 Note: Real Audio files are not supported in the "Web Browser". 

 

11.2 Google Search 
The Google Search program allows you to easily perform a search using 
Google's Internet search service. To Open Google Search, from the "Web Tools" 
menu, move to "Google Search" and press "Enter", or press G". You can launch 
Google Search from anywhere on the unit by pressing "F1-U".  

  

11.2.1 THE SEARCH DIALOG 
The "Search" dialog contains 3 items: a "Search Term" edit box, a "Search" 
button, and a "Close" button. To move through the items in the dialog, press 
"Tab (F3) or "Shift-Tab (Space-F3).  

When the Google Search application is launched, you are placed in the "Search 
Term" edit box. Type the term you wish to search for, and press "Enter" to 
launch the search; or Tab to the "Search" button and press "Enter".  

To exit the program, Tab to the "Close" button and press "Enter", or press 
"Space-Z".  
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11.2.2 THE RESULTS DIALOG 
After a search is performed, you are placed in the "Results" dialog. The 
"Results" dialog contains 5 items: the "Search Term" edit box, the "Title" list, the 
"Contents" text box, a "Search" button, and a "close" button. When the Braille 
Sense has finished searching the term you entered, you are placed in the "Title" 
list.  

The "Title" is the name of the web result that matches your search term. The 
"Title" list can contain up to 64 items. To go to the current search result on the 
web, simply press "Enter" and the webpage for the current title is opened in your 
chosen Browser. When you have finished viewing the webpage, press "Space-
Z" to close the Browser, and return to your results list in the Google Search 
program. By default, Google search uses the BrailleSense Browser when you 
press “Enter” on an item. You can open the current item in your default Android 
browser, by pressing “Backspace-L”.  

The "Contents" text box contains information about the current title, just as you 
would receive if you were performing a search on the Google website. This 
information usually includes a quick preview of the content on the web page, 
and the URL of the web result.  

Use the "Search term" edit box, and "Search" button to launch a new search as 
described in the previous section. 

 

11.2.3 CHOOSING YOUR BROWSER 
When the Google search program is opened, press F2 to open the menu. It 
contains only “Settings”, and “Exit”. 
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Press Enter on “Settings” to choose which browser to use when opening Google 
results. By default, Google search uses the native Polaris Web browser. 
However, you may also choose to use the “Default Browser”, which will open 
results in the default Android browser as set in the Android System Settings. 

Use “Space-1” and “Space-4” to move between the browser options, and press 
“Enter” to save your choice. 

 

 

12. EXTRAS 
 

12.1 Excel Viewer 
The "Excel Viewer" allows you to read and navigate XLS and XLSX files by cell, 
column, row, group, worksheet, etc. To open the "Excel Viewer", from the Main 
menu, press X to open the "Extras" menu, then press X again to open the "Excel 
Viewer". You can launch the "Excel Viewer" from anywhere on the unit by 
pressing "F1-X".  

When the "Excel Viewer" is launched, you are placed in an "Open File" dialog. 
Use normal "File List" navigation commands to locate the XLS or XLSX file you 
wish to open, and press "Enter". When the file is loaded, you are placed at the 
top of the first worksheet. Cells are displayed with the coordinates followed by 
the text of the cell. For example, the first cell in a column containing the date 
might appear as "a1 Date".  
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12.1.1 GENERAL NAVIGATION 
Use the following commands to navigate an Excel file in the "Excel Viewer".  

Move to next row: Space-Dot-4  

Move to previous row: Space-Dot-1  

Move to next column: Space-Dot-6  

Move to previous column: Space-Dot-3  

Move to beginning of row: Space-Dots-1-3  

Move to end of row: Space-Dots-4-6  

Move to top of column: Backspace-Dot-2  

Move to bottom of column: Backspace-Dot-5  

Move to top of worksheet: Space1-2-3  

Move to bottom of worksheet: Space-4-5-6  

Move to next worksheet: Space-3-4-5  

Move to previous worksheet: Space-1-2-6  

Move to next group: Backspace-Dot-5-6  

Move to previous group: Backspace-Dot-2-3  

Move to next group in row: Space-Dot-5  

Move to previous group in row: Space-Dot-2  

Move to next group in column: Space-Dot-5-6  

Move to previous group in column: Space-Dot-2-3  

You can access functions of the Excel Viewer using hot keys, or via its menus. 
To access these menus, press "Space-M" or "F2". Select a menu item using 
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"Space-1" or "Space-4", and press "Enter". Or, you can press "Space-M or "F2" 
followed by the shortcut for the corresponding menu item.  

The Excel Viewer also utilizes lists and dialogs. Use "Space-4-5" and "Space-1-
2" or "F3" and "Space-F3" to tab and shift-tab among controls in a dialog. For 
the purposes of these instructions, we will generally refer to this as "Tabbing".  

Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate 
menus, settings or file lists. Press "Enter" to execute an item. 

 

12.1.2 THE FILE MENU 
1) Open: (O) "Enter-O". Open Excel Viewer compatible files. 

2) Open Hyperlink: (H) "Enter-H". Open a link contained in an Excel file in the 
Web Browser. 

3) Set User Table: (T) "Enter-T". Set the parameters for columns and rows in 
order to get accurate information for headers and rows of sub tables. 

4) Cell Properties: (I) "Enter-I". View format information for the cell.  

5) Quick Setup: (Q) "Enter-X". Operates similar to the "Set User Table" function, 
except instead of defining the boundaries manually, the beginning cell is 
automatically set as the cell at your current cursor position, and the end cell is 
automatically set as the last cell containing data. 

6) Save As: (S) "Space-S". Lets you save an Excel file as a CSV or TXT 
separated by tabs or commas. 

7) Exit: (Z) "Space-Z". Close the Excel Viewer. 
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12.1.3 THE EDIT MENU 
1) Start Selection: (B) "Enter-B". Begin selection of a text block. The end of the 
selection is determined by your current cursor position. 

2) Select All: (A) "Enter-A". Select all the data on the current sheet. 

3) Copy: (C) "Enter-C". Copy the selected text to the clipboard. 

 

12.1.4 THE GO TO MENU 
1) Find: (F) "Space-F". Search for text on the current sheet. 

2) Jump to Cell: (G) "Space-J". Move to a cell using its coordinates. 

3) Next Sheet: (N) "Space-Dots-3-4-5". Move to the next sheet in the workbook. 

4) Previous Sheet: (P) "Space-Dots-1-2-6". Move to the previous sheet in the 
workbook. 

5) Sheet List: (L) "Enter-L". Bring up a list of all the sheets in the workbook. 

6) Set Mark: (M) "Backspace-M". Bookmark your current position. 

7) Jump to Mark: (J) "Backspace-J". Move to a previously marked position. 

8) Delete Mark: (D) "Backspace-D". Delete a previously set mark. 

9) Move to Previous Group: (R) "Space-dots-2-3". Move to previous data filled 
area. 

10) Move to Next Group: (E) "Space-dots-5-6". Move to next data filled area. 

 

12.1.5 THE READ MENU 
1) Sheet Title: (T) "Space-Dots-1-5-6". Read the name of the current sheet. 
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2) Read from Beginning of Row to cursor: (P) "Backspace-Dot-3". Read from the 
left most cell to the current position. 

3) Read from cursor to end of Row: (N) "Backspace-Dot-6". Read from your 
current position to the right-most cell. 

4) Read from Top of Column to Cursor: (U) "Backspace-Dot-1". Read from the 
top of the column to the current cursor position. 

5) Read from Cursor to Bottom of Column: (D) "Backspace-dot-4". Read from 
your current position to the bottom of the column. 

6) Read Current Row: (C) "Space-dots-1-4". Read all cells in the current row 
from left to right. 

7) Read Current Column: (R) "Space-Y". Read all cells in the current column 
from top to bottom. 

8) Read Header Cell of Row: (Y) "Backspace-Y". Read the title of the current 
row. 

9) Read Header cell of Column: (X) "Backspace-C". Read the title cell of the 
current column. 

10) Read File Name: (F) "Space-dots-3-4". Read the name of the workbook. 

 

12.1.6 THE VIEW MENU 
1) Set Time and Date: (D) "Enter-D". Determine how time and date are 
displayed. 

2) Show Hide Hidden sheets: (S) "Enter-S". Toggle whether hidden sheets are 
viewable. 
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3) Show Hide Hidden Rows: (R) "Enter-R". Toggle whether hidden rows are 
viewable. 

4) Show Hide hidden Columns: (Y) "Enter-N". Toggle whether hidden columns 
are viewable. 

5) Cell Activation: (A) "Enter". Opens the cell as a static box so you can review 
or select text. 

 

12.2 Online DAISY 
The Online DAISY program allows patrons of the Canadian National Institute for 
the Blind and Vision Australia libraries to access and download DAISY books 
available through their online bookshelf.  

To execute the Online DAISY program, Open the "Extras" menu, navigate to 
"Online DAISY" and press "Enter".  

When you execute the Online DAISY program for the first time, you are asked 
for your login information. Use "Space-1" and "Space-4" to navigate to the 
server you wish to log in to. Once done, Tab to the ID field and enter it in 
computer Braille. If accessing the CNIB library, type "CNIB_" followed by your 
user number in the ID field. For Vision Australia, type just your user ID number. 
Tab to the "Password" field and type it in computer Braille. Press "Space" to 
toggle the check boxes for "Remember Me", and "Save password". When you 
have chosen your login settings, Tab to "Login" and press "Enter". 

You are presented with a combo box with 3 items: "Expired", "New", and 
"Issued". Press "Tab (F3 or Space-4-5)" to access the list in your desired 
category. You can navigate the book list using "Space-1" and "Space-4". 
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To download a book, navigate to it and press "Enter". The unit announces 
"Download start" and shows progress indicators to let you know the progress of 
the download process. When the book is finished downloading, you may play it 
using the DAISY Player.  

Books downloaded using the Online DAISY program are available in the "Online 
DAISY" folder from the "Open DAISY" dialog of the DAISY Player. For reasons 
of copy protection, these books are only visible from the DAISY Player and 
cannot be accessed from the File Manager. 

Vision Australia users can also download BRF books. When a BRF book is 
downloaded, you have the option of opening it in the Word Processor, from 
which you can copy the text to another document, or save it to a different 
location where it can be more easily accessed. 

When you wish to return a book, navigate to it in the list, and press "Enter-R" 
This returns the book to the virtual library so that others can be issued to you. 

 

12.3 Sense Dictionary 
The Sense Dictionary is an add-on piece of software for the Sense notetakers 
available for purchase from HIMS. The basic package includes an English 
dictionary and Thesaurus, and one foreign language dictionary. Available 
dictionaries are as follows: 

US English Dictionary: Webster's New World College Dictionary 

US English Thesaurus: Collins Thesaurus A-Z 3rd 

UK English Dictionary: Collins Comprehensive English Dictionary 
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Spanish/English Dictionary: Collins Spanish Dictionary – Complete and 
Unabridged 

Italian/English Dictionary: Collins Italian Dictionary  

French/English Dictionary: Collins English French Electronic Dictionary 

 Note: If you have not purchased the dictionary package containing the 
dictionary data and license key, pressing "Enter" on the Sense Dictionary 
option in the "Extras" menu results in the message, "Authentication 
failed". For pricing and purchasing information, please contact HIMS or 
your BrailleSense dealer.  

 

 

13. Utilities 
The "Utilities" menu provides several special functions and settings for the 
Polaris. Move among the items in the "Utilities" menu using "Space-1" and 
"Space-4" and press "Enter" to open an item.  

You can access functions for each program using hot keys, or via that program's 
menus or dialogs. If a program has menus, press "Space-M" or "F2" to open the 
menu. Select a menu item using "Space-1" or "Space-4", and press "Enter". Or, 
you can press "Space-M or "F2" followed by the shortcut for the corresponding 
menu item.  

In dialogs, use "Space-4-5" and "Space-1-2" or "F3" and "Space-F3" to tab and 
shift-tab among controls. For the purposes of these instructions, we will 
generally refer to this as "Tabbing".  
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Use "Space-1" and "Space-4" or the Up and Down scroll keys to navigate 
menus, settings or file lists. Press "Enter" to execute an item. 

 

13.1 Calculator 
Using the calculator on the Polaris, you can do simple math equations as well as 
complex scientific calculations. The results and expressions are displayed in 
Braille, and spoken by the Polaris.  

To use the calculator, press C from within the "Utilities" menu. You can launch 
the "Calculator" from anywhere on the unit by pressing "F3-C". When the 
calculator is opened, 0 is displayed in computer Braille. 

You may type using computer Braille, UEB, or Nemeth Braille when inserting 
expressions. Press "Backspace-G" to cycle the Braille codes. Clear the 
calculator with "Backspace-C". If you insert numbers or a function into a result, 
the result disappears; and if you enter operators, you move to the next step. In 
addition, you can keep your result in the calculator's memory, and recall it later. 
You can activate the functions and operators via the calculator menu or you can 
use the hot keys associated with the various functions.  

 

13.1.1 GENERAL FUNCTIONS 
To access general mathematical operations, open the menu by pressing 
"Space-m or "F2" and press "Enter" on "General Functions". From the 
calculation line, access the "General Functions" by pressing "Enter-G".  

"General functions" is a dialog box that contains the "general function list", a 
"Confirm" button, and a "Cancel" button. You can navigate the operators using 
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"Space-1" or "Space-4". Or, you can press the first letter of the operator you 
want to access.  

Select your desired operation and press "Enter" to perform it. You can also use 
hot keys to quickly execute operations. Press "Space-H" for a list of hot keys in 
the Calculator.  

To enter negative numbers type minus (dots 3-6) and the number in 
parentheses. For the percent operation, type the numbers first followed by the 
percent sign. Immediately after you type the percent sign (%), the number you 
have typed in is converted into a percent value.  

 

13.1.2 FRACTIONAL ARITHMETIC 
The Polaris can perform fractional operations such as simplifying and multiplying 
fractions as well as converting fractions to decimals.  

You can also convert fractions to decimals, decimals to fractions, improper 
fractions to mixed numbers, or mixed numbers to improper fractions. When your 
result is fractional, you can bring up the "fraction options" by pressing "Space-3-
4". Press "Space-1" and "Space-4" to move among the available options. If the 
fraction is a simple fraction, your options are ""fraction to decimal" and "return 
original fraction". If the fraction is an improper fraction, you also have an option 
to return "improper fraction to mixed number". If your fraction is a mixed number, 
the "mixed number to improper fraction" appears. Finally, if your result is a 
decimal and you press "Space-3-4", the decimal is converted to a fraction.  
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13.1.3 MEMORY FUNCTIONS 
The "Memory Functions" act on stored answers and calculations in memory. To 
access these functions, press "F2" to open the menu, and press "Enter" on 
"Memory Functions".  

"Recall Items" is a dialog, containing "Variable list", "Delete", "Display detail", 
"Confirm", and "Cancel". You can access the dialog by pressing "Backspace-R" 
in the calculation line or by selecting it from the "Memory Functions" menu...  

The "Variable list" displays "item name: value". Insert the value into your 
calculation by pressing "Enter" on the item name. You can also copy items in the 
"Variable list". Press "Space" to select an item in the "Variable list". Then, press 
"Enter-I" to copy the selected items to the clipboard.  

The "Display detail" shows the item name and its result with the default set to 
"No". To review the detailed information, press "Space" to switch to "Yes". Then, 
it displays "item name: the expression = its result value" in Braille.  

"Delete" is used to remove a variable item from the list.  

You can delete all of the saved items stored in the "Recall Items". Select "Delete 
All Saved Items" from the "Memory Functions" menu, or press "Enter-D" from 
the calculation line. 

"Save Items" is a dialog that allows you to define variables according to the 
current expression or result in the calculator and save them for future use. The 
dialog contains an edit box for typing in the variable name, a "Confirm" button 
and a "Cancel" button. SELECT "Save Items" from the "Memory Functions" 
menu, or press "Backspace-S" from the calculation line.  

When the dialog is opened, the "item name" edit box is focused. Type a name 
for the variable, and press "Enter" or move to "confirm", and press "Enter". The 
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current expression or result is then saved under the variable name you just 
specified. 

If you type names under variables which have already been created, you are 
prompted, "Replace variable xx with current value? Yes". If you type function 
names like "sin", "cos", or "pi" as a variable name, you are warned, "Invalid item 
name", as you cannot use these functions in variable names.  

You can also define variables directly from the calculation line by typing 
"variable=expression" and press "Enter" to save the variable.  

 

If you select the Statistics function, a dialog opens, which consists of a list box 
containing all the stored variables and their values, a list box displaying the 
results of several functions, and a "Close" button. Press "Backspace-T" to 
activate this function from the calculation line,  

Press "Space" to select each variable in the list that you want included in the 
data set for which the statistics are calculated. TAB to the "result" list to view the 
sum, average, variance, and standard deviation of the selected variables. You 
can also select items from the result list and copy them to the clipboard.  

 

13.1.4 SINE FUNCTIONS 
Select "Sine Functions" in the Calculator's menu, or press "Enter-S" in the 
calculation line. The "sine function" list consists of "Sine", "Arc sine", and 
"Hyperbolic sine". If you press "Enter" on one of the three functions you can 
insert it into your calculation.  
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13.1.5 COSINE FUNCTIONS 
Select "Cosine Functions" from the Calculator's menu, or press "Enter-I" from 
the calculation line. The "cosine function" list consists of "Cosine", "Arc cosine", 
and "Hyperbolic cosine". If you press "Enter" on one of the three functions, the 
calculation is performed. Or, you can activate one of the three cosine functions 
by pressing the first letter of each from the list. 

 

13.1.6 TANGENT FUNCTIONS 
You can open the "Tangent Functions" by pressing "Enter-T" from the calculation 
line, or by selecting "Tangent Functions" from the Calculator's menu. The 
"tangent functions" list consists of "Tangent", "Arc tangent", and "Hyperbolic 
tangent". If you press "Enter" on one of the three functions, the calculation is 
performed.  

 

13.1.7 LOGARITHM FUNCTIONS 
You can open the "Logarithm Functions" by pressing "Enter-L" from the 
calculation line, or by selecting "Logarithmic Functions" from the Calculator's 
menu. 

The "Logarithm Functions" is a dialog, which contains a "function list", a 
"Confirm" button, and a "Cancel" button. The function list consists of "Common 
logarithm" and "Natural logarithm". If you press "Enter" on one of the logarithm 
functions, the calculation is inserted into your calculation line.  
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13.1.8 CONVERT UNIT 
The "Convert Unit" dialog allows you to convert measurements of mass, area, 
volume, distance, and temperature from metric measure to imperial measure as 
well as other standards of measurement and units of measurement within the 
same system. It also converts several units of measurement related to 
programming and computers. 

To open the "Convert Unit" dialog, Select "Convert Unit" from the Calculator's 
menu, or press "Enter-U" from anywhere in the Calculator.  

The "Convert Unit" dialog contains the following items: "Unit Category" combo 
box, "Current Unit" combo box, "Change Unit" combo box, "Input Number" edit 
box, "Convert" button, "Cancel" button and the "Result" static box. You can 
move among the controls in the dialog using "Tab (F3 or Space-4-5)" or "Shift-
Tab (Space-F3 or Space-1-2)". Use "Space-1" or "Space-4" to move among the 
items in the combo boxes.  

The available unit categories are Distance, Area, Mass, Volume, Temperature, 
Data, numbers and Text. When you have chosen your measurement category, 
the "Current Unit" and "Change Unit" combo boxes will contain measurement 
units according to your chosen category. The available distance units are: 
Millimeters, Centimeters, Meters, Kilometers, Inches, Feet, Yards, and Miles. 
The available units of area are: Square Meters, Are, Square feet, Square Yards, 
Acres, and Hectares. The available units of mass are: Grams, Kilograms, Tones, 
Grains, Ounces, and Pounds. The available units of volume are: Deciliter, 
Milliliter, Liter, Cubic Centimeter, Cubic Meter, Cubic Inch, Cubic Foot, Cubic 
Yard, Gallon, Fluid oz, Cups and Quarts. The available units of temperature are: 
Celsius, Fahrenheit and Kelvin.  
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The available data units are bit, byte, kilobyte, megabyte and gigabyte. The 
available numeric units are Hex, Dec and binary. Finally, the text conversion 
allows you to discover the ASCII equivalent to any text character. 

Choose your unit to convert from in the first combo box. Choose your unit to 
convert to in the "Change" combo box. Type the number of the measurement 
you want to convert in the "Input Number" edit box. Finally, to convert the 
measurement, Tab to the "Convert" button and press "Enter". If you wish to 
cancel the conversion, Tab to the "Cancel" button and press "Enter". When you 
activate the "Convert" button, the conversion result is displayed in the "Result" 
static box.  

 

13.1.9 COPY TO CLIPBOARD 
The "Copy to Clipboard" function is used to copy your expression or result to the 
clipboard for pasting your expression or result in a document. You can also 
access up to 20 lines of calculation history and copy them as well. Press "Enter" 
on the "Copy to Clipboard" option in the menu, or press "Enter-C" in the 
calculation line to copy the current expression. You can now paste the 
calculation to a document in the Word Processor or to another application on the 
unit.  

To access the cumulative calculation history, press "Enter-H". You can then use 
normal selection commands to select the lines of the history you wish to copy. 
Press “Space-D” to delete an item from the cumulative history. 
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13.1.10 RETURN FORMULA 
There may be times, after viewing a result, that you wish to be reminded what 
expression you used to obtain that result. The "return formula" function allows 
you to return the expression you just entered 

When your result is displayed, press "Enter-R", or select "Return Formula" from 
the menu.  

The expression you entered to obtain your current result is displayed. 

 

13.1.11 OPTION SETTINGS 
You can activate the "Option Settings" by pressing "Enter" on the menu option, 
or from your calculation line, press "Enter-O".  

The "Option Settings" dialog contains combo boxes for changing various 
settings, an "OK" button, and a "Cancel" button. The "available settings are 
"Angle Unit", "Calculator Braille Code", “decimal places to display” and “Display 
Using Scientific notation”. You can navigate among the controls using “F3” or 
“Space-F3”. Use "Space" to change the value of each setting. 

When setting the angle unit, if you select "Radian", you can get the PI value 
while using the trigonometric function. If you select "Degree" and activate PI, 
you will get a wrong answer as this is not a valid calculation.  

You can set the Calculator Braille code to computer Braille, Nemeth or UEB 
math Braille as described previously. You can use "Space-G" to change this 
setting from anywhere in the calculator. 
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13.2 Polaris Math 
This program allows you to create equations, or lists of equations, and perform 
advanced graphing functions. Be aware, because this program needs to do 
specific math related functions, it does break some of the usual interface rules. 

When you first open it, you see an empty list, with the index 1/1. We use a list 
view here for the purposes of being able to select math problems in the same 
way you can select files or folders in a list, so that you can perform a single 
action on all selected items. One difference though, because you will use Space 
when writing math expressions, you will use Space-Enter to select the current 
item. 

To enter a math problem, simply begin typing. When you press Enter after 
completing it, you will see an empty list item labeled 2/2. This will continue 
happening as you enter subsequent math expressions and press enter. 

As you enter math expressions, graphs are automatically created when you 
press Enter, navigate away from the edit box, etc. 

As you add expressions and graphs, they are added to the same image, the 
same x and y axis, with each subsequent graph appearing in a different color. If 
you graph more than 6 expressions, colors will be repeated, as there are only 6 
different colors. 

From the Word Processor, you can press Backspace-Enter-G to open the 
graphing function, this automatically opens Polaris Math, and inserts the current 
equation in to the list. 

As with most other programs on Polaris, press F2 or Space-M to open the 
menus. Menu functions are outlined below: 
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13.2.1 THE FILE MENU 
1) Export: € “Enter-E”. Saves the current Polaris math file (.mth). You are not 
able to export this to other formats, just save it for later use, or for sharing with 
another Polaris user. 

2) Import: (I) “Enter-I”. Allows you to open a previously saved Polaris Math 
(.mth) file. 

3) Save to History: (S) “Space-S”. Saves the current selection to your history.  

4) History: (H) “Enter-H”. Opens a list of equations you saved to your history. 
You can save an expression to your history by pressing Space-S.  

5) Save Graph As Braille: (F) “Enter-F”. Saves the tactile rendering of your 
currently selected graph as a Braille file. 

6) Exit: (Z) “Space-Z”. Performs the obvious function. 

 

13.2.2 THE EDIT MENU 
1) Copy: © “Enter-C”. Copies the current or selected math expressions to the 
clipboard. This function does not copy graphical images. Use the copy Graph 
function to do this. 

2) Cut: (X) “Enter-X”. Cuts the current selection to the clipboard. 

3) Paste: (V) “Enter-V”. Pastes clipboard content can currently paste only from 
other Polaris Math areas, such as the history or a math file. 

4) Delete: (D) “Space-D”. Deletes the current or selected expressions. 

5) Select All: (A) “Enter-A”. Selects all expressions in the current list. 
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6) Start Selection: (B) “Enter-B”. The same Start selection command that exists 
in File Manager and other list areas, selects continuously to your current cursor 
position. 

7) Copy Graph: (G) “Enter-G”. Copies the graph image and associated 
equations to the clipboard. 

8) Symbol picker: (S) “Backspace-S”. Allows you to search for and select math 
symbols to enter into your math expression. 

9) Set Math Code: (M) “Backspace-G”. Choose between UEB and Nemeth. 

 

13.2.3 THE GRAPH MENU 
1) Axis: (X) “Backspace-X”. Allows you to set the limits of the axes, label them, 
and set the value each point represents. 

2) Graph label: (L) “Backspace-L”. Lets you label the graph as a whole. 

3) Graph Style: © “Backspace-C”. Lets you set color and shape of the graph.  

4) Show/Hide graph: (H) “Backspace-H”. This allows you to hide the graph for 
the equation on which you are focused. This menu item will then become “Show 
Graph” which will restore its view. 

 

13.2.4 THE OUTPUT MENU 
1) Display Tactile Graph: (T) “Enter-T”. Renders a tactile representation of the 
current graph on the Braille display. Scroll Quickly to easily determine its shape. 
Start and stop quick auto scroll by pressing the Up and Down Scroll keys 
simultaneously. 



 
 

 237  

  

 

2) Send to Embosser: (P) “Enter-P”. Does just what it implies, allows you to 
emboss a tactile version of the graph. 

 

13.3 Display Time and Date 
Use this function to check the current date and time. Navigate to "Display Time 
and Date" in the "Utilities" menu, and press "Enter". You can also query the time 
and date from anywhere on the Polaris with "Space-T". You can Tab to display 
today's date.  

 

13.4 World Clock 
The “World Clock” is a very simple application that lets you easily keep track of 
and check the time for places you specify around the world. 

 You can open the “World Clock” application from the “Utilities” menu, or by 
pressing “F3-L” from anywhere on the unit. 

By default, the World Clock contains one entry which matches your Time and date 
setting. You can navigate all entries in the list using “Space-1” and Space-4”. 

To navigate the controls in the dialog, use “F3” and “Space-F3”. The World Clock 
dialog contains the entries list, an add button, a delete button, and an Exit button. 

To add an entry to the list, press Enter on the Add button. You are presented with 
a list of time zones. Choose the time zone you wish to add, and press Enter. It is 
now added to your list of entries for easy checking. 
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13.5 Display Compass Heading 
Use this option to display the direction of the compass on the Polaris. You can 
display the compass heading from anywhere on the unit. 

To display the compass heading, press "Space-F3-F4" from anywhere on the 
Polaris. 

The current status of the compass is displayed. 

You can also access compass status in the "Utilities" menu. Move to "Display 
Compass Heading" with "Space-4" and press "Enter".  

As you change direction, to check the current compass status, press "Space". 
The current direction is announced. To exit this function, press "Space-E" or 
Space-Z".  

 Note: It will take about 15 minutes to initialize the unit should the following 
situations occur: 

1. The unit discharges a great distance from the location where the compass 
was last used. 

2. The unit remains discharged for more than a month. 

 

13.5.1 OPTIONS OF GYROCOMPASS 
There are 2 option settings available when viewing compass status: "Refreshing 
time" and "Compass display type".  

Refreshing time is the interval of the automatic announcement of the compass 
status. To set this option, from the compass status, "Tab" to the "Refreshing 
time" edit box. Type the number of seconds between compass status 
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announcements. By default, it is set to 0. You may type a number between 0 
and 120. 

You can set the Compass Display Type by tabbing to this option from the 
compass status. The setting values are "cardinal and degrees", "cardinal only" 
and "degrees only". By pressing "Space", you can change the value of the 
setting. By default, it is set to "cardinal and degrees". 

 

13.6 Wake Up Alarm 
You can use this function to set multiple alarms to remind you of recurring 
events, or wake you up at different times on varying days of the week. To open 
"Wake up alarm", from the "Utilities" menu, use "Space-1" or "Space-4" to 
navigate to "Wake up alarm", and press "Enter". You can launch the "Wake Up 
Alarm" from anywhere on the unit by pressing "F3-A" If you have not yet set the 
time or date in the Polaris, the unit prompts, "Set time:" After you set the time, 
the Polaris displays the "Wake up alarm" dialog.  

The “Wake Up Alarm” dialog contains 5 items: Alarms list, an “Add” button, 
“Modify” button, “Delete” button, and a “Close” button. Use “F3” and “Space-F3” 
to move among the controls. Use “Space-1” and “Space-4” to navigate the 
Alarms list. You can also add an alarm by pressing “Enter-A”, modify with “Enter-
M”, and delete an alarm with “Space-D”. 

The "Add alarm" dialog contains: "Set time", "Bell", "Term", "Alarm duration", 
"Repeat interval", "Wake up call times", a "Confirm" button, and a "Cancel" 
button.  

When the alarm sounds, the Braille display displays the message "Wake up call. 
Press Backspace-enter to stop the alarm".  



 
 

 240  

  

 

When you open the "Wake up alarm" dialog, the Polaris displays the "Set time" 
field. The value is set to the current time or the time specified previously. Here 
you can directly type the time, or set the time using the shortcut keys, as 
explained in section 8.1.3.  

Tab to the next field and select from one of 3 alarm sounds, a vibration, a media 
file or an FM Radio frequency for the wake up alarm. Press "Space-1" or 
"Space-4" to change the alarm sound. As you move among the sounds, the 
various alarm sounds are played. When you reach the 4th option, "Vibrate 
motor", the Polaris produces a long vibration representing the one you would 
feel should you choose to use this option to alert you of your alarm.  

If you choose "Media File", Tab to the "File Name" button and press "enter" to 
browse for the file you wish to use as your alarm sound. You are placed in a File 
Manager control with the focus inside the 'Media" folder. Locate the file you wish 
to use, and press 'Enter". If you choose "FM Radio", tabbing once places you in 
an edit box in to which you can type the frequency of the radio station you wish 
to wake up to.  

When you have selected your desired alarm type, Tab to the next field. 

In the term field, you can set which days of the week the alarm sounds. There 
are four options: "Off", "Once", "Week days", and "Every day". If the "Term" is 
set to "Off", the alarm does not go off at the specified time, no matter how the 
other options in the dialog are set.  

The duration option sets the amount of time that the alarm sounds. The options 
are 1 minute, 2 minutes, or 3 minutes. If you set the ringing duration to "1 
minute", the alarm sounds for one minute, and then is silent. To stop the alarm 
before a minute has passed, press "Backspace-enter". 



 
 

 241  

  

 

The repeat interval defines the amount of time that is between the times that the 
alarm sounds. For example, if you set the repeat interval to three minutes, after 
the alarm has stopped sounding, it rings again in 3 minutes. The available 
settings are 1, 3, 5, 10, 15, or 20 minutes.  

If the alarm is not turned off by pressing "Backspace-enter", it repeats according 
to the number of times you set the Wake Up Call Time option. The available 
settings are 1 to 10.  

Press "Enter" to save your setting, or "Space-Z" to cancel setting the alarm. 

 

13.7 Stopwatch 
You can launch the "Stopwatch" from anywhere on the unit by pressing "F3-W". 
Or, you can navigate to it in the "Utilities" menu and press "Enter". 

"00:00:00" is displayed. Press "Enter", to start the stopwatch running. Press 
"Enter" again, to pause, and the Polaris announces the elapsed time, and 
displays it in Braille. Pressing "Enter" again restarts the stopwatch running. 

If you press "Backspace" while the stopwatch is paused or running, The Polaris 
announces the elapsed time and clears to "00:00:00". While the stopwatch is 
running, pressing "Space" gives you the elapsed time. As the stopwatch is still 
running, the Braille display continues displaying the time second by second as it 
passes.  

Press "Space-F2" to stop displaying the time. If you press "Space-F2" once 
more, the time is displayed again. 

Tab to switch to the "Countdown timer". You are asked to type hours, minutes, 
and seconds. Type a two-digit number for the hour, minute, and the second 
using Computer Braille or grade 1. You do not need to use a number sign. If you 
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press "Enter" without typing any numbers, the "Countdown timer" starts counting 
down by the default time, which is set to one minute. When started, the 
"Countdown timer" displays "countdown xx minute", and begins running. 

Press "Enter" on the "Countdown timer", and the Polaris tells you the remaining 
time, and pauses countdown. Press "Enter" again to restart the timer. Pressing 
"Backspace" clears the "Countdown timer". If the timer reaches zero, a 10-
second alarm sounds, and the "Countdown timer" clears. If you press 
"Backspace-enter" while the alarm is sounding, the alarm stops and your timer 
clears, and is ready to accept a new time. 

To exit the "Stopwatch" program, press "Space-Z".  

 

13.8 Terminal for Screen Reader 
The "Terminal for screen reader" function allows the Polaris to be used as a 
Braille display when connected to a computer or cell phone that uses a 
compatible screen reader such as JAWS, Supernova, Android’s TalkBack or 
Apple's VoiceOver. Before using this function, make sure that the Polaris is 
connected to your personal computer or smart phone via a Bluetooth serial 
connection, or to the USB client port. To turn on this function, from the "Utilities" 
menu, navigate to "Terminal for screen reader", and press "Enter". To launch 
"Terminal for Screen Reader" from anywhere on the unit, press "F3-S".  

The list of connection options is displayed: "Bluetooth serial port" and "USB 
port". Press "Enter" on your desired connection type, and the unit announces, 
"Terminal mode". If you are connecting using the Bluetooth serial connection 
and Bluetooth has not been activated, the unit automatically activates Bluetooth 
before entering terminal Mode. 
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Once in Terminal Mode, the Polaris no longer speaks as it is now simply acting 
as a Braille display for your computer or smart phone. If the connection fails, you 
are returned to the list of connection methods. 

You can connect a Bluetooth and USB device to the Terminal for Screen Reader 
simultaneously. Once you have established the first connection, press 
Backspace-Space-Enter-P to initiate the second connection. When 2 devices 
are connected, press Backspace-Space-Enter-C to toggle between the 
connections. 

To exit the "Terminal for Screen reader" press "Backspace-Space-Z".  

 

13.8.1 TERMINAL CLIPBOARD 
Terminal Clipboard allows you to create and edit text on the notetaker before 
sending it via the Terminal for Screen Reader to the connected device. This can 
be useful in instances like when using VoiceOver on an i-device, in which 
characters are translated as they are sent to the IPhone or iPad. Or, you may 
simply find it more comfortable to edit in the notetaker environment. 

As explained above, the Terminal Clipboard allows you to create and edit text on 
the notetaker, and send the completed text to the connected computer or 
Smartphone via the Terminal for Screen reader. 

To enter "Terminal Clipboard", press "Space-Enter-I". The BrailleSense 
announces, "Terminal Clipboard". Type and edit your text using normal text entry 
and edit commands. In "Terminal Clipboard", the Braille display and keyboard 
are temporarily disabled from sending/receiving information to/from your 
connected computer or i-device, so that you may use them for creating/editing 
your text. For more information on text entry and editing, please see section 5 of 
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this manual on the Word Processor. When you are finished typing the text you 
wish to send to your computer or mobile device, press "Enter-S" and the text is 
quickly inputted to the device via the Terminal for Screen reader, and your 
BrailleSense returns to sending/receiving information to and from the connected 
device. 

"Terminal Clipboard" can also be useful for transferring text from a document or 
e-mail in your notetaker, to a document or e-mail you are creating on your 
connected computer or Smartphone. As the "Terminal Clipboard" is a standard 
edit box on the notetaker, you can paste text in to it from the notetaker's 
clipboard. (see the sections of this manual regarding selecting text as it applies 
to supported programs such as the Word Processor, E-mail, Web Browser, etc.) 

To send text from your notetaker:  

1) Press "Space-Enter-I" to activate "Terminal Clipboard". 

2) Press "Enter-V" to paste the text from the notetaker's clipboard to the edit 
box. 

3) Press "Enter-S" to send the text via the Terminal for Screen Reader. 

 

13.9 Display Network Status 
This utility provides information about the current network connection type and 
status, the current IP of the unit, subnet mask, gateway, and MAC address. To 
check network status, press "Enter" on "Display Network Status". You can also 
query network status from the "program" menu by pressing "Space-N".  

The information about the current connection is displayed. You can Tab to a 
"Renew" button and a "Close" button. 
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The first item in the information list (status) indicates whether the Polaris is 
currently connected to the Internet (online/offline), and if so, the current 
connection type (LAN, Modem, ADSL, or Wireless LAN). The next item is the 
"current IP address", followed by "Subnet mask", and "Gateway", and finally 
"MAC address". You can move among these items by pressing "Space-4" or 
"Space-1". If the Polaris is not currently connected to the Internet, the status 
information shows "offline", and the IP address, subnet mask, and gateway 
display 0's.  

 

13.10 Display Power Status 
Press "Enter" on "Display power status" from the "Utilities" menu. Or, query 
power status from anywhere on the Polaris by pressing "Space-1-6". Two pieces 
of information are displayed: the percentage of charge remaining in the battery, 
and whether the Polaris is using the AC adapter or the battery to receive power. 
Exit by pressing "Space-Z". And you are returned to your previous location on 
the unit.  

 

13.11 Format 
WARNING!! The Polaris makes it possible to format the flashdisk to solve 
corruption problems and/or start over with a clean internal drive. Formatting the 
flashdisk erases everything on the flashdisk. Be extremely cautious when 
executing this command. If you execute this command, you will lose all of your 
data. You will NOT be able to retrieve this data once the command is executed. 
To format the flashdisk, press and hold "Space-1-2-3". While holding down 
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"Space-1-2-3," quickly press and release the reset button. Continue holding 
"Space-1-2-3" until you hear the "format start" announcement. 

You can also access the "format" function by pressing F from the "Utilities" 
menu. Or, you can launch it from anywhere on the Polaris by pressing "F3-F".  

When you format any disk on the Polaris, all information is erased. Therefore, 
before you format, you are advised to backup any important data if possible. 

 

1) From the Utilities menu, press "Enter" on "Format" and "flashdisk" is focused. 
Press "Enter", or choose another disk from the list, and press "Enter". *Note: 
you can choose the format type between FAT32 and exFAT by pressing F3 from 
the disk list. 

2) You are prompted, "Format flashdisk?" Yes". Press "Enter" 

3) You are prompted, "All data will be lost. Continue? Yes". Press "Enter".  

4) The unit announces, "Now formatting flashdisk" and the format is started. 

5) When the format is complete, you are returned to the "Disk" list. 

To cancel the format, press "Space", or press "Enter" on "No" in step 2 or 3. 

 

13.12 Set Sleep Timer 
You can set the sleep timer to turn the Polaris off after a specified amount of 
time regardless of what you are doing. 

To set the Sleep Timer, navigate to "Sleep Timer" in the Utilities" menu and 
press "Enter". Or press "Space-J" from anywhere on the unit.  
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You are prompted, "Sleep timer: 0". Enter the number of minutes for the sleep 
timer in the edit box. The available settings range from 0 to 180. Press "Enter". 

When the sleep timer is set, even if the device is active, it powers off after the 
specified amount of time. If you set the sleep timer for "5" minutes and press 
"Space-J (dots 2-4-5)" after 2 minutes, "3" is displayed in the edit box, indicating 
the time remaining before the sleep timer powers the unit off.  

 

13.13 Using Macros 
Macros allow you to automate functions of the Braille Sense for ease of use and 
efficiency, especially in cases where you perform a similar action often. For 
example, you may wish to set a macro to open a set of programs and documents 
when you come to work each morning. Or, perhaps, you want to set a macro to 
automate insertion of text and formatting of a document. You may even want to 
create a macro to automatically set an alarm for 6 in the morning the next day. 

 

13.13.1 RECORDING A MACRO. 
To create a macro, you simply ask the unit to record a set of functions as you 
perform them, and save it. To begin recording a macro, press "F2-R" from 
anywhere on the unit. Perform all the functions you wish to automate later, then 
press "F2-R" again to stop recording. For example, if you wish to set a macro to 
set an alarm, press "F2-R", go to the Utilities menu, and the Wake Up Alarm 
function. Go through the process of setting the alarm. After you have pressed 
"Enter" to complete the alarm setting, press "F2-R" to stop macro recording. You 
are asked to enter a name under which to save the macro. Type it in the edit box, 
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and press "Enter". If you have made a mistake, and do not wish to save the macro, 
press "Space-Z" to cancel saving the macro. 

There may be times when it is necessary to insert some wait time in your macro to 
account for loading time of a file or website, etc. You can insert delay time while 
recording a macro by pressing “F2-D”. Type the delay time in milliseconds and 
press “Enter”. Continue recording your macro as normal. 

 

13.13.2 EXECUTING A MACRO. 
To execute a previously created macro, press "F2-E" from anywhere on the Braille 
Sense. You are prompted for the macro name, and the last macro you created is 
automatically displayed. Type the macro name and press "Enter". The unit 
announces, "Executing macro, please wait,,,". The macro takes several seconds 
to execute as it must perform all the functions you previously recorded. When the 
macro is finished running, you are placed in the position you would normally be 
placed in if you had performed the functions manually. For example, if you set a 
macro to open your e-mail and check for new mail, when it has finished executing, 
you are placed in your inbox with the focus on the first unread message. 

You may also create a macro to define a task you wish to perform multiple times. 
You can set the macro to repeat any number of times from the “Execute Macro” 
dialog. After pressing “F2-E”, press “Space-4” to navigate to the “Repeat” edit box, 
and type the number of times you wish for the macro to repeat. The repeat count 
is remembered until you change it again or reset the unit. 
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13.13.3 THE MACRO MANAGER 
The "Macro Manager" allows you to execute and manage macros you have 
previously created. It is located in the "Utilities" menu, just above the "Upgrade" 
option. Navigate to "Macro Manager" and press "Enter". You can also open the 
"Macro Manager" from anywhere on the unit using "F2-L".  

The "Macro Manager" dialog contains: Macro Name List, “Repeat Macro”, "Delete 
Macro", "Rename Macro", "Execute Macro", “Import Macro”, “Export Macro”, and 
a "Close" button. 

The Macro Name List is a list of all the macros you have created. To execute a 
macro, press "Enter" on the macro name, or Tab to "Execute Macro" and press 
"Enter". As previously described, you can also execute a macro from anywhere 
on the unit by pressing "F2-E". To delete a macro, navigate to the macro you wish 
to delete in the list, Tab to "Delete Macro" and press "Enter", or press "Space-D".  
You can rename a macro by focusing the macro you wish to rename, and 
selecting the "Rename Macro" option. You are placed in an edit box in which you 
can type the new macro file name, with the current name displayed. To rename 
the macro, edit the current name or type a new one, and press "Enter". 

You can also import and export your Macro list from the Macro Manager, either 
to share with others, to backup Macros you have created, or to share among 
multiple units. 

 

13.14 Upgrade BrailleSense Polaris Firmware 
Using this utility, you can update the Polaris either via an Internet connection or 
from external media containing the upgrade files. If you choose the "Online" 
method, be sure you have an active Internet connection before attempting the 
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upgrade. When you update the Polaris, settings are usually maintained. 
However, if there are changes to setting values in the firmware, all settings will 
be initialized. Therefore, it is recommended that you back up your settings using 
the backup/restore utility in the “Settings” menu. Data in the flashdisk is 
protected. However, we recommend you backup your files before updating the 
Polaris Firmware as unexpected problems can occur. 

 Note: You cannot cancel the update once it has started. You must not 
reset the unit during an upgrade. You must keep the unit connected to AC 
power throughout the upgrade process. We recommend you do not touch 
the Polaris while it is updating. It may take up to 60 minutes to update the 
Polaris, possibly even longer depending on the speed of your Internet 
connection and how many Android apps you have installed.  

 Also note: the upgrade files are temporarily stored on the flashdisk for 
installation. If you do not have enough memory available on the flashdisk, 
the Polaris is unable to update until you make room for the upgrade files. 

You can access the "Upgrade Firmware" option via the "Utilities" menu, or 
launch it from anywhere on the unit using "F3-U".  

When you have chosen your upgrade method, and the upgrade files are 
downloaded or detected, Polaris will extract all of the necessary program files. 
Progress is announced every few seconds. 

Once done, the Polaris will reboot, and the system files will be upgraded. During 
this process, there is no speech, but the progress will be shown in Braille as a 
percentage. 

Once this has completed, a Braille message displaying “Initialization” will 
appear, followed by a numeric count of application files that have been 
initialized. Note that these application files include all Polaris and Android 
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packages, and the number will be somewhere around 180 even if you have not 
installed any additional Android apps. 

When the system files have been upgraded and the applications initialized, the 
software will load and boot. During this process, the Polaris displays “Starting 
BrailleSense” in Braille, and a progress indicator of changing dots appears on 
the right.  

When the system reboots, if there are no new or changed setting values in the 
firmware, the Main Menu loads, and your settings are restored. If setting values 
have been changed, all Settings are initialized, and the system boots and runs 
the Quick Guide. 

When the system boots for the final time after the upgrade, the release Note is 
displayed. Press “F4” to exit to the Main Menu. If you want to save the release 
Note to the Documents folder, Tab to save and press “Enter”. To display it again 
at any time, press “F2-F3-R” from the main Menu. 

 

 

13.14.1 UPGRADING THE POLARIS FIRMWARE USING THE 
INTERNET 
To upgrade the Polaris Firmware via the Internet, follow these steps: 

1) Make sure you are connected to the Internet and plugged into AC power. 
Press "Enter" on "Upgrade Polaris Firmware" in the "Utilities" menu.  

2) Press "Enter" on "Upgrade: Online". The Polaris connects to the HIMS server, 
and your current software version is compared to the HIMS server version. You 
are prompted to continue with the upgrade. 
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3) The Polaris begins downloading the upgrade files. The upgrade is around 1.3 
GB. Thus, depending on the speed of your Internet connection, it may take a 
long time to download. If the upgrade fails, you may receive the message, 
"Internet connection is not available. To try the upgrade again, press "Space-Z" 
to cancel, and activate "Upgrade Polaris Firmware" again. If the connection is 
successful, the upgrade files are downloaded.   

4) After downloading the upgrade files, Polaris automatically starts the upgrade 
process. Please remember you must not touch the Polaris until the upgrade is 
complete, as pressing keys, resetting, or unplugging the unit can interrupt the 
upgrade process, thus resulting in an incomplete installation. When the upgrade 
is complete, you are returned to the "program" menu, and the unit announces, 
"File manager". 

5) After the upgrade is complete, check the software version by pressing 
"Space-V" while in the "program" menu. 

 

13.14.2 UPGRADING THE POLARIS FIRMWARE FROM A DISK 
To upgrade the Polaris Firmware from a disk, follow these steps: 

1) Download the upgrade file from the HIMS website. Note: the file is a .bin file, 
however, some versions of Windows may rename it as a .zip file. Do not extract 
this file. Simply rename the extension back to .bin. Copy the file to the root of an 
external storage device such as an SD card or USB thumb drive.  

2) Connect the SD card or USB drive to the Polaris, and be sure the Polaris is 
connected to AC power. Then, press "Enter" on "Upgrade Polaris Firmware" 
from the "Utilities" menu. 
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3) "Upgrade: Online" is displayed. Press "Space-4" to go to the "Upgrade: 
Offline" option. Press "Enter".  

4) If you are already running the latest version of the software, you are asked to 
continue with the upgrade. If you press "Enter" on "No", the upgrade is 
cancelled. Press "Space" to toggle between "Yes" and "No".  

5) The Polaris starts the upgrade process. Please remember you must not touch 
the Polaris until the upgrade is complete. When the upgrade is complete, you 
are returned to the "program" menu, and "File manager" is displayed. 

6) When the upgrade is complete, check the software version by pressing 
"Space-V" while in the "program" menu. 

 

14. Installing and Using Native Android Apps 
While the Polaris has many powerful programs created specifically for the 
visually impaired, one of its most powerful features is the ability to install and 
use native Android applications directly from the Google Play Store. Before you 
can install native Android applications, you must have a Google Play Store 
account.  

You can run the Play Store by navigating to it from the Main menu, and pressing 
"Enter". You can also press the letter "P".  

When you first open the Play Store application, you will need to sign into your 
Google account. It is important to note: when you use the Google Play Store 
and any applications you install from there, you are utilizing native Android apps. 
Thus, you are no longer accessing the BrailleSense interface, and interaction 
and navigation is slightly different. 
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BrailleSense Polaris contains a mobile screen reader that is automatically 
executed when you use any native Android app. It is somewhat similar to 
TalkBack for Android with some notable enhancements. Because you must 
navigate the graphical Android screen, it can sometimes be difficult to locate 
what you need efficiently. For this reason, the Polaris screen reader allows you 
to locate icons according to their first letter. So, if you're looking for a Search 
icon, press the letter S. Pressing a given letter will take you to the first icon that 
matches. Subsequent presses of the same letter will jump to additional icons on 
the screen beginning with that letter. 

Use "F3" and "Space-F3" to move among individual objects on the screen. The 
Control and Alt keys will often take you to different content areas on the screen. 
In programs like Docs, Sheets, and Slides, keyboard shortcuts are available for 
QWERTY keyboards, and the Control and Alt keys allow you also to utilize these 
functions. Use Backspace when Shift is required. 

Use "Space-1-2-3" to move to the top of the current content area, and "Space-4-
5-6" to move to the bottom of the current content area. Use "Enter" to select or 
run the current item, and “F4”, “Space-E”, or “Space-Z” to move back one 
screen. 

To type in an edit box, you must press "Enter" to activate Edit Mode before you 
can input text. To adjust slider controls, press “Backspace-Space-4” to increase 
the slider value, and “Backspace-Space-1” to decrease a slider value”. 

You can also navigate Android apps using the Media keys on the front panel. 
Use “Back” and “Next” to move to the previous and next object. “Record” serves 
as the android Back button. “Play” opens Recent Apps, and “Stop” returns you 
to the main Menu. When playing media with an Android app such as Apple 
music or Spotify, hold the “Back” button to move to the previous item, hold the 
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“Play” button to play/pause, and hold the “Next” button to move to the next item 
or track. 

If you prefer to use more traditional keystrokes for navigating objects, you can 
change the method of navigation to emulate Swipe gestures as does TalkBack, 
using Space-1 and Space-4. To turn on the gesture method, press Backspace-
Enter-H while using the Mobile Screen reader. Use the same keystroke to 
change back to the original mobile Screen Reader method. 

To emulate a Double tap directly, regardless of mode, press “Space-Enter”. This 
is useful in apps like Tap Tap See, where some buttons have no keyboard 
equivalents. To emulate Double Tap and Hold, press “Backspace-Space-Enter”. 
This is useful in apps like Amazon, that offer additional menus of functions when 
you are placed on a shopping item, a song in Amazon Music, etc. Finally, to 
emulate a hold, you can use “Backspace-Space-Dot-2” to start and stop the 
hold. This is necessary in apps like WhatsApp Messenger for activating certain 
functions. 

It is also possible to operate Android apps in a more traditional manner using a 
keyboard and/or mouse, or portable touch monitor. You can turn accessibility 
features on and off by pressing the “Stop” and “Next” media buttons together on 
the front panel of the device. When the Mobile Screen Reader is on, these 
accessories will operate similar to how they would when using TalkBack. When 
the mobile Screen Reader is off, they will operate as they would traditionally 
operate in Android.  

Once you have signed into your Google account, you may search for 
applications using the "Search" function. If you have other Android devices, and 
have already purchased apps from the Play Store, open the Navigation drawer, 
and choose the "My Apps" option. By default, the Play Store displays only what 
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is currently installed on this unit. Select the "All" button to show all apps you 
have purchased or downloaded.  

From an Apps list, press "Enter" to view the details of an app. If you wish to 
install it, locate the "Install" button and press "Enter". You are presented with a 
dialog showing the necessary app permissions. Locate the "Accept" button, or 
press the letter A to jump to it, and press "Enter". 

When apps are installed, they will appear in the "All Apps" list at the end of the 
main program menu. When Polaris ships, this list contains stock Android apps 
and Google basics. The list is displayed in alphabetical order and can be 
navigated with first letter navigation. 

At the bottom of the Apps list is an "App Manager. The App Manager allows you 
to uninstall any native Android app on your Polaris. You can also access the 
traditional Android Actions Menu for each app by pressing “Enter-I” when 
focused on the app you want to act on. 

When you install Android apps, you may begin to hear sounds and 
announcements related to these apps. Many apps send “Notifications” to your 
Polaris in real-time, just as happens on smartphones and tablets. Press “Space-
1-2-3-4-5-6” from anywhere on the unit to see a list of these notifications. 

Press “Space-1” and “Space-4” to navigate the list, and press “Enter” on a 
notification to launch its associated application. Press “Space-D” to delete a 
notification from the list. Press “Space-Enter-D” to clear all notifications. * Note: 
Google does not allow the deletion of some notifications.  

 Note: While there are many native Android apps that work well, HIMS 
cannot and does not guarantee the accessibility or usability of any 
application that is not developed specifically for Polaris. Apps should 
generally work well if they meet Google accessibility standards, however 
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many apps are not made to meet these standards and are not easily 
usable on any Android device running a screen reader.  

 

15. Using Help 
The help section consists of a navigable version of the BrailleSense Polaris user 
Manual. To access this help file, press "F1" to go to the "program" menu, and 
use "Space-4" repeatedly until you locate "Help". Or press the letter h to quickly 
jump to and open "Help". You can also launch "Help from anywhere on the unit 
using "F1-H".  

The User Manual will load, and you will be placed in the Navigation menu. Use 
"Space-dot-1” and “Space-dot-4" to navigate to the section you wish to read. To 
navigate to sub sections for the focused section, press F3. Then, use “Space-1” 
and “Space-4” once again to navigate the sub sections. To move back a level in 
the structure, press “Space-F3”. 

Press "Enter" on the focused section to open the manual at that location and 
start reading. Keys for navigating are the same as those in the Notepad. For a 
list of navigation keys, please see chapter 6. You can return to the Navigation 
menu at any time by pressing “Space-N”.  

As you read the manual on the BrailleSense Polaris, you can search for text by 
pressing "Space-F". Type the text you wish to find, and press "Enter". You can 
find the next occurrence of the particular text you searched for by pressing 
"Enter-F".  

The Introduction section gives a physical orientation to the BrailleSense Polaris 
and an overview of its functionality.  
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The section, "Basic Functions", gives a basic overview of the programming and 
operation of the BrailleSense Polaris  

The section, "Customizing your notetaker" provides an explanation of time and 
date setup, internet Setup, Bluetooth connectivity, and the "Global Options" and 
how to use them to configure your BrailleSense Polaris according to your 
preferences.  

Most of the remaining sections cover each of the functions of the BrailleSense 
Polaris in detail.  

The "Commands Summary" section is a quick reference of hot keys for all the 
programs on the BrailleSense Polaris, useful when you simply want to know the 
keystroke for performing an action without reading the entirety of the instructions 
on a given program. 

You can also get help related to the specific task you are performing. Use 
"Space-H" within any program to get a list of keystrokes available in that 
program. 

 

16. Troubleshooting Guide 
If you are encountering problems with the BrailleSense Polaris, please take a 
look at the following suggestions for solving many common problems:  

 

16.1 The BrailleSense Polaris Will Not Turn On 
1) Check to make sure that the battery is inserted in to its compartment properly. 

2) If the battery is inserted properly, connect the AC adapter, and plug the AC 
adapter in to an electrical outlet. The battery may need to be charged. 
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3) Or, Check the location of the keyboard lock switch. If this switch is placed in 
the "lock" position, the power switch is not functional. 

 

16.2 The Voice Cannot Be Heard 
1) Make sure the volume is loud enough to be heard. Press "backspace-F4" to 
raise the volume. 

2) Make sure the voice is turned on. Press "Backspace-F2" to toggle the voice 
on/off. 

 

16.3 The Voice is Too Fast to Understand 
1) Press "space-F1" to lower the voice rate. 

 

16.4 The Voice Pitch Is Too Low or Too High to 
Understand 
1) Press "enter-F1" to lower the pitch, or press "enter-F4" to raise the pitch of 
the voice. 

 

16.5 You Don't Know Where You Are 
1) If you have become disoriented as to your location on the BrailleSense 
Polaris, and cannot remember where you are, press "F1" to access the 
"program" menu. Then, press "F2-F3" to switch among the open programs. If 
you are in the Word Processor, pressing "space1-5-6" gives you your current 
location in the open document. 
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16.6 No Internet Connection 
1) If you are using a Wi-Fi connection, ensure wireless is turned on. Use 
"Backspace-dots-1-4-5-6" to toggle wireless on/off.  

2) If using an Ethernet connection, check to ensure that the Ethernet cable is 
connected securely with the USB to Ethernet adapter, and that the network 
settings are correct.  

 

16.7 E-mail 
1) If you are having trouble downloading email, please contact your Internet 
service provider to make sure that you have the correct POP3/IMAP and SMTP 
settings. 

2) If you cannot send or receive mail, make sure you have an active connection 
to the Internet. 

 

16.8 The Braille display Does Not Display Braille 
1) If the Braille display does not display Braille, make sure that the Braille 
display is turned on. Use "Backspace-F3" to toggle the Braille display on/off. 

16.9 The BrailleSense Polaris Does Not Speak when using 
Play store or Android Apps 
If you do not have speech when you open the Play Store, or an Android app in 
your All Apps list, make sure the Mobile Screen Reader is on. You can toggle the 
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mobile Screen Reader on and off by pressing the “Stop” and “Next” media 
buttons on the front panel of the unit.  

 

16.10 The BrailleSense Menus are Not Displayed or 
Spoken 
At times, you may receive a prompt to set the default launcher between Google 
Now and the Polaris Launcher. If it is accidentally set to use the Google Now 
Launcher, the Polaris menus are not displayed, and accessibility features are 
not activated. In this case, System notifications may still be heard, but no Braille 
will appear, and no speech is heard. 

To reset the Polaris Launcher, press “F2-F3-1-2-3-4-5-6-7-8”.  

 

16.11 The BrailleSense Polaris Does Not Respond 
1. If the BrailleSense Polaris does not respond to keystrokes or commands, it 
may be necessary to reset the unit. To reset the BrailleSense Polaris, press "1-
2-3-4-5-6-F2-F3."  

2) If the soft reset does not revive the BrailleSense Polaris, you may need to 
completely shut down the unit. The easiest way to do this is to remove the 
battery, leave it out for a few seconds, re-insert it, and power on the unit.  

3) Initializing Polaris Options: if you are not able to solve your problem with the 
above methods, you may need to reset your Polaris options back to factory 
defaults. You can do this in two ways: if your unit is operational, you can launch 
the “Initialize Polaris options” item in the “Settings” menu. You may also hold the 
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Forward Media key while pressing the Power On Button. Continue to hold 
Forward until “HIMS” is displayed on the braille display. 

4: Hard resetting the Android system: In very serious cases, it may be necessary 
to perform a full system reset. However, this should not be attempted unless all 
other options have been exhausted, or unless you wish to completely erase all 
data, applications and settings. In addition, this process is complex and unique, 
and should only be done under the direction of an authorized support staff 
member. If you believe a system reset is necessary, please contact technical 
support for consultation and full instructions.  

 

16.12 The LCD Does Not Come On 
1) If the LCD screen does not come on, make sure that it is turned on. Press 
"space-o (dots 1-3-5)" to open "Global Options". Press "F3-F4" twice. Press 
"space" to turn the LCD screen option on, and press "enter" to save the option 
settings. 

 

16.13 USB or SD Files Seem to Contain 0 Bytes 
The Android operating system requires that drives are ejected properly before 
removing them. If not done, inserting them in to the Polaris or other devices may 
result in all files appearing as though they have no data, or have a size of 0 
bytes. Before disconnecting a USB drive or SD card, press “Backspace-Enter-U” 
or “Backspace-Enter-3-6” to unmount it properly. If your drive is showing files 
with no data, please re-insert it in to the Polaris, and press the Unmount key. 

 



 
 

 263  

  

 

17. Command Summary 
 

17.1 Common Combination Keys 
Open the main program menu: F1 

Open the Running Tasks list: F1-F4 

Switch to next running task: F2-F3 

Switch to previous running task: Space-F2-F3 

Open program specific menu: Space-m (dots 1-3-4) or F2 

Exit: Space-z (dots 1-3-5-6) 

Escape: Space-e (Space-1-5) or F4 

Move to the next control in a dialog box: Tab (Space-4-5 or F3) 

Move to the previous control in the dialog box: Shift-tab (Space-1-2 or Space-
F3) 

Move to the previous character: Space-3 

Move to the next character: Space-6 

Move to the previous line/item: Space-1 

Move to the next line/item: Space-4 

Move to the beginning of line/item: Space-1-3  

Move to the end of line/item: Space-4-6  

Move to the top of a document or list: Space-1-2-3  

Move to the bottom of a document or list: Space-4-5-6  
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Move to the previous page or to the first item of the previous 32-item group: 
Space-1-2-6 or F1-F2 

Move to the next page or to the first item of the next 32-item group: Space-3-4-5 
or F3-F4 

Scroll back: Up scroll button 

Scroll forward: Down scroll button 

Move the cursor to a specific cell or list item: press the corresponding cursor 
routing key 

Find: Space-f (dots 1-2-4) 

Upper case: Space-u (dots 1-3-6) 

Repeat current item: Space-r (dots 1-2-3-5) 

Open web Page: Space-w (dots 2-4-5-6) 

Say current time: Space-t (dots 2-3-4-5) 

Display power status: Space-1-6 

Open "Global options": Space-o (dots 1-3-5) 

Online help: Space-h (dots 1-2-5) 

Check software version: Space-v (dots 1-2-3-6) only from Main menu 

Display network status: Space-n (dots 1-3-4-5) from Main menu 

Display flash disk empty space: Space-i (dots 2-4) from Main menu 

LCD on/off: Enter-4-5-6 from Main menu 

Voice on/off: Backspace-F2 

Braille on/off: Backspace-F3 
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Increase voice volume: Backspace-F4 

Decrease the voice volume: Backspace-F1 

Increase the voice rate: Space-F4 

Decrease the voice rate: Space-F1 

Increase the voice pitch: Enter-F4 

Decrease the voice pitch: Enter-F1 

Increase the main volume: Backspace-Space-F4 

Decrease the main volume: Backspace-Space-F1 

One-handed mode on/off: Backspace-1-2-3 

Bluetooth on/off: Backspace-3-4-5-6 

Wireless LAN on/off: Backspace-1-4-5-6 

Typing mode on/off: Backspace-Space-Enter-M (dots 1-3-4) 

Change Braille Code: Backspace-Enter-b (dots 1-2) 

Scroll voice on/off: F3-up scroll button 

Eight dot mode on/off: F1-down scroll button 

Select Braille cursor type: F4-up scroll button 

Change TTS Voice: F3-V (dots-1-2-3-6) 

Select display of control information: F2-down scroll button 

Toggle Hide Passwords On/Off: F3-Down Scroll button 

Turn Sleep Mode On/Off: Control-Alt-S (dots-2-3-4) 

Unmount USB or SD: Backspace-Enter-u (dots 1-3-6) or Backspace-Enter-3-6 
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17.2 Quick Launch Commands 
Use the following commands to launch their associated applications from 
anywhere on the BrailleSense Polaris. 

 

Use F1 in combination with each letter to launch the following applications: 

Address Manager: A (dot 1) 

Web Browser: B (dots 1-2) 

DAISY Player: D (dots 1-4-5) 

Email: E (dots 1-5) 

File Manager: F (dots 1-2-4) 

Help: H (dots 1-2-5) 

Exchange E-mail: L (dots-1-2-3) 

Media Player: M (dots 1-3-4)  

Notepad: N (dots-1-4-5) 

FM Radio: R (dots 1-2-3-5) 

Schedule Manager: S (dots 2-3-4) 

Google search: U (dots-1-3-6) 

Word Processor: W (dots 2-4-5-6) 

Excel Viewer: X (dots 1-3-4-6) 

Online DAISY: Z (dots 1-3-5-6) 
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Use F3 in combination with each letter to launch the applications below: 

Wake up alarm: A (dot 1) 

Bluetooth Manager: B (dots 1-2) 

Calculator: C (dots 1-4) 

Format: F (dots 1-2-4) 

Setup Internet: I (dots 2-4) 

Backup/Restore Personalized Settings: K (dots 1-3) 

Polaris Math: M (dots-1-3-4) 

Password Protection: N (dots 1-3-4-5) 

Terminal for Screen Reader: S (dots 2-3-4) 

Set Time & Date: T (dots 2-3-4-5) 

Upgrade BrailleSense: U (dots 1-3-6) 

Stopwatch: W (dots 2-4-5-6) 

 

Other Quick Commands: 

Display time and date: Space-t (dots 2-3-4-5) 

Display network status: Space-n (dots 1-3-4-5) 

Display power status: Space-dots-1-6 

Display compass heading: Enter-dots 5-6 

Change device name: Backspace-Enter-e (dots 1-5) 
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Open sleep Timer: Space-j (dots 2-4-5) 

Open Global Options: Space-o (dots 1-3-5) 

Open Sense Dictionary: Backspace-Enter-d (dots 1-4-5) 

Open Menu Manager: From Main Menu, Enter-H (dots-1-2-5) 

 

17.3 File Manager 
17.3.1 NAVIGATION KEYS FOR THE FILE AND MENU LIST 
Move to previous item: Space-1 or up scroll button 

Move to next item: Space-4 or down scroll button 

Move to the beginning of the list: Space-1-2-3 or Space-1-3 

Move to the end of the list: Space-4-5-6 or Space-4-6 

 

17.3.2 NAVIGATION KEYS FOR THE FILE LIST 
Jump to folder list or file list: Space-5-6 

Move between file list and address window: Tab (Space-4-5 or F3) / shift-tab 
(Space-1-2 or Space-F3) 

Enter selected folder or open selected file: Enter 

Move up one folder level: Backspace 

Jump to the top level of the disk: Space-1-2-5-6 

Move up 32 items: Space-1-2-3 or F1-F2 

Move down 32 items: Space-3-4-5 or F3-F4 
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17.3.3 SELECTION COMMANDS 
Select individual item: Space 

Continuous selection: Enter-b (dots 1-2) 

Select all: Enter-a (dot 1) 

 

17.3.4 FILE MENU COMMANDS 
Open: Enter-o (dots 1-3-5) 

Open with: Enter-e (dots 1-5) 

Zip: Enter-z (dots 1-3-5-6) 

Unzip: Enter-u (dots 1-3-6) 

Send To: Enter-s (dots 2-3-4) 

Rename: Enter-r (dots 1-2-3-5) 

New document: Enter-n (dots 1-3-4-5) 

New folder: Enter-f (dots 1-2-4) 

File conversion: Enter-t (dots 2-3-4-5) 

Find file: Space-f (dots 1-2-4) 

Find Text: Backspace-f (dots 1-2-4) 

 Merge files: Enter-m (dots 1-3-4) 

Split files: Enter-p (dots 1-2-3-4) 

Information: Enter-i (dots 2-4) 
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17.3.5 EDIT MENU COMMANDS 
Copy: Enter-c (dots 1-4) 

Cut: Enter-x (dots 1-3-4-6) 

Paste: Enter-v (dots 1-2-3-6) 

Delete: Enter-d (dots 1-4-5) 

Select all: Enter-a (dot 1) 

 

17.3.6 VIEW MENU COMMANDS 
Sort files by: Enter-g (dots 1-2-4-5) 

Set file info: Enter-l (dots 1-2-3) 

Display only files of type: Enter-w (dots 2-4-5-6) 

Hide system folders: Enter-h (dots-1-2-5) 

Document Open Settings: Enter-D (dots-1-4-5) 

 

17.4 Word Processor 
17.4.1 FILE MENU COMMANDS 
New document: Enter-n (dots 1-3-4-5) 

Open: Enter-o (dots 1-3-5) 

Recent File List: Backspace-Enter-H (dots-1-2-5) 

Opened Documents List: Backspace-Enter-O (dots-1-3-5) 

Save: Enter-s (dots 2-3-4) 

Save as: Space-s (dots 2-3-4) 
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Export to Braille: Backspace-Enter-X (dots-1-3-4-6) 

Close current document: Space-q (dots 1-2-3-4-5) 

Print: Space-p (dots 1-2-3-4) 

Settings: Enter-e (dots 1-5) 

Set File open method: Backspace-Enter-O (dots-1-3-5) 

Dictionary: Backspace-Enter-d (dots 1-4-5) 

Exit: Space-z (dots 1-3-5-6) 

 

17.4.2 EDIT MENU COMMANDS 
Start selection: Enter-b (dots 1-2) 

Copy: Enter-c (dots 1-4)  

Add to the clipboard: Enter-p (dots 1-2-3-4) 

Clear clipboard: Enter-d (dots 1-4-5) 

Delete: Space-d (dots 1-4-5)  

Cut: Enter-x (dots 1-3-4-6)  

Paste: Enter-v (dots 1-2-3-6) 

Delete blank lines: Backspace-e (dots 1-5) 

Select all: Enter-a (dot 1) 

Check spelling: Enter-k (dots 1-3) 

Check spelling of the current word: Backspace-k (dots 1-3) 
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17.4.3 INSERT MENU COMMANDS 
Set Mark: Enter-m (dots 1-3-4)  

Jump to mark: Enter-j (dots 2-4-5) 

Delete Mark: Backspace-d (dots 1-4-5) 

Insert from file: Enter-i (dots 2-4) 

Insert date: Enter-w (dots 2-4-5-6) 

Insert time: Backspace-w (dots 2-4-5-6) 

 

17.4.4 GO TO COMMANDS 
Find: Space-f (dots 1-2-4)  

Find next: Enter-f (dots 1-2-4) 

Find previous: Backspace-f (dots-1-2-4) 

Find and Replace: Enter-r (dots 1-2-3-5)  

Go to location: Enter-l (dots 1-2-3) 

Go To Previous Sentence: Space-2-3-6 

Go To Next Sentence: Space-3-5-6 

Go to previous page: Space-1-2-6 or F1-F2 

Go to next page: Space-3-4-5 or F3-F4 

Go to previous document: Tab (Space-1-2 or Space-F3) 

Go to next document: Shift-tab (Space-4-5 or F3) 
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17.4.5 READ COMMANDS 
Read selected text: Backspace-b (dots 1-2)  

Read beginning of selected text: Enter-u (dots 1-3-6) 

Read from beginning to cursor: Backspace-g (dots 1-2-4-5) 

Read from cursor to end: Enter-g (dots 1-2-4-5) 

Auto scroll: up-down scroll buttons 

Read current paragraph: Space-2-3-5-6 

Read Current Sentence: Space-1-4-5-6 

Read current line: Space-1-4 

Read current word: Space-2-5 

Read current character: Space-3-6 

Read status: Space-3-4 

Read current cursor position: Space-1-5-6) 

Read character and space count: Enter-3-4 

Read Font info: Backspace-Enter-N (dots-1-3-4-5) 

 

17.4.6 LAYOUT COMMANDS 
Set font: Enter-backspace-f (dots 1-2-4) 

Set Style: Backspace-Enter-S (dots-2-3-4) 

Print document layout: Backspace-t (dots 2-3-4-5) 

Print paragraph layout: Backspace-2-3-4-6 
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17.4.7 MISCELLANEOUS HOT KEYS 
Move forward by heading: Space-dots-2-5-6 

Move backwards by heading: Space-2-3-5 

Move forward by double Enter: Space-Enter-5-6 

Move back by Double Enter: Backspace-Space-2-3 

Delete current paragraph: Backspace-2-3-5-6 

Delete current line: Backspace-1-4 

Delete current word: Backspace-2-5 

Delete current character: Space-d (dots 1-4-5) 

Set view format characters: Space-1-4-6 

Set reading unit: Space-2-4-6 

Set read only: Space-3-4-6 

Move back one slide in PPT: Backspace 

Move forward one slide in PPT: Space 

Go to Slide: Enter-L (dots-1-2-3) 

Insert page break: Backspace-space-Enter-p (dots 1-2-3-4) 

Insert tab: Backspace-Space-Enter-I (dots 2-4) 

Center line: Backspace-Space-Enter-c (dots 1-4) 

Left justify: Backspace-Space-Enter-J (dots-2-4-5) 

Right justify: Backspace-Space-Enter-R (dots-1-2-3-5) 

Bold On/off: Control-B (dots-1-2) 
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Italics On/off: Control-I (dots-2-4) 

Underline On/Off: Control-U (dots-1-3-6) 

Toggle Math Mode on/off: Backspace-m (dots 1-3-4)  

 

17.5 Notepad 
17.5.1 FILE MENU COMMANDS 
New document: Enter-n (dots 1-3-4-5) 

Open: Enter-o (dots 1-3-5) 

Recent File List: Backspace-Enter-H (dots-1-2-5) 

Opened Documents List: Backspace-Enter-O (dots-1-3-5) 

Save: Enter-s (dots 2-3-4) 

Save as: Space-s (dots 2-3-4) 

Close current document: Space-q (dots 1-2-3-4-5) 

Print to embosser: Space-p (dots 1-2-3-4) 

Settings: Enter-e (dots 1-5) 

Dictionary: Backspace-Enter-d (dots 1-4-5) 

Exit: Space-z (dots 1-3-5-6) 

 

17.5.2 EDIT MENU COMMANDS 
Start selection: Enter-b (dots 1-2) 

Copy: Enter-c (dots 1-4)  
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Add to the clipboard: Enter-p (dots 1-2-3-4) 

Clear clipboard: Enter-d (dots 1-4-5) 

Delete: Space-d (dots 1-4-5)  

Cut: Enter-x (dots 1-3-4-6)  

Paste: Enter-v (dots 1-2-3-6) 

Delete blank lines: Backspace-e (dots 1-5) 

Select all: Enter-a (dot 1) 

Check spelling: Enter-k (dots 1-3) 

Check spelling of the current word: Backspace-k (dots 1-3) 

 

17.5.3 INSERT MENU COMMANDS 
Set Mark: Enter-m (dots 1-3-4)  

Jump to mark: Enter-j (dots 2-4-5) 

Delete Mark: Backspace-d (dots 1-4-5) 

Insert from file: Enter-i (dots 2-4) 

Insert date: Enter-w (dots 2-4-5-6) 

Insert time: Backspace-w (dots 2-4-5-6) 

 

17.5.4 GO TO COMMANDS 
Find: Space-f (dots 1-2-4)  

Find next: Enter-f (dots 1-2-4) 

Find previous: Backspace-f (dots-1-2-4) 
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Find and Replace: Enter-r (dots 1-2-3-5)  

Go to location: Enter-l (dots 1-2-3) 

Go To Previous Sentence: Space-2-3-6 

Go To Next Sentence: Space-3-5-6 

Go to previous page: Space-1-2-6 or F1-F2 

Go to next page: Space-3-4-5 or F3-F4 

Go to previous document: Tab (Space-1-2 or Space-F3) 

Go to next document: Shift-tab (Space-4-5 or F3) 

  

17.5.5 READ COMMANDS 
Read selected text: Backspace-b (dots 1-2)  

Read beginning of selected text: Enter-u (dots 1-3-6) 

Read from beginning to cursor: Backspace-g (dots 1-2-4-5) 

Read from cursor to end: Enter-g (dots 1-2-4-5) 

Auto scroll: up-down scroll buttons 

Read current paragraph: Space-2-3-5-6 

Read Current Sentence: Space-1-4-5-6 

Read current line: Space-1-4 

Read current word: Space-2-5 

Read current character: Space-3-6 

Read status: Space-3-4 
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Read current cursor position: Space-1-5-6) 

Read character and space count: Enter-3-4 

 

17.5.6 LAYOUT COMMANDS 
Braille document layout: Backspace-p (dots 1-2-3-4) 

Braille paragraph layout: Backspace-1-2-4-6 

 

17.5.7 MISCELLANEOUS HOT KEYS 
Delete current paragraph: Backspace-2-3-5-6 

Delete current line: Backspace-1-4 

Delete current word: Backspace-2-5 

Delete current character: Space-d (dots 1-4-5) 

Set reading unit: Space-2-4-6 

Set read only: Space-3-4-6 

 

17.6 E-mail/Exchange E-mail 
17.6.1 HOT KEYS FOR THE INBOX 
Open "Accounts Manager”: Enter-m (dots 1-3-4) 

Switch from Offline to Online mode (IMAP): Enter-dots1-2-3 

Check for new mail: Enter-n (dots 1-3-4-5) 

Receive old mail (IMAP): Backspace-p (dots1-2-3-4) 

Move to previous account: Backspace-dots 1-2-6 
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Move to next account: Backspace-dots 3-4-5 

Check current account: Space-3-4 

Move to previous mailbox: Enter-dots 1-2-6 

Move to next mailbox: Enter-dots 3-4-5 

Write new message: Enter-w (dots 2-4-5-6) 

Reply: Enter-r (dots 1-2-3-5) 

Reply all: Backspace-r (dots 1-2-3-5) 

Forward: Enter-f (dots 1-2-4) 

Forward as attachment: Backspace-w (dots 2-4-5-6) 

Open Set Path: Enter-T (dots 2-3-4-5) 

Open Set Options: Enter-o (dots 1-3-5) 

Open Set Spam: Enter-e (dots 1-5) 

Find: Space-f (dots 1-2-4) 

Find again: Backspace-f (dots 1-2-4) 

Move to unread message: Enter-u (dots 1-3-4) 

Move to mailbox: Backspace-x (dots 1-3-4-6) 

Copy to mailbox: Backspace-c (dots 1-4) 

Import messages: Backspace-I (dots-2-4) 

Add a sender to the address list: Enter-i (dots 2-4) (This is valid only at the 
"from" item of the "inbox") 

Delete current message: Space-d (dots 1-4-5) (valid only from the Subject and 
Date fields of the Inbox. 
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Empty Trash: Enter-Backspace-q (dots 1-2-3-4-5) 

Save current message as text file: Space-s (dots 2-3-4) 

Print e-mail: Space-p (dots 1-2-3-4) 

Cancel: Space-e (dots 1-5) 

Cancel and exit e-mail program: Space-z (dots 1-3-5-6) 

 

17.6.2 HOT KEYS FOR SENDING E-MAIL 
 Search address list: Enter-l (dots 1-2-3) 

Attach file: Enter-f (dots 1-2-4) 

Send e-mail: Enter-s (dots 2-3-4) 

Save to Outbox: Space-s (dots 2-3-4) 

Cancel: Space-e (dots 1-5) 

Cancel and exit e-mail program: Space-z (dots 1-3-5-6) 

 

17.6.3 HOT KEYS FOR READING/WRITING AN E-MAIL MESSAGE 
Open link in message body: Enter-L (dots-1-2-3) 

Start selection: Enter-b (dots 1-2) 

Select all: Enter-a (dot 1) 

Copy to the clipboard: Enter-c (dots 1-4) 

Cut to the clipboard: Enter-x (dots 1-3-4-6) (Only available when writing a 
message) 
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Paste from the clipboard: Enter-v (dots 1-2-3-6) (only available when writing a 
message) 

Delete selection/delete current character: Space-d (dots 1-4-5)  

Cancel selection: Space-e (dots 1-5) 

 

17.7 Media 
17.7.1 MEDIA PLAYER 
 

17.7.1.1 File Commands 
Open file: Enter-o (dots 1-3-5) 

Open folder: Enter-f (dots 1-2-4) 

Add file: Backspace-o (dots 1-3-5) 

Add folder: Backspace-f (dots 1-2-4) 

Save playlist: Enter-i (dots 2-4) 

Save as playlist: Space-s (dots 2-3-4) 

Delete item: Space-d (dots 1-4-5) 

Open URL: Enter-u (dots 1-3-6) 

Get tag information: Enter-t (dots 2-3-4-5) 

 

17.7.1.2 Playback Commands 
Play: Enter, Play button 

Pause/play: Space, Play button 
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Stop: Backspace, Stop button 

Previous track: Dot 3, Previous button 

Next track: Dot 6, Next button 

Back 5 tracks: Dots 2-3 

Forward 5 tracks: Dots 5-6 

First track: Dots 1-3 

Last track: Dots 4-6 

Volume up: Space-Up Scroll button 

Volume down: Space-Down Scroll button 

Speed up: Dots 3-4-5 

Slow down: Dots 1-2-6 

Change time index: Dot 2 or Dot 5 

Move to next position by time index: Dot 4 

Move to previous position by time index: Dot 1 

Delete playlist: Space-d (dots 1-4-5) 

Set marked position: Enter-m (dots 1-3-4) 

Delete marked position: Enter-d (dots 1-4-5) 

Jump to marked position: Enter-j (dots 2-4-5) 

Go to position: Enter-g (dots 1-2-4-5) 

Set mark: Backspace-m (dots 1-3-4) 

Move to mark: Backspace-j (dots 2-4-5) 
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Move to previous mark: Backspace-dot 3 

Move to next mark: Backspace-dot 6 

Delete mark: Backspace-d (dots 1-4-5) 

Mark manager: Backspace-k (dots 1-3) 

Configuration dialog: Backspace-c (dots 1-4) 

Playback settings dialog: Enter-s (dots 2-3-4) 

Record settings dialog: Backspace-s (dots 2-3-4) 

Effect settings dialog: Enter-e (dots 1-5) 

 

17.7.1.3 Recording Commands 
Open the Record dialog: Enter-r (dots 1-2-3-5), Record button 

Record: Record button 

Pause/Continue recording: Space, Record button 

Play: Play button 

 

17.7.1.4 Hot Keys in the Play Information Tab 
Move to the next item: Space-dot-4 

Move to the previous item: Space-dot-1 

Open menu: F2 or Space-m (dots 1-3-4) 

Open help: Space-h (dots 1-2-5) 

Move to Playlist tab: Space-4-5/Space-1-2 

Exit Media Player: Space-z (dots 1-3-5-6) 
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17.7.1.5 Hot Keys in the Playlist Tab 
Move to the next file: Space-4 

Move to the previous file: Space-1 

Move to the last file: Space-4-6 

Move to the first file: Space-1-3 

Play current file: Space 

Start file selection: Enter-b (dots 1-2) 

Start playing the selected files: Enter 

Stop playing: Backspace 

Delete the selected files from the playlist: Space-d (dots 1-4-5) 

Move to "playback information" tab: Space-4-5/Space-1-2 

 

17.7.2 FM RADIO 
Open the Presets dialog: Enter-e (dots 1-5) 

Open the menu: Space-m (dots 1-3-4) or F2 

Internal speakers on/off: Space-x (dots 1-3-4-6)  

Move to next frequency: Dot 6 

Move to previous frequency: Dot 3 

Autoscan backward: Dot 2, short press Previous button 

Autoscan forward: Dot 5, short press Next button  

Go to frequency: Space-f (dots 1-2-4) 
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Move to previous preset: Dot 1, long press Previous button  

Move to next preset: Dot 4, long press Next button 

Save preset: Enter-s (dots 2-3-4) or long press Record button 

Delete preset: Space-d (dots 1-4-5) or long press Stop button 

Open Record dialog: Enter-r (dots 1-2-3-5) 

Record pause/resume: short press Record button 

Stop recording: short press Stop button 

Mute on: short press Stop button, Space 

Mute off: short press Play button, Space 

Volume up: Space-Up Scroll button 

Volume down: Space-Down Scroll button 

 

17.7.3 DAISY PLAYER 
Read title: Space-dots 1-2-5-6 

Open DAISY book: Enter-o (dots 1-3-5) 

Voice settings: Enter-s (dots 2-3-4) 

Check book-info: Enter-i (dots 2-4) 

Exit: Space-z (dots 1-3-5-6) 

Play/Pause: Space 

Go to beginning: Space-1-3 or Space-1-2-3 

Go to end: Space-4-6 or Space-4-5-6 
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Increase volume: Backspace-dot-4 

Decrease Volume: Backspace-dot-1 

Increase Speed: Backspace-dot-5 

Decrease Speed: Backspace-dot-2 

Increase Pitch: Backspace-dot-6 

Decrease Pitch: Backspace-dot-3 

Move to the next page: Space-3-4-5 

Move to the previous page: Space-1-2-6 

Go to page: Enter-g (dots 1-2-4-5) 

Select previous text/time unit: Dot 1 

Select next text/time unit: Dot 4 

Move to previous text/time unit: Dot 2 

Move to next text/time unit: Dot 5 

Select previous movement unit: Dots 2-3 

Select next movement unit: Dots 5-6 

Move to the previous unit: Dot 3 or short press Previous button 

Move to the next unit: Dot 6 or short press Next button 

Move to the next heading: Space-5 or long press Next button 

Move to the previous heading: Space-2 or long press Previous button 

Move to the last heading: Space-4-6 

Move to the first heading: Space-1-3 
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Check the current-reading level and heading: Enter-w (dots 2-4-5-6) 

Scan the heading list from the present to the end: Enter-n (dots 1-3-4-5) 

Find heading: Space-f (dots 1-2-4) 

Headings list: Enter-h (dots 1-2-5) 

Find again: Enter-f (dots 1-2-4) 

Set mark at current position: Enter-m (dots 1-3-4) 

Move to the next mark: Space-dot 6 

Move to the previous mark: Space-dot 3 

Delete mark: Space-d (dots 1-4-5) 

Create memo: Backspace-m (dots-1-3-4) 

Read memo: Backspace-r (dots-1-2-3-5) 

Read previous memo: Backspace-p (dots-1-2-3-4) 

Read Next Memo: Backspace-n (dots-1-3-4-5) 

Delete Memo: Backspace-d (dots-1-4-5) 

Exit and erase position without prompt: Enter-z (dots-1-3-5-6) 

Exit and erase marks without prompt: Backspace-z (dots-1-3-5-6) 

 

17.7.4 DOCUMENT READER 
File commands: 

Open File: Enter-O (dots-1-3-5) 

Recent Documents list: Enter-R (dots-1-2-3-5 
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Page Settings: Backspace-P (dots-1-2-3-4) 

Voice Settings: Enter-S (dots-2-3-4) 

Start Setting: Enter-e (dots-1-5) 

Document information: Enter-I (dots-2-4) 

Exit and Save Bookmark: Space-Z (dots-1-3-5-6) 

Exit and remove bookmark: Enter-Z (dots-1-3-5-6) 

Exit without saving bookmark: Backspace-Z (dots-1-3-5-6) 

 

Edit Commands: 

Start Selection: Enter-B (dots-1-2) 

Copy: Enter-C (dots-1-4) 

Add to Clipboard: Enter-P (dots-1-2-3-4) 

Clear Clipboard: Enter-D (dots-1-4-5) 

Select All: Enter-A (dot-1) 

 

Read Commands: 

Toggle Manual/continuous Read Mode: Enter. 

Pause/resume reading: Space 

Read Selected Text: Backspace-B (dots-1-2) 

Read current page: Backspace. 

Read current paragraph: Space-2-3-5-6. 
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Read current line: Space-1-4. 

Read current sentence: dots-2-3-5-6. 

 

Go To Commands: 

Find: Space-F (dots-1-2-4) 

Find Next: Enter-F (dots-1-2-4) 

Find Previous: Backspace-F (dots-1-2-4) 

Go to location: Enter-G (dots-1-2-4-5- 

Go to Headings list: Enter-T (dots-2-3-4-5) 

Go to Previous Heading: Backspace-Space-2-3-5 

Go to Next heading: Backspace-Space-2-5-6 

Move back by double Enter: Backspace-Space-2-3. 

Move forward by Double Enter: Space-Enter-5-6. 

 

Mark Commands: 

Set Mark: enter-M (dots-1-3-4) 

Move to Mark: Enter-J (dots-2-4-5) 

Delete Mark: Space-D (dots-1-4-5) 

Next Mark: Enter-N (dots-1-3-4-5) 

Previous Mark: Backspace-M (dots-1-3-4) 

Mark Manager; enter-k (dots-1-3) 
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Mark Alert options: Backspace-O (dots-1-3-5) 

 

 

17.8 Organizer 
17.8.1 ADDRESS MANAGER 
 

17.8.1.1 Navigation When Adding an Address 
Move to the previous field or menu item: Space-1 or Up Scroll button 

Move to the next field or menu item: Space-4 or Down Scroll button 

Move to the first field or menu item: Space-1-2-3 

Move to the last field or menu item: Space-4-5-6 

 

17.8.1.2 Navigation in Search Results List 
Move to the previous record: Space-1 or Up Scroll button 

Move to the next record: Space-4 or Down Scroll button 

Move to the first record: Space-1-2-3 

Move to the last record: Space-4-5-6 

Move to Record information: F3 

 

17.8.1.3 General Commands 
Add address: Enter-i (dots 2-4) 

Find address: Enter-s (dots 2-3-4) 
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Edit address: Enter-m (dots1-3-4) 

Delete address: Space-d (dots 1-4-5) 

Select all: Enter-a (dot 1) 

Save as a file: Enter-t (dots 2-3-4-5) 

Print address: Space-p (dots 1-2-3-4) 

Backup address list: Enter-u (dots 1-3-6) 

Restore address list: Enter-r (dots 1-2-3-5) 

Set backup options: Enter-e (dots 1-5) 

Setting add/searching address fields: Enter-o (dots 1-3-5) 

Import from CSV: Backspace-i (dots 2-4) 

Export to CSV: Backspace-x (dots 1-3-4-6) 

 

17.8.2 SCHEDULE MANAGER 
 

17.8.2.1 General Commands 
Move to the next field: Space-4-5 or F3 

Move to the previous field: Space-1-2 or Space-F3 

Add appointment: Enter-i (dots 2-4) 

Search appointments: Enter-s (dots 2-3-4) 

Modify appointment: Enter-m (dots 1-3-4) 

Delete appointment: Space-d (dots 1-4-5) 

Delete all appointments: Backspace-Enter-q (dots1-2-3-4-5) 
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Backup appointments: Enter-u (dots 1-3-6) 

Restore appointments: Enter-r (dots 1-2-3-5) 

Set backup options: Enter-e (dots 1-5) 

Alarm options: Enter-o (dots 1-3-5) 

Save appointments as file: Enter-t (dots 2-3-4-5) 

Print appointments: Space-p (dots 1-2-3-4) 

Refresh sync with cloud: Backspace-R (dots-1-2-3-5) 

17.8.2.2 Navigating Search Results 
Move to the previous appointment: Space-2 

Move to the next appointment: Space-5 

Move to the first appointment: Space-2-3 or Space-1-2-3 

Move to the last appointment: Space-5-6 or Space-4-5-6 

Move to the previous appointment on the same day: Space-1 or Up Scroll button 

Move to the next appointment on the same day: Space-4 or Down Scroll button 

Move to the first appointment on the same day: Space-1-3 

Move to the last appointment on the same day: Space-4-6 

 

17.8.3 DATABASE MANAGER 
Move to the next control: Tab (Space-4-5 or F3) 

Move to the previous control: Shift-Tab (Space-1-2 or Space-F3) 

Move to the next list item: Space-4 or down scroll button 

Move to the previous list item: Space-1 or up scroll button  
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Table Manager: enter-T (dots-1-2-4-5) 

Create New Table from CSV: Enter-X (dots-1-3-4-6) 

Add Table: Enter-A (dot-1) 

Modify Table: (Enter-M (dots-1-3-4) 

Delete Table: Space-D (dots-1-4-5) 

Set as Default Table: Enter-D (dots-1-4-5) 

Insert New Record: Enter-I (dots-2-4) 

Import Records from CSV: Backspace-I (dots-2-4) 

Search records: Enter-s (dots 2-3-4) 

Move to the next record: Space-4 or down scroll button 

Move to the previous record: Space-1 or up scroll button 

Move to the last record: Space-4-5-6  

Move to the first record: Space-1-2-3 

Move to the next field: Space-5 

Move to the previous field: Space-2 

Move to previous same field different record: Space-3 

Move to next same field different record: Space-6 

Move to the last field: Space-4-6  

Move to the first field: Space-1-3 

Set backup options: Enter-e (dots 1-5) 

Backup database: Enter-u (dots 1-3-6) 
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Restore database: Enter-o (dots 1-3-5) 

 

17.9 Web tools 
17.9.1 WEB BROWSER 
 

17.9.1.1 General Commands 
Open URL: Enter-u (dots 1-3-6) 

Open: Enter-o (dots 1-3-5) 

Save as: Space-s (dots 2-3-4) 

Information: Enter-i (dots 2-4) 

File Download Dialog: Backspace-3-4 

Exit: Space-z (dots 1-3-5-6) 

Read from beginning to cursor: Backspace-g (dots 1-2-4-5) 

Read from cursor to end: Enter-g (dots 1-2-4-5) 

Auto scroll: Up Scroll button-Down Scroll button 

Start selection: Enter-b (dots 1-2) 

Copy: Enter-c (dots 1-4) 

Add to clipboard: Enter-p (dots 1-2-3-4) 

Copy URL: Backspace-d (dots 1-4-5) 

Copy link: Backspace-l (dots 1-2-3) 

Go to home page: Backspace-h (dots 1-2-5) 
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Go to previous page: Backspace-Space-3 or Backspace-p (dots 1-2-3-4) 

Go to next page: Backspace-Space-6 or Backspace-n (dots 1-3-4-5) 

Go to previous heading: Backspace-b (dots 1-2) 

Go to next heading: Backspace-f (dots 1-2-4) 

Go to previous text chunk: Space-2-4-6 

Go to next text chunk: Space-1-2-4-5-6 

Go to previous visited link: Space-2-3-6 

Go to next visited link: Space-3-5-6 

Refresh: Enter-r (dots 1-2-3-5) 

Open the history list: Enter-h (dots 1-2-5) 

Check the address of the selected title in the history list: Space-i (dots 2-4) 

Find: Space-f (dots 1-2-4) 

Find again: Enter-f (dots 1-2-4) 

Links list: Backspace-i (dots 2-4) 

RSS Feed List: Enter-j (dots 2-4-5) 

Set current as your home page: Enter-s (dots 2-3-4) 

Add to favorites: Backspace-a (dot 1) 

Favorites list: Enter-l (dots 1-2-3) 

Option settings: Backspace-o (dots 1-3-5) 
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17.9.1.2 Hot Keys When Playing Audio Files in Web Browser 
Turn up the volume: Space-Up Scroll button 

Turn down the volume: Space-Down Scroll button 

Play: Play button on the front panel 

Stop: Stop button on the front panel 

 

17.9.1.3 Hot Keys for Reading Web Pages 
Move to the previous control: Shift-tab (Space-1-2) 

Move to the next control: Tab (Space-4-5) 

Select the next item in a combo box (list box): Backspace-Space-4 

Select the previous item in a combo box (list box): Backspace-Space-1 

Move to previous form control: Space-1-2-3-4-6 

Move to next form control: Space-1-3-4-5-6 

Move to previous table: Space-3-4-5-6 

Move to next table: Space-1-4-5-6 

Move to previous cell: Space-2-3 

Move to next cell: Space-5-6 

Move to upper cell: Space-3-5 

Move to lower cell: Space-2-6 

Read current cell: Space-2-3-5-6 

Move to previous cell of upper level table: Backspace-2-3 

Move to next cell of upper level table: Backspace-5-6 
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Move to upper cell of upper level table: Backspace-3-5 

Move to lower cell of upper level table: Backspace-2-6 

Check current position: Space-1-5-6 

Move to previous frame: Space-3-4-6 

Move to next frame: Space-1-4-6 

Read current line: Space-r (dots 1-2-3-5) 

 

17.10 Extras 
17.10.1 EXCEL VIEWER 
 

17.10.1.1 Navigation Commands 
Move to next row: Space-Dot 4 

Move to previous row: Space-Dot 1 

Move to next column: Space-Dot 6 

Move to previous column: Space-Dot 3 

Move to beginning of row: Space-Dots 1-3 

Move to end of row: Space-Dots 4-6 

Move to top of column: Space-Dots 2-3 

Move to bottom of column: Space-Dots 5-6 

Move to top of worksheet: Space-1-2-3 

Move to bottom of worksheet: Space-4-5-6 
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Move to next worksheet: Space-3-4-5 

Move to previous worksheet: Space-1-2-6 

Move to next group: Backspace-Dots 5-6 

Move to previous group: Backspace-Dots 2-3 

Move to next group in row: Space-Dot 5 

Move to previous group in row: Space-Dot 2 

Move to next group in column: Space-Dots 5-6 

Move to previous group in column: Space-Dots 2-3 

 

17.10.1.2 File Commands 
Open: Enter-o (dots 1-3-5) 

Open Hyperlink: Enter-h (dots 1-2-5) 

Set User table: Enter-t (dots 2-3-4-5) 

Cell properties: Enter-i (dots 2-4) 

Quick Setup: Enter-x (dots 1-3-4-6) 

Save as: Space-s (dots 2-3-4) 

 

17.10.1.3 Go To Commands 
Find: Space-f (dots 1-2-4) 

Find Next: Enter-f (dots 1-2-4) 

Find Previous: Backspace-f (dots 1-2-4) 

Move to cell: Enter-j (dots 2-4-5) 
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Next sheet: Space-3-4-5 

Previous sheet: Space-1-2-6 

Sheet list: Enter-l (dots 1-2-3) 

Set Mark: Backspace-m (dots 1-3-4) 

Go to Mark: Backspace-j (dots 2-4-5) 

Delete Mark: Backspace-d (dots 1-4-5) 

 

17.10.1.4 Read Commands 
Set Options: Backspace-o (dots 1-3-5) 

Sheet title: Space-1-5-6 

Read from top of column to cursor: Backspace-Dot 1 

Read from cursor to bottom of column: Backspace-Dot 4 

Read from beginning of row to cursor: Backspace-Dot 3 

Read from cursor to end of row: Backspace-Dot 6 

Read current row: Space-c (dots 1-4) 

Read current column: Space-y (dots 1-3-4-5-6) 

Read header cell of row: Backspace-c (dots 1-4) 

Read header cell of column: Backspace-y (dots 1-3-4-5-6) 

Read from beginning to cursor: Backspace-g (dots1-2-4-5) 

Read from cursor to end: Enter-g (dots 1-2-4-5) 

Read One character (When in Cell Activation): Space-Dots 3-6 
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Read Current Cell: Space-Dots 3-6 

Read File Name: Space-Dots 3-4 

Read Selected Text: Backspace-b (dots 1-2) 

 

17.10.1.5 View Commands 
View Hide Sheet: Enter-s (dots 2-3-4) 

View Hide Row: Enter-r (dots 1-2-3-5) 

View Hide Column: Enter-y (dots 1-3-4-5-6) 

Cell Activation: Enter  

Activation Cancel: Backspace 

Set Time and Date: Enter-d (dots 1-4-5) 

 

17.10.1.6 Edit Commands 
Start Selection: Enter-b (dots 1-2) 

Select All: Enter-a (dot 1) 

Copy Selected Text: Enter-c (dots 1-4) 

 

17.10.2 ONLINE DAISY 
Move between category and booklist: F3 and Space-F3 

Move among list items: Space-1 and Space-4 

Download book: Enter 

Return book: Enter-r (dots 1-2-3-5) 
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17.11 Utilities 
17.11.1 CALCULATOR 
Clear calculator: Backspace-c (dots 1-4) 

Delete numbers or operators: Backspace 

Calculation history: Enter-h (dots 1-2-5) 

General functions: Enter-g (dots 1-2-4-5) 

PI: Enter-p (dots 1-2-3-4) 

Exp: Enter-e (dots 1-5) 

Trigonometric Functions: Enter-s (dots 2-3-4) 

Sine: Enter-s (dots 2-3-4), s (dots 2-3-4) 

Arc Sine: Enter-s (dots 2-3-4), a (dot 1) 

Hyperbolic Sine: Enter-s (dots 2-3-4), h (dots 1-2-5) 

Cosine: Enter-i (dots 2-4), i (dots 2-4) 

Arc Cosine: Enter-c (dots 1-4), a (dot 1) 

Hyperbolic Cosine: Enter-c (dots 1-4), h (dots 1-2-5) 

Tangent: Enter-t (dots 2-3-4-5), t (dots 2-3-4-5) 

Arc Tangent: Enter-t (dots 2-3-4-5), a (dot 1) 

Hyperbolic Tangent: Enter-t (dots 2-3-4-5), h (dots 1-2-5) 

Logarithm Function: Enter-l (dots 1-2-3) 

Natural Logarithm: Enter-l (dots 1-2-3), e (dots 1-5) 
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Common Logarithm: Enter-l (dots 1-2-3), n (dots 1-3-4-5) 

Recall Items: Backspace-r (dots 1-2-3-5) 

Delete all saved items: Enter-d (dots 1-4-5) 

Save Items: Backspace-s (dots 2-3-4) 

Convert Unit: Enter-u (dots 1-3-6) 

Copy to Clipboard: Enter-c (dots 1-4) 

Option Settings: Enter-o (dots 1-3-5) 

Fraction options: Space-dots 3-4 

Return formula: Enter-r (dots1-2-3-5) 

Change Braille code: Space-g (dots1-2-4-5) 

 

17.11.2 POLARIS MATH 
 

17.11.2.1 File Menu Commands 
Export: Enter-E (dots-1-5) 

Import: “Enter-I (dots-2-4) 

Save to History: “Space-S (dots-2-3-4) 

History: “Enter-H (dots-1-2-5) 

Save Graph As Braille: “Enter-F (dots-1-2-4) 

Exit: “Space-Z (dots-1-3-5-6) 
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17.11.2.2 The Edit Menu 
Copy: “Enter-C (dots-1-4) 

Cut: “Enter-X” (dots-1-3-4-6) 

Paste: “Enter-V (dots-1-2-3-6) 

Delete: “Space-D (dots-1-4-5) 

Select All: “Enter-A (dot-1) 

Start Selection: “Enter-B (dots-1-2) 

Copy Graph: “Enter-G (dots-1-2-4-5) 

Symbol picker: “Backspace-S (dots-2-3-4) 

Set Math Code: “Backspace-G (dots-1-2-4-5) 

 

17.11.2.3 The Graph Menu 
Axis: “Backspace-X (dots-1-3-4-6)  

Graph label: “Backspace-L (dots-1-2-3) 

Graph Style: Backspace-C (dots-1-4)  

Show/Hide graph: “Backspace-H (dots-1-2-5)  

 

17.11.2.4 The Output Menu 
Display Tactile Graph: Enter-T (dots-2-3-4-5)  

Send to Embosser: Enter-P (dots-1-2-3-4)  
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17.11.3 DISPLAY COMPASS HEADING 
Open Display Compass Heading: Space-F3-F4 

Move to the next control: Space-4-5 or F3 

Move to the previous control: Space-1-2 or Space-F3 

Change compass display type: Backspace or Space 

Exit: Space-z (dots 1-3-5-6) or Space-e (dots 1-5) 

 

17.11.4 ALARM 
Add Alarm: Enter-A (dot-1) 

Modify Alarm: Enter-M (dots-1-3-4) 

Delete Alarm: Space-D (dots-1-4-5) 

 

17.11.5 STOPWATCH 
Stopwatch start, pause, restart: Enter 

Check the elapsed time: Backspace 

Stop and restart Braille display: Space-F2 

Switch between stopwatch and countdown timer: Space-4-5 or Space-1-2 

Count down timer pause or restart: Enter 

Count down timer Initialize: Backspace 

Exit stopwatch or countdown timer: Space-z (dots 1-3-5-6) 
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17.11.6 TERMINAL FOR SCREEN READER 
Enter terminal Clipboard: Space-Enter-i (dots 2-4)  

Send Terminal Clipboard content: Enter-s (dots 2-3-4)  

Exit terminal for Screen reader: Space-Backspace-z (dots 1-3-5-6)  

 

17.11.7 MACRO COMMANDS 
Start/stop recording Macro: F2-R (dots-1-2-3-5) 

Insert Delay Time: F2-D (dots-1-4-5) 

Execute Macro: F2-e (dots-1-5) 

Macro Manager: F2-L (dots-1-2-3) 

 

17.11.8 OTHER UTILITY COMMANDS 
Display network status: Space-n (dots 1-3-4-5) 

Display power status: Space-1-6 

Format: Space-1-2-3 

Set Sleep Timer: Space-j (dots 2-4-5) 

Check upgrade download progress: Space-i (dots 2-4) 

Check date and time: Space-t (dots 2-3-4-5) 

 

17.12 Settings 
17.12.1 SETTING TIME AND DATE 
Move to the next day: Space-6 
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Move to the previous day: Space-3 

Move to the next week: Space-5 

Move to the previous week: Space-2 

Move to the next month: Space-4 

Move to the previous month: Space-1 

Move to the next year: Space-5-6 

Move to the previous year: Space-2-3 

Move to 1 hour after: Space-4 

Move to 1 hour before: Space-1 

Move to 10 minutes after: Space-5 

Move to 10 minutes before: Space-2 

Move to 1 minute after: Space-6 

Move to 1 minute before: Space-3 

Switch between A.M. and P.M.: Space-x (dots 1-3-4-6) 

 

17.12.2 BLUETOOTH MANAGER 
Rescan for Bluetooth devices: Enter-r (dots 1-2-3-5) 

Connect device: enter on the device name 

Connect service: enter on the service name 

Disconnect the service in Bluetooth service list: Enter-d (dots 1-4-5) 

Move to Bluetooth device list in service list: Backspace 
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Remove device settings in Bluetooth device list: Space-d (dots 1-4-5) 

 

17.12.3 BACKUP/RESTORE PERSONALIZED SETTINGS 
Move to previous item: Space-1 or up scroll button 

Move to next item: Space-4 or down scroll button 

Move to previous control: Shift-tab (Space-1-2 or Space-F3) 

Move to next control: Tab (Space-4-5 or F3) 

Select/unselect check box: Space 

Backup: Enter-b (dots 1-2) 

Restore: Enter-r (dots1-2-3-5) 

 

17.12.4 PASSWORD PROTECTION. 
Set password: Enter-i (dots 2-4) 

Modify password: Enter-m (dots 1-3-4) 

Password configuration: Enter-c (dots 1-4) 

Reset to factory defaults: i (dots 2-4) 

 

17.13 Screen Reader Commands 
17.13.1 MOVING FOCUS 
Move to next object: Space-4-5 or F3 

Move to previous object: Space-1-2 or Space-F3 

Move to top of screen: Space-1-2-3 
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Move to bottom of screen: Space-4-5-6 

Scroll down one screen: Space-3-4-5 

Scroll up one screen: Space-1-2-6 

Execute current item: Enter or Cursor routing key 

Back button: Space-e, F4 or Space-Z 

Move to specific object: press first letter of object name 

Go to Home screen: F1 

Activate App Actions Menu: Enter-I on focused app 

Open Notification Shade: Space-1-2-3-4-5-6 

Activate Notification: Enter 

Delete notification: Space-D (dots-1-4-5) 

Clear all notifications: Space-Enter-D (dots-1-4-5) 

Activate Edit Box: Enter 

Increase Slider Value: Backspace-Space-4 

Decrease Slider Value: Backspace-Space-1 

Double Tap: Space-Enter 

Double Tap and Hold: Backspace-Space-Enter 

Start/Stop Hold: Backspace-Space-Dot-2 

Reset Polaris Launcher: F2-F3-1-2-3-4-5-6-7-8 

Change object navigation method: Backspace-Enter-H (dots-1-2-5) 
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17.13.2 WHEN EDITING TEXT 
Go to next character: Space-6 

Go to previous character: Space-3 

Go to next word: Space-5 

Go to previous word: Space-2 

Go to next line: Space-4 

Go to previous line: Space-1 

Go to next paragraph: Space-5-6 

Go to previous paragraph: Space-2-3 

Go to beginning of paragraph: Space-1-3 

Go to end of paragraph: Space-4-6 

Go to top of document: Space-1-2-3 

Go to bottom of document: Space-4-5-6 

Delete current character: Space-1-4-5 

Delete previous character: Backspace 

Delete current word: Backspace-2-5 

Delete current line: Backspace-1-4 

Delete current paragraph: Backspace-2-3-5-6 

Move to next display length: Down Scroll 

Move to previous display length: Up Scroll 
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17.13.3 MEDIA KEY FUNCTIONS WHEN IN "APP MODE" 
Open Main menu: Stop button 

Recent Apps: Play button 

Back: Record button 

Move to previous object: Previous button 

Move to next object: Next button 

Android Media play/Pause: Hold Play button 

Android previous track: Hold Previous button 

Android Next track: hold Next button 

Mobile Screen Reader on-off: Stop and Next buttons 

Call Google Voice Assistant: Record and Play buttons 
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